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Abstract

This book provides an overview of the Microsoft Office 2010 suites and information about how to get started with Office 2010. The audience for this book includes IT generalists, IT operations, help desk and deployment staff, IT messaging administrators, and consultants.

The content in this book is a copy of selected content in the Office 2010 Resource Kit technical library (http://technet.microsoft.com/en-us/library/cc303401(office.14).aspx) as of the publication date. For the most current content, see the technical library on the web.
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Getting help

Every effort has been made to ensure the accuracy of this book. This content is also available online in the Office System TechNet Library, so if you run into problems you can check for updates at:

http://technet.microsoft.com/office
If you do not find your answer in our online content, you can send an e-mail message to the Microsoft Office System and Servers content team at:

itspdocs@microsoft.com
If your question is about Microsoft Office products, and not about the content of this book, please search the Microsoft Help and Support Center or the Microsoft Knowledge Base at:

http://support.microsoft.com

Exploring Office 2010

Microsoft Office 2010 provides features that help IT administrators configure, validate, deploy, and protect Office installations in their organizations. This section introduces some of the new features and improvements in the Microsoft Office 2010 suites that are relevant to IT professionals.

In this section:

	Article
	Description

	Office 2010 suites
	Describes the editions of the Microsoft Office 2010 suites that are available, and provides an overview of the licensing requirements.

	What's new for IT professionals in Office 2010
	Describes the new features and improvements in the Microsoft Office 2010 suites that are relevant to IT professionals.

	SharePoint Workspace 2010 overview
	Describes the the key functionality and architecture of Microsoft SharePoint Workspace 2010. SharePoint Workspace 2010 is the new name for and succeeds Microsoft Office Groove 2007.

	Overview of the Office user interface in Office 2010
	Provides information about the Microsoft Office Fluent user interface (UI) in Office 2010, including the ribbon, the Quick Access Toolbar, and the new Backstage view.

	User interface differences in Office 2010 from earlier versions of Microsoft Office
	Describes some of the differences among Office 2010, the 2007 Office system, and Office 2003 that are relevant to IT professionals.

	Product and feature changes in Office 2010
	Provides information about new features, changed features, and deprecated features for the products in the Microsoft Office 2010 suites, as well as Microsoft Project 2010 and Microsoft Visio 2010. Also included are migration considerations for the specific products.

	Changes introduced in the 2007 Office system
	Provides a summary of changes in the 2007 Microsoft Office system for administrators who might not be familiar with that version of the product.

	Technical diagrams for Office 2010
	Provides visual representations or models of recommended solutions for deploying Office 2010.

	Help and support for Office 2010
	Describes some of the support options that are available for the Office 2010 suites.


See Also
Product and feature changes in Office 2010
SharePoint Workspace 2010 overview
Office 2010 suites

Six editions of the Microsoft Office 2010 suites are available — three user versions and three business versions — depending on an organization’s needs and licensing requirements. These include the following editions:


Microsoft Office Home and Student 2010


Microsoft Office Home and Business 2010


Microsoft Office Standard 2010


Microsoft Office Professional 2010


Microsoft Office Professional Plus 2010


Microsoft Office Professional Academic 2010
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Note: 

Microsoft requires activation of all editions of Microsoft Office 2010. This includes those obtained through a Volume Licensing program. Only the volume-licensed version enables organizations to host browser-based versions of the software.

Comparisons of Office 2010 editions

The following table compares Office 2010 suites, products, and features.

	Programs, products, and features
	Home and Student 
	Home and Business 
	Standard
	Professional
	Professional Plus
	Professional Academic

	Licensing
	Retail
	Retail
	Volume
	Retail
	Volume
	Retail with valid “@__.edu”

	Microsoft Excel 2010
	Yes
	Yes
	Yes
	Yes
	Yes
	Yes

	Microsoft OneNote 2010
	Yes
	Yes
	Yes
	Yes
	Yes
	Yes

	Microsoft PowerPoint 2010
	Yes
	Yes
	Yes
	Yes
	Yes
	Yes

	Microsoft Word 2010
	Yes
	Yes
	Yes
	Yes
	Yes
	Yes

	Microsoft Outlook 2010
	No
	Yes
	Yes
	Yes
	Yes
	Yes

	Microsoft Publisher 2010
	No
	No
	Yes
	Yes
	Yes
	Yes

	Microsoft Access 2010
	No
	No
	No
	Yes
	Yes
	Yes

	Microsoft Communicator 2010
	No
	No
	No
	No
	Yes
	No

	Microsoft InfoPath 2010
	No
	No
	No
	No
	Yes
	No

	Microsoft SharePoint Workspace 2010
	No
	No
	No
	No
	Yes
	No


Office 2010 is available in 32-bit and 64-bit editions. For a list of specific requirements, see System requirements for Office 2010.

See Also
What's new for IT professionals in Office 2010
User interface differences in Office 2010 from earlier versions of Microsoft Office
What's new for IT professionals in Office 2010

Microsoft Office 2010 provides new features and improvements that help IT administrators configure, validate, deploy, and protect their Office installations. This article describes some of the changes in these areas.

In this article:


Licensing and volume activation

Office 2010 64-bit editions

Security changes

Office Customization Tool changes

Application virtualization

Additional resources
Licensing and volume activation

Microsoft includes product activation technologies in the following products sold through the Volume Licensing channel: Windows Vista, Windows 7, Windows Server 2008, Windows Server 2008 R2, and now Office 2010. Product activation is verification with the manufacturer to confirm that software is genuine and that its product key is not compromised. Activation establishes a relationship between the software's product key and a particular installation of that software on a device. 

Activation types include retail, volume, and OEM, and most require interactive steps by the user or IT professional, such as entering a product key from the packaging, or contacting a networked server or telephone service center. Activation technologies and tools vary according to the different channels for the software — retail, volume, and OEM.

The Microsoft policy requires the activation of all editions of Office 2010. This includes those obtained through a Volume Licensing program. This requirement applies to Office 2010 running on both physical computers and virtual machines.

You can use the following methods to activate Office 2010 with Office Activation Technologies:


Key Management Service (KMS). KMS uses a KMS host key to activate a KMS host computer and establish a local activation service in your environment. Office 2010 connects to the local KMS host for activation.


Multiple Activation Key (MAK). With a MAK, clients activate Office 2010 online with the Microsoft hosted activation servers or by telephone


A combination of KMS and MAK.

For more information about Office Activation Technologies, see Volume activation overview for Office 2010 (http://technet.microsoft.com/library/0735c1f5-f874-41f1-b9a9-dbea158524b2(Office.14).aspx ) and Volume activation quick start guide for Office 2010 (http://technet.microsoft.com/library/dbff777c-3a2d-4d8e-a7be-6c45900c73c2(Office.14).aspx).

Office 2010 64-bit editions

Processors that are 64-bit are quickly becoming the standard for systems ranging from servers to desktop computers. The 64-bit systems can use more virtual and physical memory than 32-bit processors. This lets users work with much larger data sets than they could previously, to analyze and solve large computational problems. Office 2010 introduces native 64-bit versions of Office products to take advantage of the additional capacity provided by 64-bit processors. This additional capacity is only needed by Office users who require Microsoft Excel spreadsheets that are larger than 2 GB, for example. The 32-bit version of Office 2010 provides the same functionality and is also compatible with 32-bit add-ins. This is why Office 2010 will install the 32-bit version by default.

For information about the supported operating systems, supported scenarios, setup process, and deployment considerations for 64-bit Office 2010, see 64-bit editions of Office 2010.

Security changes

Fortunately, several new security controls in Office 2010 make it easier for IT professionals to build a robust defense against threats without diminishing information worker productivity. Five of the new controls provide countermeasures for hardening and reducing the attack surface and mitigating exploits. These include the following:

Data Execution Prevention (DEP) support for Office applications   A hardware and software technology that helps harden the attack surface by preventing the execution of viruses and worms that exploit buffer overflow vulnerabilities.

Office file validation   An Office software component that helps reduce the attack surface by scanning files for file format (file fuzzing) exploits before the files are opened by an application.

Expanded file block settings   A suite of Group Policy settings that helps reduce the attack surface by providing more specific control over the kinds of files an applications can access.

Office ActiveX kill bit   An Office feature that administrators can use to prevent specific ActiveX controls from running within Office applications.

Protected view   A sandbox environment that helps mitigate attacks by enabling users to preview untrusted or potentially harmful files in a secure viewer.

In addition to these new controls, Office 2010 provides several security enhancements that further harden the attack surface by helping to ensure the integrity and confidentiality of data. This includes the following:


Cryptographic agility for Microsoft Excel 2010, Microsoft PowerPoint 2010, and Microsoft Word 2010.


Trusted time stamping support for digital signatures.


Domain-based password complexity checking and enforcement. 


Encryption strengthening enhancements. 


Improvements to the password to modify feature.


Integrity checking of encrypted files.

Office 2010 also provides several security improvements that have a direct effect on information worker productivity. Improvements in the message bar user interface, a trust model that remembers users’ trust decisions, Trust Center user interface settings, and single identity management are some examples of new features that help make security decisions and actions less intrusive to information workers. In addition, many of the new and enhanced security controls can be managed through Group Policy settings. This makes it easier for you to enforce and maintain your organization’s security architecture.

For more information about security for Office 2010, see Security overview for Office 2010 (http://technet.microsoft.com/library/67869078-71c6-45f5-aab0-0823c83aed54(Office.14).aspx) and Plan security for Office 2010 (http://technet.microsoft.com/library/c38e3e75-ce78-450f-96a9-4bf43637c456(Office.14).aspx).

Office Customization Tool changes

The Office Customization Tool (OCT) is the main customization tool that is used to customize an installation of Microsoft Office 2010 (and the 2007 Microsoft Office system). The OCT is part of the Setup program and is the recommended tool for most customizations, and is available only with volume licensed versions of Office 2010 and the 2007 Office system. You run the OCT by typing setup.exe /admin at the command line. 

For more information about the OCT, see Office Customization Tool in Office 2010 (http://technet.microsoft.com/library/8faae8a0-a12c-4f7b-839c-24a66a531bb5(Office.14).aspx).

The Office 2010 release provides the following new features:


Two architecture-specific versions of the OCT, one for 32-bit Office 2010 and one for 64-bit Office 2010. The 64-bit version of the OCT supports 64-bit client editions of Office 2010, and provides the same user interface, capabilities, and OPA settings as the 32-bit version. The OCT files are located in the Admin folder under the x86 (32-bit) and x64 (64-bit) folders, respectively.

For information about 64-bit Office 2010, see 64-bit editions of Office 2010.


Import feature that lets administrators import 32-bit OCT customization (.msp) updates into the 64-bit version of the OCT and 64-bit .msp updates into the 32-bit version of the OCT. This allows administrators of mixed environments (32-bit and 64-bit) to do the Setup customizations one time. For more information, see Import an Office 2010 Setup customization file (http://technet.microsoft.com/library/6bd88342-4f3a-4535-a570-475d251ef9da(Office.14).aspx).


Support for adding multiple Microsoft Outlook e-mail accounts.

Application virtualization

Microsoft Application Virtualization (App-V) is another method to deploy Office 2010. Virtualization transforms applications into virtualized, network-available services that are not installed on the users’ computer. Instead, applications can be automatically delivered to the users’ computer as users need them.

By using App-V and Office 2010 together, you can quickly deliver the latest version of Office without having to worry about application conflicts or delays in productivity for users. Deploying Office 2010 with App-V 4.6 (currently in Beta) includes new support for integration with SharePoint Products and Technologies, Outlook Search, and Microsoft OneNote 2010. App-V 4.6 is scheduled for release in 2010.

App-V significantly reduces regression and application interoperability testing. App-V also minimizes the effect on users during application upgrades, patching, and terminations of user rights to applications because restarts and uninstallations are no longer required.

For more information about Application Virtualization, see Planning and Deployment Guide for the Application Virtualization System (http://go.microsoft.com/fwlink/?LinkId=156611).

Additional resources

To learn about application-specific changes, application compatibility in Office 2010, and tools for preparing to migrate to Office 2010, see the following resources:


For information about application-specific changes in Office 2010, see Product and feature changes in Office 2010.


To learn about application compatibility in Office 2010, see Application compatibility assessment and remediation guide for Office 2010, Office Environment Assessment Tool (OEAT) user's guide for Office 2010, and Microsoft Office Code Compatibility Inspector user's guide.


For information about tools for preparing your environment for migrating to Office 2010, see Office Migration Planning Manager (OMPM) overview for Office 2010.

For information about architecture changes that were introduced in the 2007 Microsoft Office system for administrators who might not be familiar with that version of the product, see Setup changes introduced in the 2007 Office system.

See Also
User interface differences in Office 2010 from earlier versions of Microsoft Office
Setup architecture overview for Office 2010 (http://technet.microsoft.com/library/f022a92a-2c32-44b7-996d-09e671a41e9c(Office.14).aspx)
Setup changes introduced in the 2007 Office system
System requirements for Office 2010
Changes in Office 2010
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SharePoint Workspace 2010 overview

This article describes the key functionality and architecture of Microsoft SharePoint Workspace 2010. SharePoint Workspace 2010 is the new name for and succeeds Microsoft Office Groove 2007. SharePoint Workspace 2010 is a client application that provides fast, any-time interactive access to document libraries and lists on Microsoft SharePoint Server 2010 and Microsoft SharePoint Foundation 2010. SharePoint Workspace 2010 also provides options for creating Groove peer workspaces and Shared Folder workspaces. SharePoint Workspace 2010 is more versatile than Microsoft Office Groove 2007 and can be integrated with Microsoft SharePoint Server 2010 or can run independently.

Microsoft SharePoint Workspace 2010 provides a client for Microsoft SharePoint Server 2010 and Microsoft SharePoint Foundation 2010 that enables real-time synchronization of desktop content with SharePoint documents and lists. SharePoint Workspace 2010 also provides options for creating Groove collaboration workspaces and synchronized shared folders. By using SharePoint Workspace 2010, information workers can easily synchronize online and offline content with a designated SharePoint site or collaborate with external partners and offsite team members through shared workspaces. SharePoint Workspace 2010 is included with Microsoft Office Professional Plus 2010.

Key features of SharePoint Workspace 2010 include the following:


A choice of workspace types:

SharePoint workspaces — Provide direct bi-directional synchronization of library and list content between a SharePoint site and a workspace on an individual client computer. Creation of a SharePoint workspace enables individual SharePoint users to check out and check in SharePoint library documents from their local computers, bring SharePoint documents and lists to their computers where they can work online or offline, and synchronize local content with a SharePoint site. When an individual client establishes a connection with a SharePoint server, synchronization occurs at regular intervals when the client is online. When a client cannot connect to a SharePoint site, the user can easily take work offline to make updates. The updated documents are automatically synchronized with SharePoint document libraries and lists when the user reconnects. This interface offers an efficient and satisfying alternative to browser access of SharePoint. Unlike other workspace types, the SharePoint workspace is a personal synchronized copy of a SharePoint site.


Groove workspaces — Provide a rich and secure peer collaboration environment that supports synchronization of content among peer client computers that host a shared workspace. Creation of a Groove workspace enables SharePoint Workspace users to quickly form teams and automatically synchronize online or offline contributions with fellow team members. A full set of collaboration tools lets team members schedule meetings, hold discussions, and share work with trusted partners around the world. Support for communications under various network conditions and across firewalls facilitates timely and effective collaboration.


Shared Folder workspaces — Support Windows folder sharing among clients. Creation of a Shared Folder workspace lets information workers share the contents of a common folder in a designated Windows Explorer directory.


Easy setup   Windows users can easily download and run SharePoint Workspace 2010 without IT assistance. 


Offline and online collaboration   Information workers can easily synchronize online and offline work, through a SharePoint workspace, Groove workspace, or Shared Folder workspace. Content is synchronized dynamically among online collaboration points and updates are transmitted immediately when an offline client comes back online. When an offline client reconnects, SharePoint Workspace automatically adds offline contributions to the workspace and applies workspace updates to the previously offline client.


Immediate access to latest document versions   Updates to SharePoint workspaces are distributed quickly and automatically to SharePoint Server document libraries and lists. Likewise, document and list updates are automatically synchronized (on a 15-minute schedule) from SharePoint servers to SharePoint workspaces. Updates to Groove workspaces are automatically synchronized among workspace peers.


Bandwidth usage optimization   To minimize workload, update packets, instead of whole files or documents, are transmitted over the network.


Integration with Windows logon   SharePoint Workspace 2010 uses Windows logon credentials to authenticate users so that a separate logon is not necessary.


Microsoft Communicator integration and built-in workspace messaging   SharePoint Workspace 2010 supports Microsoft Communicator contact presence detection and messaging while offering workspace members a choice of messaging types.


Familiar user interface   The user interface presents the ribbon and other technology that is familiar to Office users.


Searchable content   Windows Desktop Search 4.0 can be used to find content in workspaces.


Common file dialog boxes   Windows technology enables Microsoft Office 2010 users to directly open and save files in SharePoint Workspace.


Safe Mode operation   SharePoint Workspace 2010 users who encounter problems can restart in Safe Mode, attempt to resolve the issue, and then restart as usual.


For Groove workspace users:

Collaboration tools support document creation and editing, discussions, meeting management, and other tasks.


The Documents tool enables users to store, organize, and share Word, text, and other documents. This tool replaces the Groove 2007 Files tool.


The Lists tool provides a custom tool Design environment that uses Microsoft InfoPath 2010. Tool developers import form templates designed in InfoPath into the Lists tool and then perform additional layout, sorting, and filtering tasks in the List Tool Designer. The List tool replaces Groove 2007 Forms and InfoPath Forms tools.


Built-in security protects user content. SharePoint Workspace 2010 automatically and securely distributes and saves content that Groove workspace members produce during their interactions, transmitting it directly to workspace members for storage on member computers. All communications are private, transmitted only among authenticated members and the content of workspace member transmissions is encrypted over the network. SharePoint Workspace 2010 avoids storing member content on remote servers that might not be secure.


Standards-based public key infrastructure (PKI) provides a solid framework for securing Groove workspaces.


Ability to traverse firewalls enables collaboration with trusted partners outside the corporate intranet.


Compatibility with Office Groove 2007 workspaces simplifies collaboration strategies.


Onboard Groove workspace backup mechanism.

For more information about SharePoint Workspace functionality, see the SharePoint Workspace product description at Microsoft products online (http://go.microsoft.com/fwlink/?LinkId=162269).

See Also
Plan for SharePoint Workspace 2010 (http://technet.microsoft.com/library/e8a433c1-ea1f-4cf7-adc8-50972f58d465(Office.14).aspx)
Configure and customize SharePoint Workspace 2010 (http://technet.microsoft.com/library/5290b730-b9fd-4228-93e0-7ace1766aa85(Office.14).aspx)
Overview of the Office user interface in Office 2010

Microsoft Office 2010 builds on the foundation that was established in the 2007 Microsoft Office system by including the ribbon in all Office applications and by adding a new component named the Microsoft Office Backstage view.

This article contains an introduction to the Microsoft Office Fluent user interface (UI). The Office Fluent UI makes it easier to find and use commands and features by using the ribbon, the Quick Access Toolbar, and the new Backstage view.

In this article:


Backstage view

Ribbon

Quick Access Toolbar
Backstage view

The Backstage view is accessed by clicking the File tab, which replaces the Microsoft Office button and File menu that were in previous versions of Office. The Backstage view is available in every Office 2010 product that supports the Office Fluent UI. It helps users discover and use the features that are not part of the ribbon, such as sharing, printing, and publishing tools. The Backstage view lets you see all the information about a document in one place.

In addition, the Backstage view provides contextual information. For example, a workbook has a disabled macro in it, which is necessary for the file to work correctly, and the macro is blocked to protect your computer. You can view the contextual information about the macro and enable the macro by using the Info tab. Another example, a document that was created in an earlier version of Office is opened in Compatibility mode and some rich new features are disabled. You can view the status of the document and convert the document to the latest version (if you want to use those features) by using the Info tab. If the document is located on a Microsoft SharePoint 2010 Products site and you use features such as Co-authoring, Workflows, Check Out, or Policy, the Info tab will always show you what is occurring with your document (for example, a workflow task that is assigned to you).

Similarly to the ribbon, the Backstage can be extended via custom UI that uses XML to define the elements, such as workflow or task information that is specific to your needs.

For more information about how to use and customize the Backstage, see Customizing the Office 2010 Backstage View for Developers (http://go.microsoft.com/fwlink/?LinkId=184245).

Ribbon

The ribbon is at the top of the work area in the Office applications, which provides a consistent appearance and behavior. Tabs organize commands in logical groups. Along with the main tabs, which are always present on the screen, the ribbon provides contextual tabs that appear when you are working on a particular object (for example, a table, chart, or image). The contextual tabs provide the appropriate tools at the appropriate time for a particular object.

Two new features added to the extensibility model of the ribbon are tab activation and auto-scaling. Tab activation lets you activate a tab (bring a tab to the foreground) on demand. Auto-scaling enables ribbon groups to adapt their layout to best match the horizontal window size.

In Office 2010, the ribbon tabs can be easily customized by any user, without using programmatic means. To customize the commands listed on the ribbon, follow these steps:

1.
Click the File tab.

2.
Click Options, and then select Customize Ribbon.

3.
Choose the commands that you want to add or remove from the ribbon.

User customizations (including both ribbon and Quick Access Toolbar customizations) can be exported as a single Office UI file. This file can be imported by another user, or can be provided for an enterprise-level deployment by using the Office Customization Tool (OCT). The OCT settings only provide initial defaults and users can still use the application UI to change the settings afterward. To prevent end-user customization, we recommend that you use Group Policy.
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Tip


For information about how to configure settings by using the OCT, see Configure user settings for Office 2010 (http://technet.microsoft.com/library/29cdde97-d1a7-4683-9c34-bd0bd78c41cc(Office.14).aspx). The OCT does provide an option to add a file. For more information about how to add a file by using the OCT, see the Additional content (http://technet.microsoft.com/library/8faae8a0-a12c-4f7b-839c-24a66a531bb5.aspx#Additional_content) section in Office Customization Tool in Office 2010 (http://technet.microsoft.com/library/8faae8a0-a12c-4f7b-839c-24a66a531bb5(Office.14).aspx).


You can set or clear administrative policies related to the Office Fluent UI by using the Group Policy Management Console.

For new users to the Office 2010 UI, the game Ribbon Hero can be a fun way to learn new tools while improving your productivity with Office. This concept test is an add-in for Word, PowerPoint and Excel that helps you increase your Office skills while you play games, score points, and compete with friends via an optional Facebook application. To download the free game from the Microsoft Office Labs, see Ribbon Hero game (http://go.microsoft.com/fwlink/?LinkId=184740&clcid=0x409).

Quick Access Toolbar

The Quick Access Toolbar provides a way to put the commands and buttons that you use most often within easy reach. By default, the Quick Access Toolbar appears above the ribbon on the application title bar. However, users can chose to move it below the ribbon.

The Quick Access Toolbar can be easily customized by users to accommodate their working environment. To customize the commands listed on the Quick Access Toolbar, follow these steps:

1.
Click the File tab.

2.
Click Options, and then select Quick Access Toolbar.

3.
Choose the commands that you want to add or remove from the Quick Access Toolbar.

User settings (including both ribbon and Quick Access Toolbar customizations) can be exported to be used by another user, or you can choose to import another customized file from this location. For more information, see Deploying a Customized Ribbon and Quick Access Toolbar in Office 2010 (http://go.microsoft.com/fwlink/?LinkId=184247).

See Also
Customizing Context Menus in Office 2010 (http://go.microsoft.com/fwlink/?LinkId=182186)
Customize the Office user interface in Office 2010 (http://technet.microsoft.com/library/56c5e2cf-5456-4e5f-96a4-45e12df9382f(Office.14).aspx)
User interface differences in Office 2010 from earlier versions of Microsoft Office

Within each application, Microsoft Office 2010 has improved functionality in many areas. When the 2007 Microsoft Office system was released, a significant difference from Office 2003 was the introduction of the ribbon in the user interface (UI) for Microsoft Office Access 2007, Microsoft Office Excel 2007, Microsoft Office PowerPoint 2007, Microsoft Office Word 2007, and parts of Microsoft Office Outlook 2007. The UI changed from a collection of menus and toolbars to a single ribbon mechanism. The Microsoft Office 2010 suites maintain the ribbon and have some new features.

The ribbon is now available across all products of the Office 2010 suites so moving from one application to another is seamless. In addition to changes in the ribbon, the Office 2010 suites background is now a gray color, by default, whereas the 2007 Office system background was blue. For more information about specific changes in Office 2010, see Product and feature changes in Office 2010.

Table of differences

The following table describes the differences in UI elements among Office 2010, the 2007 Office system, and Office 2003.

	UI element
	Office 2010
	Office 2007
	Office 2003

	Menus and tabs
	The ribbon replaces menus and toolbars across all products of Office 2010 and can be fully customized.
	The ribbon replaces menus and toolbars in Access 2007, Office Excel 2007, PowerPoint 2007, Word 2007, and parts of Outlook 2007.
	Menus and toolbars only are available.

	Task panes
	Groups of commands on the ribbon and the ability to customize.
	Groups of commands on the ribbon and the ability to customize.
	Basic task pane.

	Quick Access Toolbar (QAT)
	Fully customizable.
	Introduced in 2007.
	Not available.

	Backstage view
	More tools outside the document viewing window.
	Limited tools that can be accessed through the Microsoft Office Button.
	Limited tools on the File menu

	Digital signatures
	Found in the Backstage view under Information about Document / Protect Document.
	Formatted with XMLDSig, found under File / Finalize Document / Signatures.
	Found under Tools / Options / Security / Digital Signatures

	Smart Art
	Improved from the 2007 version.
	Design tools available in all Microsoft Office applications.
	Not available.

	Open Formats (*.odt) OpenDocument Text
	Included in this version.
	Added in 2007 Office system Service Pack 2 (SP2).
	Not available.

	Windows Live Writer integration
	Blog posting options available in the application.
	Not available.
	Not available.

	Spelling checker
	The spelling checker is now integrated with automatic correction.
	Basic spelling checker.
	Basic spelling checker.

	Paste Preview
	A live preview before you commit to Paste. Avoids having to use the Undo button.
	Paste, Undo, Paste.
	Basic Paste capabilities.

	Print
	The Backstage combines Print with Print Preview, Page Layout and other print options. 
	Microsoft Office Button, Print with limited printing tools spread across several commands.
	Basic Print option on the File menu.

	Sparklines
	A miniature chart inserted into text or embedded in a spreadsheet cell to summarize data.
	Dynamic charts and chart types.
	Three-dimensional (3-D) charting.

	E-mail Essentials
	Conversation, Cleanup, Ignore Thread, and Mail Tips for when a person is out of the office or if e-mail is sent to a group.
	Not available.
	Not available.

	Photo editing tools
	Available in these applications: (Word 2010, Excel 2010, PowerPoint 2010, Outlook 2010, and Microsoft Publisher 2010).
	Limited functionality.
	Limited functionality.

	Video in Microsoft PowerPoint
	Video triggers and controls.
	Not available.
	Not available.


See Also
What's new for IT professionals in Office 2010
Product and feature changes in Office 2010
Product and feature changes in Office 2010

This section contains a list of articles that describe new features, changed features, and deprecated features for the products in the Microsoft Office 2010 suites, as well as Microsoft Project 2010 and Microsoft Visio 2010. Each article also describes migration considerations for the particular product.

In this section:

	Article
	Description

	Changes in Office 2010
	Lists changes in Microsoft Office 2010 since the 2007 Microsoft Office system.

	Changes in Access 2010
	Lists changes in Microsoft Access 2010 since Microsoft Office Access 2007 and migration considerations.

	Changes in Excel 2010
	Lists changes in Microsoft Excel 2010 since Microsoft Office Excel 2007 and migration considerations.

	Changes in InfoPath 2010
	Lists changes in Microsoft InfoPath 2010 since Microsoft Office InfoPath 2007.

	Changes in OneNote 2010
	Lists changes in Microsoft OneNote 2010 since Microsoft Office OneNote 2007 and migration considerations.

	Changes in Outlook 2010
	Lists changes in Microsoft Outlook 2010 since Microsoft Office Outlook 2007 and migration considerations.

	Changes in PowerPoint 2010
	Lists changes in Microsoft PowerPoint 2010 since Microsoft Office PowerPoint 2007 and migration considerations.

	Changes in Project 2010
	Lists changes in Microsoft Project 2010 since Microsoft Office Project 2007 and migration considerations.

	Changes in Publisher 2010
	Lists changes in Microsoft Publisher 2010 since Microsoft Office Publisher 2007 and migration considerations.

	Changes in SharePoint Designer 2010
	Lists changes in Microsoft SharePoint Designer 2010 since Microsoft Office SharePoint Designer 2007.

	Changes in SharePoint Workspace 2010
	Lists changes in Microsoft SharePoint Workspace 2010 since Microsoft Office Groove 2007 and migration considerations.

	Changes in Visio 2010
	Lists changes in Microsoft Visio 2010 since Microsoft Office Visio 2007 and migration considerations.

	Changes in Word 2010
	Lists changes in Microsoft Word 2010 since Microsoft Office Word 2007 and migration considerations.


Changes in Office 2010

This article lists changes in Microsoft Office 2010 since the 2007 Microsoft Office system and migration considerations. 

In this article:

What’s new
What’s changed
What’s removed
Migration considerations
What’s new

For information about the new features in Microsoft Office 2010 that are relevant to IT administrators, see What’s New for IT Professionals in Office 2010 in What's new for IT professionals in Office 2010.

What’s changed

This section summarizes the feature changes in Office 2010.

Insert Clip Art task pane and Clip Organizer

The Insert Clip Art task pane and Clip Organizer functionality remains generally unchanged in Office 2010. However, the feature that enabled downloading and managing a locally stored clip art collection has instead been replaced by the ability to search for and insert online clip art. This change is due to an increased desire by Office users (who are becoming more Internet savvy) to be able to grab and use images from the Web immediately without having to store them for later use.

HTML editor

The HTML editor is updated for Windows SharePoint Services, Microsoft Office SharePoint Server, and Microsoft InfoPath. New features include cross-browser support, XHTML support, and a shared editor.

Legacy brightness and contrast

Da Vinci brightness and contrast algorithms replace legacy algorithms, and are now available through the user interface and Office Manager. Legacy brightness and contrast algorithms are still available for backward compatibility. This is a core architecture change.

Besides brightness and contrast, other photo editing algorithms and tools are provided through the user interface and Office Manager. With this change, users can receive improved photo editing results. If a photo does not contain 2007 Office system brightness or contrast edits, the visual fidelity of the 2007 Office system brightness and contrast is retained in Office 2010. If a photo does contain 2007 Office system brightness or contrast edits, Office 2010 produces better results because the old effects are converted into new effects.

Language Preferences

Language Preferences replaces Language Settings and assists users in showcasing language packs and in determining whether the necessary proofing tools or keyboards are enabled. Included are direct links to online locations where users can obtain additional tools. There is also new functionality, such as ScreenTip Language.

What’s removed

This section provides information about removed features in Office 2010.

Insert Clip Art task pane and Clip Organizer

Deprecated functionality in both the Insert Clip Art task pane (within client applications) and the standalone Clip Organizer application:


Simplified drop-down menu options for "Search In" (replaced by a check box to include or exclude online content) and "Media Types" (Photo, Illustration, Audio and Video. The level of granularity for file extensions is removed).


Removing thumbnail icons indicating online content and clip art loading from a media CD.

Deprecated functionality in the Insert Clip Art task pane only:


Removing the "Organize Clips" link.

Deprecated functionality in the standalone Clip Organizer application only:


Auto-import local content into Clip Organizer


Associate a folder with a particular collection (for use by auto-import)


Find Similar Style within a user's local clipart content library


Send clip art to Mail recipient(s) feature


List and Details views of the Clip art (we keep only thumbnail view now)


Delete a clip from a particular collection.

Symbol input add-in: East Asia versions of Office 2010

The special symbol input add-in is removed from Microsoft Word 2010, Microsoft Excel 2010, Microsoft PowerPoint 2010, and Microsoft Access 2010 in the East Asia versions of Office 2010. 

This change includes the language releases shown in the following table.

	Language
	Geographic area
	Language tag (ll-cc)
	LCID

	Chinese (Simplified)
	People's Republic of China
	zh-cn
	2052

	Chinese (Traditional)
	Hong Kong SAR
	zh-hk
	3076

	Chinese (Traditional)
	Taiwan
	zh-tw
	1028


This feature is removed because users can easily access this functionality through the similar feature that is available through the Insert Symbol button in the Symbol group under the Insert tab, or through the Input Method Editor (IME).

InterConnect

InterConnect is removed from Office 2010. InterConnect provided Japanese users with a unique, electronic business card that could be secured and delivered. It was available as a part of Microsoft Office Ultimate, InterConnect retail SKU, and Microsoft Outlook+InterConnect retail SKU.

Office Startup Assistant

Although turned off by default in 2007 Microsoft Office system, the ability to create a new Office document from the Start menu, or Office Startup Assistant (OSA), is completely removed in Microsoft Office 2010. Users can no longer manually turn on the feature in the Start menu through Office 2010 setup or open a dialog box to create a new document in an Office 2010 application.

This feature is replaced by the ability to create a new Office document for each Office 2010 application from the Microsoft Office Backstage by clicking New and then creating the document. In addition, the improved functionality is compatible with the 64-bit version of Office 2010.

Office Diagnostics

Office Diagnostics, also known as Customer Watson, is removed for all Office 2010 applications. Because of shifting resources, the focus must be on analysis and reporting features that have been proven beneficial for other teams. Users must now run the repair utility from the Control Panel.

Document workspaces

The following is removed from Microsoft Word 2010, Microsoft Excel 2010, Microsoft PowerPoint 2010, Microsoft OneNote 2010, Microsoft Visio 2010, and Microsoft Outlook 2010.


The ability to create document workspaces.


The ability to create shared attachments in Outlook.


The ability to invoke actions on Microsoft SharePoint Foundation by using the Document Management pane.


The functionality that enables the local copy of the document to synchronize with the server copy.

Users can no longer access the following in Service Options in the <Application> Option dialog box: Create Document Workspace, Document Information Management, and Document Management. The synchronization functionality is replaced by the implicit cache, which enables users to continue editing within the document workspace even when the document is offline and then automatically sync the changes to Windows SharePoint Services the next time that the document is online. The implicit cache prevents user confusion over which option to use.

Support for Microsoft XML Parser 5

Office 2010 does not support Microsoft XML Parser 5 (MSXML5). Existing solutions will not create an instance of MSXML5 objects when they are loaded by Office 2010. Migrate code to Microsoft XML Parser 6 (MSXML6) or to managed code that uses the .NET Framework. 
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Note: 

MSXML6 does not support Digital Signature code. For more information about MSXML6, see Building MSXML Applications (http://go.microsoft.com/fwlink/?LinkId=187366).

Migration considerations

When planning a migration to Office 2010, review what is new, changed, and removed for Office 2010. In addition, see the Migration considerations sections in the articles listed in See Also.

See Also
Changes in Access 2010
Changes in Excel 2010
Changes in InfoPath 2010
Changes in OneNote 2010
Changes in Outlook 2010
Changes in PowerPoint 2010
Changes in Project 2010
Changes in Publisher 2010
Changes in SharePoint Designer 2010
Changes in SharePoint Workspace 2010
Changes in Visio 2010
Changes in Word 2010
Changes in Access 2010

This article lists changes in Microsoft Access 2010 since Microsoft Office Access 2007 and migration considerations. If you are upgrading from Microsoft Office Access 2003, see also Changes in Access 2007 (http://go.microsoft.com/fwlink/?LinkId=164065) and Migration considerations for Access 2007 (http://go.microsoft.com/fwlink/?LinkId=164070).

In this article:

What’s new
What’s changed
What’s removed
Migration considerations
What’s new

This section highlights new feature in Access 2010 that might be of more interest to IT administrators. For more information about new features, see Microsoft Access 2010 (http://go.microsoft.com/fwlink/?LinkId=182564).

Share a database on the Web

In Office Access 2007, there was limited support in sharing a database to the Web, where you could only publish your lists and move the database to document libraries. Now, in Access 2010, if you have access to Access Services in Microsoft SharePoint Server 2010, you can create a Web database by using Access 2010. Users can use your database in a Web browser window, but you must use Access 2010 to make design changes. Although some desktop database features do not translate to the Web, you can do many of the same things by using new features, such as calculated fields and data macros.

Export to .pdf and .xps

In Access 2010, you can export data to a .pdf file format (Portable Document Format) or an .xps file format (XML Paper Specification) to print, post, and distribute e-mail. In Office Access 2007 this capability was also available through a downloadable add-in. Beginning with Office Access 2007 SP2 and continued with Access 2010, this feature was built into the product so you do not need to install any additional software. Exporting a form, report, or datasheet to a .pdf file or an .xps file lets you capture information in an easy-to-distribute form that retains all the formatting characteristics, but does not require other users to install Access on their computers to print or review your output.

Connect to a Web service as an external data source

You can now connect to a Web service as an external data source. You will need a Web service definition file provided by the Web service administrator. After you install the definition file, you can link to Web service data as a linked table.

Backstage view

The Microsoft Office Backstage is part of the Microsoft Office Fluent user interface (UI) and a companion feature to the ribbon. The Backstage view, which can be accessed from the File tab, contains commands that you apply to an entire database, such as compact and repair, or open a new database. (The File tab replaces the Microsoft Office Button and File menu that were used in earlier releases of Microsoft Office.) Commands are arranged on tabs on the left side of the screen, and each tab contains a group of related commands or links. For example, if you click New, you see a set of buttons that let you create a new database from scratch, or you can select from a library of professionally designed database templates. 

What’s changed

This section summarizes some of the feature changes in Access 2010 that might be of more interest to IT administrators. 

Backward compatibility between Access 2010 and Access 2007

Access 2010 introduces features that are not supported in Office Access 2007. Although Office Access 2007 SP1 will not open databases that contain these features, Office Access 2007 SP2 offers limited viewing and designing capabilities. 

Enhanced security

Enhanced security features and strong integration with Microsoft SharePoint Foundation 2010 help you more effectively manage data and allow you to make your information tracking applications more secure than before. By storing your tracking application data in lists on SharePoint Foundation 2010, you can audit revision history, recover deleted information, and set data access permissions.

Office Access 2007 introduced a new security model that is carried forward and improved in Access 2010. Unified trust decisions are integrated with the Microsoft Office Trust Center. Trusted locations make it easy to trust all databases in secure folders. You can load an Office Access 2007 application with code or macros that are disabled to provide a more secure, sandbox experience (that is, unsafe commands cannot be run). Trusted macros are run in Sandbox mode.

Support for SQL Server 2008 data types

Access 2010 provides limited support in Access projects (.adp) for the following seven new data types introduced in Microsoft SQL Server 2008:


date


datetime2


datetimeoffset


time


geography


geometry


hierarchyID

The following three data types are unsupported when you use table or view design mode in Access 2010:


geography


geometry


hierarchyID

The alternative is to use SQL Server 2008 design tools for creating tables, views, stored procedures, and functions when you use any of these three data types. You can still use Access 2010 to design reports, forms, modules and macros that reference these data types.

What’s removed

This section provides information about removed features in Access 2010 that might be of more interest to IT administrators.

Calendar control (mscal.ocx)

The Microsoft Calendar control (mscal.ocx) is not available in Access 2010. An alternative is to use the date picker control in Access 2010. Opening an application from an earlier version of Access where the control was used will generate an error message in Access 2010 and the control will not appear. 

Microsoft Replication Conflict Viewer

The Microsoft Replication Conflict Viewer is not available in Access 2010. To achieve the same functionality, you can use the ReplicationConflictFunction property in a database replica set so that you can create a custom procedure to resolve synchronization conflicts. For more information, see How to Use the ReplicationConflictFunction Property (http://go.microsoft.com/fwlink/?LinkId=165394).

Snapshot file format

The ability to export a report as a snapshot file is not available in Access 2010. Alternatives to the snapshot file format, in which file formats preserve the layout and formatting of the original report, are .pdf and .xps file formats.

Data access pages

Beginning with Office Access 2007, the ability to create, modify, or import data access pages was no longer supported. However, data access pages in an Office Access 2007 database would still function. By using Access 2010, you can open a database that includes data access pages. However, the data access pages will not function. When you attempt to open a data access page, you will receive an error message that states that Microsoft Office Access does not support this operation for Data Access Pages.

An alternative to using data access pages is to create a Web database and publish to a SharePoint site by using Access Services. For more information, see What's new for Access Services in SharePoint Server 2010 (http://go.microsoft.com/fwlink/?LinkId=182566).

Lotus 1-2-3, Paradox, Jet2.x, and Red2 IISAM

The IISAM (installable index sequential access method) for Lotus 1-2-3, Paradox, Jet2.x, and Red 2 is not available in Access 2010. If you need to link to, import from, or export to one of these IISAMs, you can use Office Access 2007 or earlier. When you attempt to create a link to, import from, or export to a Jet 2.x or Red 2 database, and when you select or paste a linked table to Lotus 1-2-3 or Paradox, you might receive one of the following error messages:

Migration considerations

When you plan a migration to Access 2010, review what is new, changed, and removed for Access 2010. Because Access 2010 has many similarities with Office Access 2007, such as the same native file format, you can also review and use the existing migration documentation for Office Access 2007 when you migrate to Access 2010.

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 was updated to VBA 7.0. VBA 7.0 settings were reset to their defaults after migration instead of automatically repopulating. This occurred because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	Office 2000 through Office 2007
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\7.0\Common


To correct this problem, copy the VBA 6.0 registry keys from the 6.0 hive to the 7.0 hive.

For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx) and Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=185841).
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Introduction to Office Migration Planning Manager (OMPM) (http://go.microsoft.com/fwlink/?LinkId=165906)
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Changes in Excel 2010

This article lists changes in Microsoft Excel 2010 since Microsoft Office Excel 2007 and migration considerations. If you are upgrading from Microsoft Office Excel 2003, see also Changes in Excel 2007 (http://go.microsoft.com/fwlink/?LinkId=134563) and Migration considerations for Excel 2007 (http://go.microsoft.com/fwlink/?LinkId=164062).

In this article:
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What’s new

This section highlights new features in Excel 2010 that might interest IT administrators. For more information about new features, see Microsoft Excel 2010 (http://go.microsoft.com/fwlink/?LinkId=182569).

In addressing user needs

This section highlights changes in Excel 2010 to address user needs, especially improvements in programmability.

High performance computing clusters

In Excel 2010, High Performance Computing (HPC) solves computationally intensive problems by using multiple computers. Excel 2010, running on a desktop computer, can offload the evaluation of certain kinds of user-defined functions to a compatible cluster, such as HPC Windows Server 2008. This offload enables Excel 2010 to continue calculating other parts of the workbook in parallel to the cluster calculating the user-defined functions. Secondly, complete workbooks can also be calculated on the cluster. For example, a workbook model can be recalculated many thousands of times by performing batches of calculations in parallel on the cluster. When a supported computer cluster is available, users can instruct Excel 2010 to use that cluster by selecting a cluster connector and configuring a specific cluster name to use in the Advanced options of the Excel Options dialog box.

Use this capability in Excel 2010 to solve mathematical analysis or data processing problems, or Monte Carlo simulations. Cluster-safe user-defined functions must be implemented in an XLL. You cannot create a cluster-safe user-defined function in VBA or in a COM automation add-in. Also, cluster-safe user-defined functions cannot interact with Excel in any way except to return their value. Workbooks must be designed for the cluster. This means that existing workbooks will not necessarily work on the cluster without modification. This option is not supported for 32-bit and ia64-based, language-specific, Itanium platforms. This option is not supported for 32-bit and ia64-based, language-specific, Itanium platforms.

Macro recording support for chart elements

In Microsoft Office Excel 2007, recording a macro while formatting a chart, or other object, did not produce any macro code. However, in Excel 2010, you can use the macro recorder to record formatting changes to charts and other objects and then reuse those changes repeatedly. Standardize formatting by distributing these macros to users.

Closing XLM/VBA gaps

Excel has a macro facility, known as Excel 4 macros (XLM for short), that was the primary macro language prior to the introduction of VBA in Excel 5.0. Most people have long ago migrated their Excel 4 macros to VBA. However, some Excel 4 macro capabilities were missing from VBA, which made this migration difficult.

In Excel 2010, one of our goals was to remove any remaining barriers that people had to complete the migration of Excel 4 macros to VBA. Excel 2010 does still enable the creation, editing and execution of Excel 4 macros. You can use Excel 2010 to migrate your macros.

User-defined functions run asynchronously

In Excel 2010, you can author these non-processor-intensive user-defined functions as asynchronous. This ability is supported in XLL add-ins, and the new Excel 2010 SDK has all that you need for writing asynchronous user-defined functions.

How it works
Break your user-defined function in two parts:

1.
A synchronous function call, which sets up the asynchronous calculation, data request, external Web service call, and so on, and returns immediately.

2.
An asynchronous part, which returns the result to Excel when it is ready.

Excel tracks uncompleted user-defined function calls and continues independent parts of the calculation. When the user-defined function call result becomes available to your XLL add-in, the add-in then calls back into Excel with the user-defined function result. For information about how to configure the XLL add-in, see Programmability Improvements in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2010/01/27/programmability-improvements-in-excel-2010.aspx).

In Business Intelligence

Business Intelligence (BI) is a category of technologies that are used to support decision making.

Sparklines

Sparklines are a new kind of visualization in Excel 2010. They are small cell-sized graphics used to show trends in series of values by using line, column, or win/loss charts. Sparklines allow the viewer to see in a single cell information-dense graphics that greatly increase reader comprehension of the data. They demonstrate the “what” not the “why” of the data. For more information, see Sparklines in Excel (blog) (http://blogs.msdn.com/excel/archive/2009/07/17/sparklines-in-excel.aspx).

Slicers

Slicers make filtering and interpretation of data easier. They improve PivotTables and CUBE functions in a workbook. Slices filtered data interactively. They float above the grid and behave like report filters so you can hook them to PivotTables, PivotCharts, or CUBE functions to create interactive reports or dashboards. For more information, see Easy (and Even Fun!) Data Exploration: Introducing Excel 2010 Slicers (blog) (http://blogs.msdn.com/excel/archive/2009/09/23/easy-and-even-fun-data-exploration-introducing-excel-2010-slicers.aspx), and Interacting with Slicers (blog) (http://blogs.msdn.com/excel/archive/2009/09/25/interacting-with-slicers.aspx), and Dressing up your Slicers (blog) (http://blogs.msdn.com/excel/archive/2009/09/29/dressing-up-your-slicers.aspx).

Microsoft SQL Server PowerPivot for Excel add-in

If you need to model and analyze very large amounts of data, you can download the PowerPivot for Excel add-in and work with that data inside your Excel workbooks. By using this add-in, you can quickly combine data from multiple sources, including corporate databases, worksheets, reports, and data feeds. You can then interactively explore, calculate, and summarize that data by using PivotTables, slicers, and other Excel features. As you interact with the data, you will notice that the response time is fast, whether you are working with hundreds of rows, or hundreds of millions of rows. If you have access to Excel Services in Microsoft SharePoint Server 2010, you can make your reports and analyses available on a SharePoint site so that other people in your organization can benefit from your work.

For more information about PowerPivot, see Introducing PowerPivot for Excel 2010 (http://go.microsoft.com/fwlink/?LinkId=186137).

Calculation feature improvements

This section provides updates to the Excel calculation engine.

New version of Solver

Excel 2010 includes a new version of the Solver add-in, which you can use to find optimal solutions in what-if analysis. Solver has an improved user interface, a new Evolutionary Solver, based on genetic algorithms, that handles models with any Excel functions, new global optimization options, better linear programming and nonlinear optimization methods, and new linearity and feasibility reports. In addition, the Solver add-in is now available in a 64-bit version. For more detailed help about Solver from Frontline Systems, see Solver Help at www.solver.com (http://go.microsoft.com/fwlink/?LinkId=164909).

New statistical functions

The function library in Excel improved in Excel 2010. Accuracy of functions improved, consistency improved with Excel's function names and definitions with 50 new functions, and a new functions user interface was added. New algorithms were implemented to improve the accuracy of our statistical, financial and math functions. For more information about improvements, see Function Improvements in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2009/09/10/function-improvements-in-excel-2010.aspx).

In Excel Services

This section highlights changes in Excel Services. For more information, see Excel Services 2010 Overview (blog) (http://blogs.msdn.com/excel/archive/2009/11/03/excel-services-2010-overview.aspx).

Excel Services enhancements

Many organizations use Excel Services to share workbooks and data with other people, such as executives and other stakeholders in your organization. If you use Excel Services on a SharePoint site, you can take advantage of the following improvements:


Share workbooks from Backstage   Before Excel 2010, it was previously possible to save and publish worksheet data to a SharePoint site. In Excel 2010, the options for doing this are now conveniently located together on the Share tab in the Microsoft Office Backstage view.


More support for Excel features   Before Excel 2010, if a workbook contained unsupported features, it could not be opened in the browser. In Excel 2010, most workbooks with unsupported features will open. In addition, more Excel features are supported in Excel Services, including new Excel 2010 features such as Sparklines and Slicers.


Edit and collaborate on workbooks   If you publish a workbook to a SharePoint site where Excel Services is installed, you can edit your workbook in a supported Web browser, in addition to viewing it. In addition, you and your colleagues can work on the same workbook at the same time. This means that you no longer have to e-mail a workbook around, or wait for someone to check it back in on the server before you can edit it. For example, imagine that you and your manager are currently viewing the same worksheet in different offices. If you make a change to the data, your manager will see that change on her screen. For more information about Excel Services, see What's new for Excel Services (SharePoint Server 2010) (http://go.microsoft.com/fwlink/?LinkId=168442).


Enhanced programmability   This includes the following:


Improved Web Services API


New REST API


New JavaScript OM


Support of new XL features and visualizations   This includes slicers, sparklines, new conditional formatting, and others.


Better Admin scriptability   By using Windows PowerShell.

In Office suite changes 

The new 64-bit version of Office allows the processing of larger data sets, which is especially important for Excel 2010. You use it in conjunction with the new VBA 7.0. You might need to update VBA when using 64-bit Excel 2010. For more information, see Excel 2010 – Now With More Bits! (blog) (http://blogs.msdn.com/excel/archive/2009/08/28/excel-2010-now-with-more-bits.aspx).

Backstage view

The new Backstage view replaces the traditional File menu. All file management tasks are available in Backstage. Click the File tab to access the Backstage view. Although it was previously possible to save and publish worksheet data to a SharePoint site, in Excel 2010, the options for doing this are now conveniently located together on the Share tab in Microsoft Office Backstage. For more information, see Backstage (blog) (http://blogs.technet.com/office2010/archive/2009/07/15/microsoft-office-backstage-part-1-backstory.aspx).

Excel 2010 64-bit advantages

Applications built with the 64-bit version simply can use more physical memory than ever, especially important for those who need to work with really large data sets. In Excel 2010 investments were made in our 64-bit architecture to optimize our memory consumption while keeping the cell table (and related operations) as fast as possible.

For example, create bigger workbooks using 64-bit Excel that can be too big for 32-bit Excel to open. But generally workbooks are interchangeable between 32-bit and 64-bit. For information about 64-bit support and code compatibility, see Programmability Improvements in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2010/01/27/programmability-improvements-in-excel-2010.aspx).

What’s changed

This section summarizes the feature changes in Excel 2010 that might interest IT administrators. For more information about changed features, see Microsoft Excel 2010 (http://go.microsoft.com/fwlink/?LinkId=182569).

In addressing user needs

This section highlights changes in Excel 2010 to address user needs, especially improvements in programmability.

Compatibility mode tool

New features in Excel 2010 are disabled when you are opening previous versions of Excel in Excel 2010. For example, new 2010 Sparklines and Slicers features are disabled with opening earlier version of Excel. Workbooks created in the Excel 97-2003 file format (.xls) automatically open in Compatibility Mode. Workbooks created in Excel 2010, but destined for others who use earlier versions of Excel, should turn on Compatibility Mode to prevent accidental use of functions and features that are incompatible with the earlier versions of Excel. This is very important for users who plan to share workbooks with other users who have not yet migrated to Office Excel 2007 or a later version.

File loading performance

File loading (opening and saving) lends itself well to parallel processing and the multi-core functionality of Excel 2010. However, the structure and content of workbooks significantly affects the performance gains. For example, if there is only one very large sheet in a workbook, a proportionally large amount of file loading time will be spent simply loading the one sheet. But if you have two very large sheets, Excel can fetch the second sheet off disk while the first sheet is still being loaded into memory.

In Business Intelligence

Business Intelligence (BI) is a category of technologies that are used to support decision making.

PivotTable enhancements

PivotTables are easier and faster to use in Excel 2010. Some of the key improvements include the following:


Improved performance   In Excel 2010, multithreading helps speed up data retrieval, sorting, and filtering in PivotTables.


OLAP Write-back support   In Excel 2010, you can change values in the OLAP PivotTable Values area and have them written back to the Analysis Services cube on the OLAP server. Online Analytical Processing (OLAP) using Excel 2010 is available with the CubeCellValue add-in. Excel workbook data can be stored directly in an Online Analytical Processing (OLAP) cube. The OLAP data is written back to the worksheet to create PivotTable reports that are based on the OLAP source data. Before Excel displays any summarized data in a PivotTable report, an OLAP server performs calculations to summarize the data. The CubeCellValue add-in must be downloaded and installed on computers where this feature is required.


Named sets   Named sets are a tool that allows a re-usable group of items to be created for use in PivotTables. Combine items from different hierarchies (asymmetric reporting) in ways that otherwise wouldn’t be possible. Create PivotTables based on your own custom Multidimensional Expressions (MDX). Create PivotTables that dynamically change based on filters by using dynamic sets. For more information, see PivotTable Named Sets in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2009/10/05/pivottable-named-sets-in-excel-2010.aspx).


Dynamic sets support   When you work with the same set of items from data repeatedly, Excel 2010 provides the ability to easily create and reuse this logical grouping of items as a single object. For OLAP PivotTable users, dynamic rendering using the filter in the matrix is supported.

Filtering

For large worksheets filtering enables the quick location and display of specific data in tables and PivotTable views. Use new Search Filter capability to spend less time sifting through large data sets. For more information, see Excel 2010: New Search Filter (blog) (http://blogs.msdn.com/excel/archive/2009/10/01/excel-2010-new-search-filter.aspx).

Conditional formatting

Conditional formatting allows references to be made to different sheets on the workbook (cross-sheet conditional formatting). Use conditional formatting to discover and show important trends and highlight data exceptions. More styles, data bar options, and new icon sets made available. References to other worksheets allow in conditional formatting rules. Conditional formatting stores dependencies of the formulas used so reevaluation of the entire conditional format is not necessary as often. Pivot tables or scrolling refresh more quickly so they can display faster. For more information, see More Conditional Formatting Features in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2009/08/11/new-conditional-formatting-features-in-excel-2010.aspx).

Icon sets

Icon Sets are a new kind of conditional formatting. An icon is drawn in each cell representing the value of the cell relative to the other cells in the selected range. Icons sets are a great way to create groups of similar data as a part of your data analysis. For more information, see Icon Set Improvements in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2009/08/05/icon-set-improvements-in-excel-2010.aspx).

Data bars

Data bars now drawn proportionally according to their values. Negative values more clearly displayed and zero values are suppressed. For more information, see Data Bar Improvements in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2009/08/07/data-bar-improvements-in-excel-2010.aspx).

OfficeArt controls and objects

In Excel 2010, in addition to shape objects, the following controls and objects are converted to the new OfficeArt technology:


Form controls


Microsoft ActiveX objects


OLE objects


Camera tool objects

Shape objects drawn in earlier versions of Microsoft Excel that are not upgraded to Microsoft Excel 2010 SmartArt format cannot be grouped with shape objects that are created in or upgraded to Excel 2010 SmartArt format. Mixed shape objects are layered, with the earlier versions of shape objects drawn on top of all later versions. This also means that Excel 2010 charts cannot be shown on dialog sheets that were created in an earlier version of Excel. You will not be able to access the new shape objects by clicking Select Objects (Home tab, Editing group, Find & Select button). To select the newer shape objects, you must use the Select Multiple Objects command (File tab, Options, Customize Ribbon).

Pattern fills

Pattern fills removed in 2007 have been reintroduced in Excel 2010. Charts formatted with pattern fills in previous versions of Excel will retain and display the pattern fills when they are opened in Office Excel 2007. For more information, see Chart Pattern Fills (blog) (http://blogs.msdn.com/excel/archive/2007/11/16/chart-pattern-fills.aspx).

In strategic improvements

Charting enhancements

It is easier to work with charts in Excel 2010. Specific improvements include the following:


New charting limits   It is easier to work with charts in Microsoft Office Excel 2007. Specific improvements include new charting limits. In Microsoft Office Excel 2007, you could have up to 32,000 data points in a data series for 2-D charts. In Excel 2010, the number of data points in a data series is limited only by available memory. This enables users — especially those in the scientific community — to more effectively visualize and analyze large sets of data. Memory errors could result if large 64-bit worksheets are calculated on a 32-bit computer.


Macro recording for chart elements   In Office Excel 2007, recording a macro while formatting a chart or other object did not produce any macro code. However, in Excel 2010, you can use the macro recorder to record formatting changes to charts and other objects.


Improvements in the chart UI   Improvements include PivotChart Interactivity, Formatting Enhancements, Parity Improvements, and Limit Increases. Double click any chart element and the format dialog appears. The chart element selector is available in the right-click mini-bar. Pattern fills are available again. When formatting charts, you can now record a macro to use format and layout changes again. Parity Improvements were made in the areas of Axis Scaling, Layout, Visual Parity, and Object Model Parity. Data size limits on charts are removed or increased. Prior limit of 32,000 points per data series on 2D is removed. Machine memory is the current limit. The maximum of 256,000 data points is now removed. The only limit is the available memory and computer capacity. For more information, see More Charting Enhancements in Excel 2010 (blog) (http://blogs.msdn.com/excel/archive/2009/08/25/more-charting-enhancements-in-excel-2010.aspx).

What’s removed

This section highlights features that were available in previous versions of Microsoft Office that are removed from Excel 2010 and that might interest IT administrators. For more information about removed features, see Microsoft Excel 2010 (http://go.microsoft.com/fwlink/?LinkId=182569).

In addressing user needs

This section highlights changes in Excel 2010 to address user needs, especially improvements in programmability.

Clip Art task pane Search in Box

The Search in box is no longer available, which means that you can no longer limit your search to specific collections of content. To narrow your search, you can use multiple search terms in the Search for box.

ClipArt task pane Clip Organizer

Clip Organizer is a tool that arranges and catalogs clip art and other media files that are stored on your hard disk. Clip Organizer is no longer directly accesses the Clip Art task pane in Office programs. In addition, the following changes were made to Clip Organizer:


Although you can delete clips from Clip Organizer, you can no longer delete a clip from a specific collection.


The command that allowed you to find clips of a similar style is no longer available.


The command for sending a clip as an attachment in e-mail messages is no longer available.


The List and Details views are no longer available. Instead, all clips appear as thumbnails in the Clip Organizer window.


The Organize clips link is no longer available. To open Microsoft Clip Organizer from Windows 7, Windows Vista, or Windows XP, click the Windows Start button, click All Programs, click Microsoft Office, click Microsoft Office 2010 Tools, and then click Microsoft Clip Organizer.


The command for automatically finding media files on your computer and organizing them into collections no longer exists. However, you can still add clips manually to Clip Organizer or import them from a scanner or camera.

In calculation features

Conditional Sum Wizard

The Conditional Sum Wizard is replaced in Excel 2010 by a Function Wizard that includes SUMIF and SUMIFS functions. Formulas created in an earlier version that were generated by the Conditional Sum Wizard will continue to work and can be edited using other methods. The legacy Conditional Sum Wizard add-in is no longer available with Excel 2010.

Lookup Wizard

The Lookup Wizard is replaced in Excel 2010 by a Function Wizard that includes SUMIF and SUMIFS functions. Formulas created in an earlier version that were generated by the Lookup Wizard will continue to work and can be edited using other methods. The legacy Lookup Wizard add-in is no longer available with Excel 2010.

Updated statistical functions

The following table shows algorithms for calculating the statistical distribution functions that have been modified or redesigned completely for better accuracy.

	Description
	Function

	Binomial distribution
	BINOMDIST, CRITBINOM

	Chi squared distribution
	CHIDIST, CHIINV

	Exponential distribution
	EXPONDIST

	F distribution
	FDIST, FINV

	Gamma distribution
	GAMMADIST, GAMMAINV

	Hypergeometric distribution
	HYPGEOMDIST

	Lognormal distribution
	LOGNORMDIST, LOGINV

	Negative Binomial distribution
	NEGBINOMDIST

	Normal distribution
	NORMDIST, NORMINV

	Standard Normal distribution
	NORMSDIST, NORMSINV

	Poisson distribution
	POISSON

	Student's t distribution
	TDIST,TINV

	Weibull distribution
	WEIBULL


The following table shows additional functions for which the accuracy has been improved.

	Description
	Function

	Hyperbolic arcsine
	ASINH

	Ceiling function
	CEILING

	Convert function
	CONVERT

	Error function
	ERF

	Complementary error function
	ERFC

	Floor function
	FLOOR

	Natural logarithm of the gamma function
	GAMMALN

	Geometric mean
	GEOMEAN

	MOD function
	MOD

	Random number function
	RAND

	Sample standard deviation
	STDEVS

	Sample variation
	VARS


As part of the accuracy improvements, Excel accepts a larger range of input values. As a result, it will return a wider range of results for certain functions. For example, the ERF and ERFC functions now take negative input values, and the MOD function is able to take larger input values. For more information about the improvements to the statistical functions, see Function Improvements in Microsoft Office Excel 2010 (http://go.microsoft.com/fwlink/?LinkId=186148).

In Office suite changes

Smart tags now “Additional actions”

Smart tags have been replaced by the context menu option “Additional actions” in Excel 2010. Text is no longer automatically recognized by a smart tag recognizer and is no longer marked by a purple dotted underline of the activated cell. Instead, users are able to trigger the data recognition function and view the custom actions associated with text by selecting the text and choosing the Additional actions item on the context menu activated by right-clicking a selected cell. 

Calendar control

Calendar control (mscal.ocx) was a Microsoft Access feature that could be used in Access worksheets. Calendar control is removed in Access 2010 and is not usable for Excel 2010. Instead, users can use Date Picker or their own custom calendar controls.

Migration considerations

When planning a migration to Excel 2010, review what is new, changed, and removed for Excel 2010. Because Excel 2010 has many similarities with Office Excel 2007, such as the same native file format, you can also review and use the existing migration documentation for Office Excel 2007 when you migrate to Excel 2010. 

MSXML5

MSXML5 is not supported in Excel 2010. Users will receive a runtime error if they attempt to run an Excel extensibility solution created by using MSXML5. Migrate code to MSXML6 or to managed code that uses the .NET Framework. 

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 was updated to VBA 7.0. VBA 7.0 settings were reset to their defaults after migration instead of automatically repopulating. This occurred because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	Office 2000 through Office 2007
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\7.0\Common


To correct this problem, copy the VBA 6.0 registry keys from the 6.0 hive to the 7.0 hive.

For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx) and Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=185841).

See Also
Changes in Office 2010
Changes in Office Excel 2007 (http://go.microsoft.com/fwlink/?LinkID=134563&clcid=0x409)
Migration considerations for Excel 2007 (http://go.microsoft.com/fwlink/?LinkID=164062&clcid=0x409)
Introduction to Office Migration Planning Manager (OMPM) (http://go.microsoft.com/fwlink/?LinkId=165906)
Changes in InfoPath 2010

This article lists changes in Microsoft InfoPath 2010 since Microsoft Office InfoPath 2007. 

In this article:


What’s removed
What’s removed

This section provides information about removed features in InfoPath 2010.

Data importer framework

In the InfoPath 2010 Editor, the entry point for Import form data is removed. The Import form data option enabled users to select a third-party data importer to import form data into their forms.

Data set change tracking

The functionality to track data set changes when a user designs a form in InfoPath Form Designer against a Web service that returns the System.DataSet type is removed in InfoPath 2010. However, existing forms that use change tracking with the System.DataSet type will continue to work in InfoPath 2010. 

InfoPath Form Designer Group Policy template settings

The settings that let you disable aspects of InfoPath Form Designer are removed from the Office 2010 Group Policy templates. This change provides more consistent functionality across installations of InfoPath 2010.

Form template exporter

The form template exporter extensibility option is removed from the InfoPath 2010 Form Designer. In Office InfoPath 2007, this option enabled third-party vendors to provide tools to export InfoPath form templates to other formats.

Form template samples

The sample form templates that were included with Office 2003 and the 2007 Office system are removed in InfoPath 2010. If an organization uses these templates, you must republish these form templates to a location other than the default location to continue using the forms. The new page and section layouts that are now in the InfoPath Form Designer replace the form templates.

Human Workflow Services integration

All integration points with BizTalk Human Workflow Services are removed from InfoPath 2010. This functionality is replaced by Workflows in Microsoft Office SharePoint Server 2007 and Microsoft SharePoint Server 2010.

Installable form templates

The capability to publish a form template that can be installed on the local client computer as an application is removed. Instead, users can publish forms to a specific location and run the form from that location. Existing installable forms will continue to run in the InfoPath 2010 Editor. 

Receive and Submit Web service connection

The Receive and submit data Web service connection option is removed for new forms. To simplify the feature and promote best practices, it is replaced with separate options to create a Receive data connection and then create a secondary Submit data connection. Existing forms that use the Receive and submit data Web service connection type will still work in InfoPath 2010.

Sample data

The capability to display sample data in the controls is removed. In InfoPath 2010 users must preview the form and manually enter sample data to evaluate how it looks in the form.

Script code development environment

The ability to develop script code in InfoPath 2010 is removed. When existing forms with script code are opened, all of the entry points to add code to a form will be disabled and hidden. Runtime support continues, but customers will have to upgrade script code to managed code to continue developing by using an integrated development environment in InfoPath.

Support for Microsoft XML Parser 5

Office 2010 does not support Microsoft XML Parser version 5 (MSXML5). Existing solutions will not create an instance of MSXML5 objects when loaded by Office 2010. Migrate code to managed code by using the Microsoft .NET Framework or to MSXML6. Note that MSXML6 does not support digital signature code. 

Changes in OneNote 2010

This article lists changes in Microsoft OneNote 2010 since Microsoft Office OneNote 2007. If you are upgrading from Microsoft Office OneNote 2003, see also Changes in Office OneNote 2007 (http://go.microsoft.com/fwlink/?LinkId=163029).

In this article:


What’s new

What’s changed

What’s removed

Migration considerations
What’s new

This section highlights new features in OneNote 2010.

Fluent UI

The OneNote 2010 user interface is redesigned and now uses the Microsoft Office Fluent user interface (UI). Introduced in the 2007 Microsoft Office system, the Fluent UI is designed to make it easier for people to find and use the full range of features that Office applications provide, and to preserve an uncluttered workspace. For more information about the Fluent UI, see the resources in Microsoft Office Fluent User Interface Resource Center (http://go.microsoft.com/fwlink/?LinkID=111045).

The ribbon

The ribbon, part of the Fluent UI, is designed to optimize key OneNote note-taking scenarios to make them easier to use. The ribbon in OneNote 2010 provides quicker access to all the commands and allows for easier future additions and customizations. You can also customize the ribbon. For example, you can create custom tabs and custom groups to contain frequently used commands. To help maximize the note-taking space on the page, the ribbon can also be hidden while writing.

Backstage view

The Microsoft Office Backstage is part of the Fluent UI and a companion feature to the ribbon. The Backstage view, which can be accessed from the File tab, helps you find frequently used features for managing your Microsoft OneNote notebook files. (The File tab replaces the Microsoft Office Button and File menu that were used in earlier releases of Microsoft Office.) The Backstage is used to manage files and the data about the files, such as creating and saving files, inspecting for hidden metadata or personal information, and setting file options.

Language preferences

OneNote 2010 also provides simplified language settings that allow multilingual users to use a single dialog box in OneNote 2010 to set preferences for editing, display, ScreenTip Language, and Help languages. If users do not have a required software or keyboard layout installed, a notification displays to provide information and links to resolve such issues.

File format

The OneNote 2010 file format enables new features, such as sharing on the Web, linked note-taking, mathematical equations, and versioning.

OneNote 2010 will continue to work on Office OneNote 2007 notebooks without changing to the new file format. By default, notebooks are not upgraded. Do not upgrade notebooks if you plan to share them with Office OneNote 2007 users. To change an existing notebook to the OneNote 2010 notebook format, use the Notebook Properties dialog box: Click the File tab, click the Settings drop-down menu, and then click Properties, or right-click the Notebook and click Properties.

[image: image6.png]


Note: 

If you change a notebook to the OneNote 2010 notebook format, you cannot change it back to the Office OneNote 2007 format.

Improved access to information

OneNote 2010 provides virtually uninterrupted access to notes by allowing you to view and use your notebook files anywhere — at work, home, or in transit.


Sync to Windows Live   You can access notebooks from any computer. You can also synchronize notebooks by using shared folders, Microsoft SharePoint Server 2010, and USB drives.


Microsoft OneNote Web App   You can access and edit notebooks from a Web browser, even on computers on which the full version of OneNote is not installed.


Microsoft OneNote Mobile 2010   By using a compact version of OneNote on a Windows Mobile-based smartphone, you can access and edit your notebooks stored on Windows Live and SharePoint.

Search, Outlook integration, organization, and editing improvements

The changes in these areas include the following:


Improved search, which can find information on either the current page, within selected sections or notebooks, or within notebooks.


Outlook integration improvements:

Create Outlook tasks from OneNote.


Improved organization and search features:

Section and page tab improvements.


 Search improvements allow for rapid search and navigation within the search results. For example, by typing the first few letters of a title, users can quickly jump to recently visited pages, or repeat a previous search.


The ability to easily add links to content within other content — for example, pages, sections, or section groups — and to quickly navigate through these links. This enables you to create Wiki-like notebooks.


Quick Filing feature, which lets you choose where in your notebook you want to send information (such as mails from Outlook, pages from Internet Explorer, and so on).


Editing improvements:

Quick Styles for creating and applying headings.


Support for mathematical equations.


Formatting improvements for bulleted lists.


Mini Translator, which lets you use your mouse to point to a foreign word or phrase and see a translation into your native language in a small window (you can also use the Play button to hear the pronunciation of the word or phrase, and use a Copy button to paste the translation elsewhere in your notebook).


Research and note-taking improvements:

Linked note-taking to Web page URLs, Microsoft Word 2010, and Microsoft PowerPoint 2010.


Automatic text wrapping.


Docked OneNote.


Information Rights Management (IRM) protected printouts.


Print driver for 64-bit operating systems.

Sharing and collaboration features

OneNote 2010 supports simultaneous editing of notebooks by multiple users. For example, a group of users can work on a notebook at the same time, or a single user can work on the same notebook from different computers simultaneously, all without locking the file.

The changes are as follows:


New content is automatically highlighted.


Author information for any added or shared content is identified by a color-coded bar and the author’s initials.


Version support lets users see when and by whom changes were made to a notebook. Changes relative to earlier versions of the notebook are automatically highlighted.


Faster synchronization of pages so that changes are displayed to all authors in near real time.


Display recently added content (by last day, week, month, and so on). You can also get an overview of what specific users changed on specific days.


Merge feature allows merging two sections of a shared notebook.

Support for touch-enabled computers

OneNote 2010 provides support for computers that run touch-enabled operating systems such as Windows 7. The features include the following:


Panning and auto-switching   On compatible computers that run Windows 7, the user can scroll and pan around any page in OneNote 2010 by using a finger and, depending on the input device, OneNote automatically switches between pen, pan, and selection.


Zooming   On multitouch devices, such as a computer that runs a touch-compatible or multitouch-compatible operating system such as Windows 7, using a pinch gesture with the fingers allows a user to zoom in or out of a notebook page in OneNote to customize the page view.


Improved navigation   Several navigational enhancements have been added to OneNote 2010 for users who have computers that run touch-enabled operating systems.
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Note: 

For more information, see the OneNote 2010 resources in the “Getting Started with OneNote” guide included in the product. For information about OneNote 2010 features and how to use the product features, see the Microsoft OneNote 2010 Beta Help blog (http://go.microsoft.com/fwlink/?LinkId=167111).
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What’s changed

This section summarizes the feature changes in OneNote 2010.

Task pane replacements

The following task panes are replaced in OneNote 2010:


Customize My Tags — Replaced by a dialog box in the Fluent UI.


New — Options in the New task pane are available in the New section of the File tab.


Font — Options are available in the Basic Text group on the Home tab on the ribbon.


Bullets — Replaced by the Bullets gallery in the new Basic Text group on the Home tab. The ability to change all bullets at a specific level is removed.

Some task panes are removed in OneNote 2010, as noted in Task Panes removed later in this article.

Top of page
What’s removed

This section provides information about removed features in OneNote 2010.

Outlining features and body text

The Outlining toolbar, including the Make Body Text option, is removed in Microsoft OneNote 2010. The ability to increase and decrease indentations and expand or collapse text is available through other user interface entry points and keyboard shortcuts.

SimpleImporter API

The SimpleImporter API was introduced in Microsoft Office 2003, and was replaced by another API in the 2007 Microsoft Office system, although it remained available to the few users who still needed it. The SimpleImporter API is completely removed in Microsoft OneNote 2010.

Start Live Session

The Start Live Session functionality is removed. In OneNote 2010, we recommend that you use a shared notebook. To share a notebook in OneNote 2010, you can specify a Web location so that you can use the notebook from any computer or from a Web browser. This option requires that you sign in or sign up for an account such as Windows Live. You can also enter the full path of a network file share, enter a mapped network drive, or paste the full address of a SharePoint document library where you want to create and store the shared notebook. The page updates will be reflected in near real-time to all users. To use the shared notebooks feature, select Share This Notebook (or New Shared Notebook) on the Share tab. For more information, see the “Getting Started with OneNote” guide included in the product.

Join Live Session

This functionality is removed. As noted in the Start Live Session section, in OneNote 2010, we recommend that you use a shared notebook.

Current Live Session

This functionality is removed. As noted in the Start Live Session section, in OneNote 2010, we recommend that you use a shared notebook.

Create Outlook Appointment and Create Outlook Contact

The Create Outlook Appointment and Create Outlook Contact functionality is no longer available.

Task Panes removed

The List and Document Management task panes are removed from Microsoft OneNote 2010. The functionality is no longer available, and the user interface entry points are removed. New features in OneNote 2010 provide more functionality than these rarely used features. 

For information about task pane replacements, see Task pane replacements earlier in this article.
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Migration considerations

This section discusses issues that administrators should consider when migrating from previous versions of Microsoft OneNote to Microsoft OneNote 2010.

In this section:


OneNote 2010 availability

OneNote 2010 file format

Upgrading OneNote 2007 notebooks 

Upgrading OneNote 2003 notebooks

OneNote notebook sharing

OneNote user data settings migration
OneNote 2010 availability

OneNote 2010 is included in all editions of the Office 2010 suites:


Microsoft Office Home and Student 2010


Microsoft Office Home and Business 2010


Microsoft Office Standard 2010


Microsoft Office Professional 2010


Microsoft Office Professional Plus 2010

For information about system requirements for OneNote 2010, see the Microsoft Excel 2010 section in System requirements for Office 2010.

In the 2007 Microsoft Office system, Microsoft Office OneNote 2007 was included in these editions of the product: Microsoft Office Home and Student 2007, Microsoft Office Ultimate 2007, and Microsoft Office Enterprise 2007.

Microsoft Office OneNote 2003 was available only as a stand-alone product.

OneNote 2010 file format

OneNote 2010 uses a new file format for saving files than previous versions of the product. Many of the new OneNote 2010 features (such as math equations, versioning, linked note taking, and multi-level subpages) require the new format to work. The new file format also lets you share your notebooks on the Web, so you can use a Web browser to view and edit your notebook files. When you create a notebook in OneNote 2010, the file is saved in the new OneNote 2010 file format by default.

With OneNote 2010, you can view, open, and edit notebooks that are saved in the Office OneNote 2007 file format. You can convert Office OneNote 2007 notebooks to OneNote 2010, and you can also convert them back to the Office OneNote 2007 format. For more information, see Upgrading OneNote 2007 notebooks  later in this article.

Notebooks that use the OneNote 2003 file format are read-only in OneNote 2010 (and in Office OneNote 2007). This means that you cannot edit files that use the OneNote 2003 format in OneNote 2010 or in Office OneNote 2007. For more information, see Upgrading OneNote 2003 notebooks later in this article.

To determine the file format of a notebook, in OneNote 2010, right-click the notebook icon in the navigation bar, and then click Properties. The Notebook Properties dialog box displays, and the Default File Format section indicates the file format version. If you open an Office OneNote 2007 notebook, the application title bar also displays "[Compatibility Mode]" to indicate the file format is Office OneNote 2007.

Upgrading OneNote 2007 notebooks 

OneNote 2010 works on Office OneNote 2007 notebooks without changing to the new file format. OneNote 2010 can view, open, and edit Office OneNote 2007 notebook files. By default, existing Office OneNote 2007 notebooks are not automatically converted when you update from Office OneNote 2007 to OneNote 2010. You cannot use Office OneNote 2007 to open and use notebooks that are saved in the OneNote 2010 file format.

If you plan to share your notebooks with Office OneNote 2007 users who do not have OneNote 2010, we recommend that you do not upgrade the notebooks.

If sharing notebooks with users of earlier versions of OneNote is not a requirement, we recommend that you convert existing notebooks to the OneNote 2010 format to enable all of the new product features.

Upgrading OneNote 2003 notebooks

As noted previously, notebooks that use the OneNote 2003 format are read-only in OneNote 2010. If you want to be able to edit your OneNote 2003 notes when you upgrade from OneNote 2003 to OneNote 2010, you must upgrade your notebook to the OneNote 2010 format (or the Office OneNote 2007 format). To do this, open the notebook in OneNote 2010, and then click the Information Bar that appears at the top of every page in your OneNote 2003 notebook. 
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Note: 

After you convert OneNote 2003 notebooks to the OneNote 2010 or the Office OneNote 2007 format, they cannot be changed back. Therefore, we recommend making a backup copy of the notebooks before you convert the files to a newer format.

OneNote notebook sharing

In Office OneNote 2007, users can participate in live shared note-taking sessions. User can store their shared notebooks in a Web location or a network location such as a network file share, or a SharePoint document library. They can access their shared notebooks from any computer or from a Web browser, or from a computer on the same network or a SharePoint document library. This allows all participants to view and edit each other's notes. To use the live shared session feature, users open the notebook and section that they want to share with others, point to Live Sharing Session on the Share menu, and then click Start Sharing Current Section. 

In OneNote 2010, the Start Live SessionJoin Live Session, and Current Live Session functionality is removed. In OneNote 2010, we recommend that you use a shared notebook. The page updates are reflected in near real-time to all users. In OneNote 2010, multiple authors can access a shared notebook simultaneously. When authors edit the pages and sections in the shared notebook, OneNote automatically synchronizes the changes so that the notebook is always up-to-date. OneNote maintains a separate offline copy of the notes on each user’s computer. Authors can edit the notes locally even when their computer is disconnected from the network. The next time that the users connect to the shared notebook, OneNote automatically merges their changes with the changes made by other authors. 

To use the shared notebooks feature in OneNote 2010, select Share This Notebook (or New Shared Notebook) on the Share tab. Users can choose to share their notebooks on the Web so they can be accessed from any browser (this option requires a Windows Live account). They can also choose to use the full path of a network file share, enter a mapped network drive, or paste the full address of a SharePoint document library. For more information, see “Share notebooks in OneNote 2010” in the OneNote online Help.

OneNote user data settings migration

Information about the OneNote registry keys that are migrated when performing an Microsoft Office 2010 installation is available in Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx). The article provides information about the Office OneNote 2007 and OneNote 2003 user data registry keys that are migrated and those that are not migrated for the following Microsoft Office 2010 upgrade scenarios: 


In-place upgrade   An earlier version of Office such as the 2007 Microsoft Office system is installed on computers.


Uninstall and upgrade   The installed version of Office is uninstalled first and then Office 2010 is installed on computers.


Operating system upgrade   A new version of the operating system such as Windows 7 is installed with Microsoft Office 2010.

For information about Office OneNote 2007, see the following sections: “OneNote 2007 <include>” and “OneNote 2007 <exclude>” in Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx).

For information about OneNote 2003, see the following sections: “OneNote 2003 <include>” and “OneNote 2003 <exclude>” in Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx).

See Also
System requirements for Office 2010
Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx)
Product and feature changes in Office 2010
Plan for OneNote 2010 (http://technet.microsoft.com/library/de6c8b8d-4dcc-4a9c-a0a2-10df11ae9825(Office.14).aspx)
Changes in Outlook 2010

This article lists changes in Microsoft Outlook 2010 since Microsoft Office Outlook 2007 and migration considerations. If you are upgrading from Office Outlook 2003, see also Changes in Outlook 2007 (http://go.microsoft.com/fwlink/?LinkId=160240) and Migration considerations for Outlook 2007 (http://go.microsoft.com/fwlink/?LinkId=162899).

In this article:

What’s new
What’s changed
What’s removed
Migration considerations
What’s new

This section highlights new features in Outlook 2010.

64-bit editions

Starting with Microsoft Office 2010, Outlook is available as a 32-bit application and a 64-bit application. The version (bitness) of Outlook that you choose depends on the edition of the Windows operating system (32-bit or 64-bit) and the edition of Office 2010 (32-bit or 64-bit) that is installed on the computer, if Office is already installed on that computer. The bitness of an installed version of Outlook is always the same as the bitness of Office 2010, if Office is installed on the same computer. For more information, see 64-bit editions of Office 2010.

If you have a MAPI application in your environment, that the bitness of the MAPI application must be the same as the installed version of Outlook 2010. For more information, see Considerations for MAPI applications for Outlook in 64-bit editions of Office 2010.

Bitness registry key

When Outlook 2010 is installed, it sets the new registry key named Bitness, which indicates whether the Outlook 2010 installation is a 32-bit or 64-bit version. This can be useful to administrators who want to audit computers to determine the installed versions of Outlook 2010 in their organizations. 

Registry path: HKEY_LOCAL_MACHINE\Software\Microsoft\Office\14.0\Outlook

Registry key: Bitness

Value: either x86 or x64

For more information about Microsoft Office 2010 in 64-bit, see 64-bit editions of Office 2010.

Calendar Preview in meeting requests

Microsoft Outlook shows a preview of your calendar in meeting requests. The Calendar Preview feature shows where the meeting appears in your Calendar together with any conflicting and adjacent meetings. When you view a meeting request for a recurring meeting, you can use the Calendar Preview feature to navigate between meeting instances in the series.

Conversation actions

Outlook 2010 contains several new features to help users manage their Inboxes more effectively, including the Ignore and Clean Up commands. The Ignore button on the ribbon moves all of a conversation and any future replies to that conversation directly to the Deleted Items folder. The Clean Up button moves older, redundant messages in the conversation to the Deleted Items folder but keeps the most recent message. 

Quick Steps

Quick Steps are one-click buttons that can perform multiple actions at the same time. Users can create their own Quick Steps to manage their e-mail with a single click.

Multiple Exchange accounts

Outlook 2010 can connect to multiple Exchange accounts at the same time. The Exchange accounts can be in the same or different domains or servers.

Roaming AutoComplete list

Recipient AutoComplete lists are now stored on the Exchange Server. A user’s recipient AutoComplete list is now available to any computer on which Outlook 2010 runs that is connected to the same Exchange account. Names can be easily removed from the list by using the new inline Delete function.

The ribbon

The ribbon, part of the Microsoft Office Fluent user interface (UI), replaces the menus and toolbars of the Outlook main window. Ribbon tabs can be customized or replaced with tabs that you create. Through the Options menu on the File tab, you can create new tabs that bring together your favorite commands and groups. Existing tabs can also be customized to meet the organization’s needs.

Features available with Office Communicator 2007 R2, Office Communicator Server 2007 R2, or later versions

With richer integration of Microsoft Communicator than in earlier versions, you can start live conversations from Outlook 2010. Hover over a name, see a person’s availability and then easily start a conversation directly through instant messaging, voice call, or video.

Features available with Microsoft Exchange Server 2010

The following features are available with Microsoft Exchange Server 2010 and Outlook 2010.


Calendar features   An organization can now establish a federated trust relationship with an external partner and share availability (free/busy) information, calendar, or contacts. Federation provides the underlying trust infrastructure to enable easy and secure sharing of information across Exchange organizations and in cross-premises organizations. You can also use the new Group Schedule view in Outlook Calendar to see multiple calendars vertically, instead of side by side, or save frequently used groups of calendars together from one location. The Group Schedule view is optimized for viewing a schedule for a group and scheduling a meeting for a group.


Call answering and routing rules   Unified Messaging in Exchange Server 2010 enables you to create call answering and routing rules for individuals or groups of callers based on Caller ID and contact information.


Centralized rights management   You can set up rules to automatically apply Information Rights Management policies to outgoing e-mails based on content or recipients.


Integrated e-mail archive   The Personal Archive feature is available with Outlook 2010 and Exchange Server 2010 and lets you regain control of the organization's messaging data by eliminating the need for Personal Folder files (.pst). Like .pst files, the Personal Archive feature does not affect the user’s primary mailbox size. However, unlike .pst files, the e-mail archive folders are stored online so that users can access the archived files by using Microsoft Outlook Web App or from a secondary computer by using Outlook 2010. By using either of these client applications, users can view an archive mailbox and move or copy messages between their primary mailboxes and the archive.


MailTips   This feature is a configurable warning system to help prevent common e-mail mistakes. Extra information is presented to users when they compose e-mail messages. The MailTips are displayed in an InfoBar, similar to the banner that says "This message has not been sent”. MailTips do not prevent sending an e-mail message. But they reveal things that might be unexpected about the delivery or audience of the message, such as recipient validity, whether the recipient is external to the organization or is out of the office, if the distribution list is unusually large, or if a message might not be delivered. 


Protected Voice Mail   This feature enables encrypted voice mail to be sent to a user’s mailbox. Protected voice messages can be marked as Private to prevent them from being forwarded.


Text messaging through Exchange ActiveSync   Windows Mobile 6.5 (or a later version) telephones or browser-enabled cellular telephones can access text messages by using Exchange ActiveSync, a synchronization protocol that is optimized to work together with high-latency and low-bandwidth networks. 


Voice Mail Preview   Microsoft speech technology converts voice mail messages into text that users receive in an e-mail or text message.

For more information about Microsoft Exchange Server 2010, see Microsoft Exchange 2010 (http://go.microsoft.com/fwlink/?LinkId=163579) and What's New in Exchange Server 2010 (http://go.microsoft.com/fwlink/?linkId=164425).

What’s changed

This section summarizes the feature changes in Outlook 2010.

Conversation view

The Conversation view in Outlook 2010 is changed. The Conversation view provides a threaded view of e-mail messages in an Microsoft Outlook folder, and in Outlook 2010 is accessed by clicking View, Conversation, and then Show Messages in Conversations. The improved Conversation view helps users deal with larger volumes of incoming e-mail, reduces information overload, and increases user productivity in e-mail.

Improved IMAP support

IMAP accounts are easier to set up in Outlook 2010 than in earlier versions. When users add a new account in Outlook 2010, the automatic configuration of a Webmail account will set the account type to IMAP by default for IMAP-supported Webmail accounts such as Google Gmail. Note that users can change the account type to POP3 by selecting the Manually configure server settings option in the Add New Account dialog box. 

The Delete and Send operations for IMAP accounts are also improved in Outlook 2010. IMAP accounts now have a separate Deleted Items folder. Also, Outlook 2010 does not prompt for a Sent Items folder, as Office Outlook 2007 did. This is consistent with Outlook behavior for other e-mail account types. 

 Outlook is more responsive for IMAP users in Outlook 2010 and Office Outlook 2007 SP2. On-demand downloads of messages now occur in the background. 

Faster performance

Outlook 2010 starts and exits faster than Office Outlook 2007. Outlook 2010 performance is faster overall than Office Outlook 2007. 

Menu and commands


ALT keyboard shortcuts   With the introduction of the ribbon in Outlook 2010, the ALT keyboard shortcuts have changes. Press ALT to display the command key tips.


Copy Folder Design   The Copy Folder Design command is replaced with the ribbon View tab option Apply Current View to Other Mail Folders.


Current View and Organize panes   The Current View pane in the navigation pane for Contacts, Tasks, and Notes is removed in Outlook 2010. Also the Organize pane accessed in Office Outlook 2007 by clicking Tools and Organize is removed in Outlook 2010. You can change and format your views by using the features on the ribbon View tab.


Go menu   The Go menu option is redundant with the Navigation pane in Office Outlook 2007. The keyboard shortcuts that were shown in the Go menu still work and are now displayed as tooltips on the navigation pane buttons. For example, you can use Ctrl+1 to switch to Mail, Ctrl+2 for Calendar, Ctrl+3 for Contacts, Ctrl+4 for Tasks, and so on.


Plan a Meeting   This dialog box accessed in Office Outlook 2007 from the Actions menu in the Calendar view is replaced by the ribbon Home tab Schedule View command in the Calendar view.


View Group Schedules   This dialog box accessed in Office Outlook 2007 from the Actions menu in the Calendar view is replaced by the commands in the Manage Calendars section on the ribbon Home tab and in the navigation pane in the Calendar view. From the ribbon Calendar Groups option, you can create a Calendar Group by clicking Create New Calendar Group or save currently displayed calendars by using the Save as New Calendar Group. In the navigation pane, you can select which group calendars to view and right-click on a group to find the Rename Group, Delete Group, and New Calendar Group commands. 

Search tools

Outlook 2010 enables you to easily find and manage large quantities of e-mail, calendar items and contact files. The Search tab on the new Outlook 2010 ribbon includes search filter options to help quickly narrow your search results. You can quickly change the scope of search by selecting, for example, All Subfolders. You can then refine the search by using search filter buttons such as Subject, Has Attachment, or Unread. You can also run advanced searches and view your recent searches to run them again.

Improved in Outlook 2010 with Exchange Server 2010

The following Outlook 2010 improvements are available through Exchange Server 2010.


Greater calendar reliability   Improvements in Outlook 2010 and Exchange Server 2010 logic make calendars more reliable than in Office Outlook 2007. Improvements include conflict resolution in online mode to resolve conflicts when there are different updated versions of an item on the server and on the client. Also, multiple instances of a recurring meeting can now be changed independently of one another.

Exchange Server 2010 introduces the Calendar Repair Assistant (CRA). CRA can automatically detect and correct inconsistencies that occur for single and recurring meeting items for mailboxes that are on an Exchange Server 2010 mailbox on which the Microsoft Exchange Mailbox Assistants service runs.


Improved retention and compliance functionality   Users can apply retention policy to a message or a folder. IT can enforce policies on built-in folders (Inbox, sent items, and so on). Also, an online archive provides separate, online-only folders for long-term retention and archiving.


Simplified administration   By using role-based access control (RBAC), you can control resources and the features that users can access. You create role assignment policies for each specialized user group and tailor those role assignment policies to grant more-restrictive or less-restrictive permissions to the groups. For example, you could create a Compliance Offer role to conduct mailbox searches for legal discovery, a Human Resources role to update employee information in the company directory, or a Help Desk role to manage mailbox quotas. Users can also manage some tasks on their own, such as creating and managing distribution groups or tracking message delivery. 

For more information about Microsoft Exchange Server 2010, see Microsoft Exchange 2010 (http://go.microsoft.com/fwlink/?LinkId=163579).

What’s removed

This section provides information about removed features in Outlook 2010.

ANSI offline Outlook data files (.ost) for Exchange synchronization

ANSI offline Outlook data files (.ost) can no longer be created (unless overridden by Group Policy). By default, newly created profiles in Outlook 2010 will be in Unicode.

Unicode Outlook data files (.ost) are recommended in all scenarios except when alternate display names are required. To use alternate display names, configure Group Policy to set the default Outlook data files (.ost) to ANSI. The Group Policy keys to set are in the Outlook 2010 Group Policy template in Microsoft Outlook 2010\Account Settings\Exchange and Microsoft Outlook 2010\Miscellaneous\PST Settings. Note that ANSI .ost files do not work for profiles that contain multiple Microsoft Exchange Server accounts.

AutoArchive-based retention

Users can no longer deploy AutoArchive-based retention settings through Outlook 2010 by using Group Policy. Users who need retention policies are encouraged to explore the Messaging Records Management (MRM) features in Microsoft Exchange Server 2007 and later versions.

Calendar rebasing tool

The calendar rebasing tool is removed in Outlook 2010. Calendar rebasing was introduced in Microsoft Office Outlook 2007, and was accessed by clicking Tools, Options, Calendar Options, Time zone, and then making selections in the Time zone drop-down list. Calendar rebasing is available through a separate Web tool, Time Zone Data Update Tool for Microsoft Office, which is currently available to users from the Microsoft Download Center. 

The Change Time zone button is no longer available in the Time zone dialog box, and all underlying code and user interface code are removed. New calendar items that are created in Outlook 2010 can display start and end times correctly without the need for rebasing. Users can use Time Zone Data Update Tool to rebase down-level clients and servers.

Customization of Contact Activity Search folders

In Outlook 2010, the Activities tab on the Contact Folder Properties dialog box is removed because of low usage. This feature allowed you to customize the list of folder groups available to search when in the Activities view on the individual Contact item.

DAV connectivity for HTTP account types

Distributed Authoring and Versioning (DAV) connectivity is removed in Outlook 2010. DAV is an old mechanism used when you connect to Windows Live Hotmail and synchronize e-mail. A new mechanism for Hotmail connectivity exists, and enables synchronization of e-mail, contacts, and calendar synchronization through a Web download. There is no visible loss of functionality to Hotmail users. Users who connect to other DAV accounts (non-Hotmail accounts) will lose connectivity and will be unable to synchronize e-mail.

Exchange 2000 connectivity

Outlook 2010 cannot connect to Microsoft Exchange Server 2000 or earlier versions of Exchange. Users who run Exchange Server 2000 in their environments will receive an error message when Outlook 2010 attempts to connect to the server. The error message will state that the server version is not supported. Public folders in Microsoft Outlook 2010 also cannot connect to Exchange Server 2000, although an error message does not appear. Users will have to migrate to Exchange Server 2003 or a later version.

Exchange Message Security feature support

Support for the Exchange Message Security feature in Outlook 2010 is removed. Customers must use S/MIME to support message security. The infrastructure to support the Exchange Message Security feature was deprecated in Exchange 2000 Server SP2. For more information about S/MIME, see Understanding S/MIME (http://go.microsoft.com/fwlink/?linkId=167356).

Most Recently Used list

The list of last opened Other User's Folder in the File | Open menu is removed. As a replacement, consider using delegates, adding additional Exchange accounts to user profiles or sharing tasks and calendars. The Other User's Folder is still available in Outlook 2010 by clicking the ribbon File tab and Open.

Outlook integrity check tool (.ost)

The Outlook Offline Folder (.ost) integrity check tool (scanost.exe) is not included in Outlook 2010. This tool was recommended in previous versions for fixing errors in Outlook data files (.ost). 

If there is an issue with a specific folder, you can resync the folder:

1.
Right-click the folder and then click Properties.

2.
In the dialog box that appears, click the Clear Offline Items button and then click OK.

3.
On the Outlook 2010 ribbon, click the Send/Receive tab.

4.
Click Update Folder.

Otherwise, we recommend that you delete the .ost file and let Outlook download information again from Exchange. The exception is if you have local data that is not present on the server. In that case, we recommend that you export the data to an Outlook Data File (.pst), delete the .ost file, allow the server data to download again, and then import the .pst file data by using the Do not import duplicates option that can be accessed through the Open option on the File tab.

Photo resize options

The Outlook 2010 options to resize attached photo do not include 640 x 480 or 800 x 600 pixels. If you decide to resize an image, the largest of the three previously supported choices (1024 x 768) is used by default in Outlook 2010. 

Also, the resize options have been moved to the File tab.

These changes were made to simplify the resize options and make them more discoverable.

Postmarking

The Postmarking feature is removed in Outlook 2010. The When sending e-mail, Postmark the message to help e-mail clients distinguish regular e-mail from junk e-mail option is removed from the Junk E-mail Options dialog box and Postmarks will not be generated by Outlook 2010. 

Preview of published Office Online calendars

The Office Online Calendar Sharing Service Web site enabled users to view and manage their shared calendars in a Web browser without having to subscribe to the published calendar. Within Outlook, users could select the Preview this Calendar option when they were notified that a calendar was shared to them. 

The Web site for Outlook Calendar Sharing Service is discontinued with Outlook 2010. Therefore, the Preview this Calendar option is removed in Outlook 2010. Users can still publish their calendars for sharing. However, to view the contents of the calendar, users will have to subscribe to the calendar for viewing within Outlook. For Web access, users will have to subscribe to the calendar in Windows Live Calendar. Users who subscribe to the published Office Online Calendar in Outlook are not affected.

Quick View

Quick View is a file viewer that was included with Windows 95, Windows 98, and Windows NT 4.0. The related code in Outlook was removed in Outlook 2010. There is no related change to the user experience for those who are on supported operating systems.

Remote Mail

Remote Mail is removed from Outlook 2010. The Remote Mail functionality is replaced by Cached Mode, which was introduced in Outlook 2003.

Search Toolbar add-in

The Search Toolbar add-in setup code is removed in Outlook 2010. The Search Toolbar add-in enables local indexing of online mode Exchange Server mailbox stores by using Windows Desktop Search. As a result of this change, e-mail in online Exchange mailboxes will not appear in the results of Windows Explorer searches. The online indexing add-in is a legacy component that adversely affects performance of Outlook during startup and shutdown. With this removed in Outlook 2010, users will experience improved Outlook reliability and significantly lower Exchange bandwidth usage. For fast search, use Cached Exchange Mode or for online mode, use Exchange Search in Exchange 2007 and later versions.

Send Link to This Folder

In Office Outlook 2007 and earlier versions, this feature opens a new mail message that has an attached .xnk file that links to the public folder. Because of increased security in Office Outlook 2007, by default access is denied to Microsoft Exchange Server public folder shortcuts with an .xnk file name extension. So in Outlook 2010, the Send Link to This Folder on the Public Folder context menu is removed. Instead, consider using SharePoint Server for collaboration.

Send Options

In Outlook 2010, the ability to specify the format for e-mail messages by using Send Options is removed. This feature was once useful for sending e-mail to people who would receive an e-mail on an Apple computer. Apple computers can now read e-mail messages in Multipurpose Internet Mail Extensions (MIME) type. In Office Outlook 2007, to find the Send Options command enter an e-mail address in the To line, resolve the e-mail address, right-click the e-mail address and select Send Options.

Shade group headings

The ability to shade group headings is removed in Outlook. In Office Outlook 2007, to access this feature right-click on the column heading, select Custom…, Customize current view and then click Other Settings. 

Third-party Exchange client extensions do not load

Third-party Exchange client extensions do not load on Outlook 2010. We recommend that users contact their Exchange client extension vendor for more information regarding an update to their solutions. Third-party exchange client extensions are replaced by add-ins built by using Microsoft Visual C++, Visual Studio Tools for Office, or third-party tools that can create an Outlook COM add-in.

Web browser support

Web browser support is removed in Outlook 2010. The following related features have also been removed.


View Web pages from within Outlook


Save as Web Page option for Calendar 


Search the Internet from within Outlook


Navigate to Web pages within Outlook

Migration considerations

Even though several new features and user interface changes are added in Outlook 2010, the Outlook data files (.ost and .pst) and Outlook profile file (.prf) formats in Outlook 2010 are compatible with earlier releases.

Outlook data files (.pst and .ost)

With Outlook 2010, users can open and use Outlook data files that were created in earlier versions of Outlook. Users who have offline Outlook data files (.ost) do not need to re-create those files; for example, users whose accounts are configured to use Cached Exchange Mode. Similarly, users who have Outlook data files (.pst) can continue to use the files without converting or migrating the files.

By default, Outlook .pst and .ost files that are created by using Office Outlook 2003 and later versions are in the updated Unicode file format that allows larger file sizes (the 2-gigabyte (GB) limit is eliminated). The data file format (non-Unicode ANSI) used by Outlook 2002 and earlier is also supported by Outlook 2010.

If users currently have non-Unicode ANSI-formatted .ost files, we recommend that you upgrade the .ost files to Unicode. 


To determine whether users’ .ost files are in ANSI or Unicode format, see How to determine the mode that Outlook 2007 or Outlook 2003 is using for offline folder files (http://go.microsoft.com/fwlink/?LinkId=159924).


For information about how to force an upgrade of an existing non-Unicode (ANSI) formatted .ost file to Unicode format, see the section “Force upgrade of non-Unicode ANSI format .ost files to Unicode” in Configure Cached Exchange Mode in Outlook 2010 (http://technet.microsoft.com/library/c6f4cad9-c918-420e-bab3-8b49e1885034(Office.14).aspx).

Outlook profile file (.prf)

As in earlier versions of Outlook, you can continue to use the Outlook profile file (.prf) to provide options for specifying additional Outlook settings or MAPI services. The Outlook 2010 .prf file format has changed but Office Outlook 2007, Office Outlook 2003, and Outlook 2002 versions of the file will work with Outlook 2010. If you plan to make updates to the .prf file for an Outlook 2010 deployment, we recommend that you re-create the .prf file by using the Office 2010 Office Customization Tool (OCT), export the settings to a new .prf file, and use that file to specify the additional Outlook settings or MAPI services that you need.

Reverting to Office 2007 from Office 2010

Because of the changes in Outlook 2010 that allow for multiple Exchange e-mail accounts, user profiles that were upgraded to Outlook 2010 will not work if the user removes Outlook 2010, reinstalls Office Outlook 2007, and then attempts to start Office Outlook 2007 by using the same user profile. In this scenario, the user profile will have to be removed and re-created in Windows through the Control Panel and Mail options.

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 is updated to VBA 7.0. VBA 7.0 settings are reset to their defaults after migration instead of automatically repopulating. This occurs because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	2007 Office system and previous versions
	HKEY_CURRENT_USER\Software\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\Software\Microsoft\VBA\7.0\Common


For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx).
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Changes in PowerPoint 2010

This article lists changes in Microsoft PowerPoint 2010 since Microsoft Office PowerPoint 2007 and migration considerations. If you are upgrading from Microsoft Office PowerPoint 2003, see also Changes in Office PowerPoint 2007 (http://go.microsoft.com/fwlink/?LinkId=169005).

In this article:


What’s new

What’s changed

What’s removed

Migration considerations
What’s new

This section highlights new features in PowerPoint 2010.

Fluent UI

The PowerPoint 2010 user interface is updated from the Microsoft Office Fluent user interface (UI) that was introduced in the 2007 Microsoft Office system. The Microsoft Office Fluent UI is designed to make it easier for people to find and use the full range of features that Office applications provide, and to preserve an uncluttered workspace. For more information about the Fluent UI, see the resources in Microsoft Office Fluent User Interface Resource Center (http://go.microsoft.com/fwlink/?LinkID=111045).

The ribbon

The ribbon, part of the Fluent UI, was designed to optimize key PowerPoint presentation scenarios to make them easier to use. The ribbon provides quicker access to all the commands in PowerPoint 2010 and allows for easier future additions and customizations. You can also customize the ribbon. For example, you can create custom tabs and custom groups to contain frequently used commands. To help maximize the editing of your presentation space on the page, the ribbon can also be hidden while writing.

Backstage view

The Microsoft Office Backstage is now part of the Fluent UI and a companion feature to the ribbon. The Backstage view, which can be accessed from the File tab, helps you find frequently used features for managing your PowerPoint presentation files. (The File tab replaces the Microsoft Office Button and File menu that were used in earlier release of Microsoft Office.) The Backstage view is used to manage files and the data about the files, such as creating and saving files, inspecting for hidden metadata or personal information, and setting file options.

File format

The PowerPoint 2010 file format enables new features such as sharing on the Web, linked presentation co-authoring, and versioning. PowerPoint 2010 will continue to work on Office PowerPoint 2007 presentations.

Protected View

Files from a potentially unsafe location (such as the Internet or an e-mail attachment) or files that contain active content (such as macros, data connections, or ActiveX controls) are validated and can open in Protected View. When you open files in Protected View mode, the editing functions are disabled. You can open and edit files from trusted sources by clicking Enable Editing. You can also explore data about the files in the Backstage view.

Collaboration and sharing features

PowerPoint 2010 supports simultaneous editing of presentations by multiple users. For example, a group of users can work on a presentation at the same time, or a single user can work on the same presentation from different computers at the same time, all without locking the file.

The changes are as follows:


New content is automatically highlighted. 


Author information for any added or shared content is identified by a color-coded bar showing the author’s initials.


Version support lets users see when and by whom changes were made to a presentation, and automatically highlights changes relative to earlier versions of the presentation.


Faster synchronization of pages so that changes are displayed to all authors in near real-time.

Presentations to live and virtual audiences

PowerPoint 2010 has a remote slide show capability that lets you present a slide show over the Web or a network connection to virtual attendees or live attendees, or both. 

Some common broadcast scenarios are as follows:


Ad hoc one-on-one broadcast.


Invite multiple viewers to view a presentation remotely at any time.


Present a slide show to both live and remote attendees at the same time in the context of a training session, meeting, or conference call.

Working with text and objects

PowerPoint 2010 provides improved editing tools with a new set of Photo Effects that enable you to transform your images.


Video and audio editing


Graphics, transitions, and animations


Help and translation
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What’s changed

This section summarizes the changes in PowerPoint 2010.

Arrange Group

The Arrange Group is now the Arrange menu.

Insert a shape

Previously, Drawing Tools (on the Format tab) automatically display when you insert a shape on a slide. This is no longer the case. The tab appears, but it does not open automatically. You can double-click the shape to bring up the tools.

Selection pane

The Selection pane is a feature that lists all objects in a presentation. In PowerPoint 2010 it is now located on the Arrange menu on the Home tab.

What’s removed

This section provides information about removed features in PowerPoint 2010.

Maximum sound file size

The audio/video link and embed feature has replaced the maximum sound file size embed feature. In Microsoft Office PowerPoint 2007, this appears in two locations: 1) as Max Sound File Size (KB) in Sound Tools | Options | Sound Options and 2) Link sounds with file size greater than in PowerPoint Options. This feature was necessary before because you were only able to embed of .wav files less than a certain size, as specified at one of the two places. In PowerPoint 2010, you can embed any file of any size so that these two features are no longer necessary.

The functionality is still there, but only as part of the new audio/video insertion behavior. The feature itself is deprecated.

You will not see Max Sound File Size (KB) in the ribbon and Link sounds with file size greater than in PowerPoint Options. Instead, the audio/video link and embed feature will replace this functionality. You will be able to do the same thing with fewer limitations and also do it directly when a media file is inserted.

In PowerPoint 2010, the user can choose whether to embed any file directly by using the Insert dialog box. Therefore, Max Sound File Size and Link sounds with files size greater than boxes are no longer needed. You can embed any file kind of any size instead of being limited to .wav files less than 50 MB.

Save as Web Page

The entry points for Save as Web Page have been removed.
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Migration considerations

This section provides information about features and changes that administrators should consider when migrating from Microsoft Office PowerPoint 2007 to Microsoft PowerPoint 2010.

PowerPoint Presentation Files (.ppt/.pptx)

The default file format for presentations created in PowerPoint 2010 has not changed from PowerPoint 2007, which is an XML-enabled file format. PowerPoint 2010 does not support saving to PowerPoint 95 (or earlier) file formats, nor Pack and Go Wizard (.ppz) files. For more information about new file formats in Office 2010, see File Formats supported in PowerPoint 2010 (http://go.microsoft.com/fwlink/?LinkId=184681&clcid=0x409).

To ensure that a presentation in PowerPoint 2010 can be viewed in PowerPoint 2003 or earlier versions, you can run the Compatibility Checker in PowerPoint 2010. The Compatibility Checker finds potential compatibility issues between PowerPoint 2010 and earlier versions of PowerPoint, and creates a report to help you resolve any issues. 

With all the new media capabilities, photo effects, graphics, and formatting capabilities in PowerPoint 2010, knowing how they will translate when the file is opened in an earlier version is important. For example, the new photo effects are stored in the file in such a way that when you open the file in PowerPoint 2007, the photos that use the new effects look exactly as they did in PowerPoint 2010. However you cannot modify the effect if you return to PowerPoint 2007.

The new slide transitions are mapped to a PowerPoint 2007 transition when the presentation is viewed in PowerPoint 2007, and any improved slide transitions revert to the original look in PowerPoint 2007. Embedded videos will work to view in PowerPoint 2007, because PowerPoint 2007 Service Pack 2 was updated to include support for embedded videos. However, if you applied some PowerPoint 2010 effects to the video in PowerPoint 2010, such as crop it to a shape, apply 3-D to it, layer shapes, or apply a duotone, it will return to a default video and play without the special effects. The new slide transitions are mapped to a PowerPoint 2007 transition when the presentation is viewed in PowerPoint 2007, and any improved slide transitions revert to the original look in PowerPoint 2007. Embedded videos will work to view in PowerPoint 2007, because PowerPoint 2007 Service Pack 2 was updated to include support for embedded videos. However, if you applied some PowerPoint 2010 effects to the video in PowerPoint 2010, such as crop it to a shape, apply 3-D to it, layer shapes, or apply a duotone, it will return to a default video and play without the special effects.

For information about formatting compatibility with PowerPoint 2003 or earlier versions, see Features that change when you open a PowerPoint 2010 presentation in PowerPoint 2003 or earlier (http://go.microsoft.com/fwlink/?LinkId=184658&clcid=0x409).

Storing or sharing files

PowerPoint 2010 supports exporting files to all previous file formats that were found in PowerPoint 2007 and OpenDocumentation Presentations. In the Microsoft Office Backstage view, there is a quick-click sharing capability to send a presentation via e-mail as an attachment, as a link to the presentation on a Web server, or as a .pdf or .xps copy. You can also share the presentation via an instant message, in the Presentation Window, via Internet Fax, by publishing to Microsoft SharePoint 2010 Products or any specific location, or packaging it for a CD.

Presentation security

In Office PowerPoint 2007, new security features were introduced to help ensure that a presentation was safely managed after it left the user’s hands. In PowerPoint 2010, the permissions can still be set, but now through the Backstage view. Security features include the following:


Prevent unintended changes to a final version of a document by using the Mark as Final command.


Provide assurance as to the authenticity, integrity, and origin of the presentation by adding a digital signature.


Assign permissions that prevent other users from copying, printing, or editing the presentation by selecting the access level specific to their requirements.


Manage document properties through the Backstage view.

PowerPoint Viewer

The Viewer is not included with an installation of Office. Therefore, for users who require viewing a PPT/PPTX presentation offline, a new PowerPoint Viewer is available online. The Viewer lets you view presentations created in Microsoft PowerPoint 2000, PowerPoint 2002, PowerPoint 2003, PowerPoint 2007, and PowerPoint 2010. The Viewer also supports opening password-protected PowerPoint presentations.

The Viewer cannot be installed side-by-side with 64-bit Microsoft Office, and cannot open files created in PowerPoint 95 or earlier versions. Support is limited to Windows XP, Windows Server 2003, Windows Vista, and Windows 7. Windows 2000 and Windows 98 are not supported. Unlike previous viewers, users will have the option to use Reading mode or Full Screen Slide Show mode.

Macro recorder

The macro recorder, used to automate frequent tasks, is not available in PowerPoint 2010. Instead, you can use Microsoft Visual Basic for Applications (VBA) to create or configure macros. If you create a macro in a version of PowerPoint earlier than PowerPoint 2007 by using the macro reader, use VBA to configure the macro.

If you want to access developer controls, write code, or create macros, do the following to display the Developer tab: 

1.
Click the File tab.

2.
Select Options.

3.
In the PowerPoint Options dialog box, click Customize Ribbon.

4.
In Customize the Ribbon, in the Main Tabs list, select the Developer tab, click Add, and then click OK.

The macro recorder, used to automate frequent tasks, is not available in PowerPoint 2010. Instead, you can use Microsoft Visual Basic for Applications (VBA) to create or configure macros. If you create a macro in a version of PowerPoint earlier than PowerPoint 2007 by using the macro reader, use VBA to configure the macro.

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 was updated to VBA 7.0. VBA 7.0 settings were reset to their defaults after migration instead of automatically repopulating. This occurred because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	Office 2000 through Office 2007
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\7.0\Common


To correct this problem, copy the VBA 6.0 registry keys from the 6.0 hive to the 7.0 hive.

For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx) and Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=185841).
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This article lists changes in Microsoft Project 2010 since Microsoft Office Project 2007 and migration considerations. 

In this article:

What’s new
What’s changed
What’s removed
Migration considerations
What’s new

This section highlights new features in Project 2010.

Fluent UI

The Project 2010 user interface is redesigned and now uses the Microsoft Office Fluent user interface (UI). Introduced in the 2007 Microsoft Office system, the Fluent UI is designed to make it easier for people to find and use the full range of features that Office applications provide, and to preserve an uncluttered workspace. For more information about the Fluent UI, see the resources in Microsoft Office Fluent User Interface Resource Center (http://go.microsoft.com/fwlink/?LinkID=111045).

Backstage view

The Microsoft Office Backstage is part of the Fluent UI and a companion feature to the ribbon. The Backstage view, which can be accessed from the File tab, helps you find frequently used features for managing your Microsoft Project files. (The File tab replaces the Microsoft Office Button and File menu that were used in earlier releases of Microsoft Office.) The Backstage is used to manage Microsoft Project Server connections, and to check out and publish projects.

Team Planner

Project 2010 Professional contains the Team Planner, a resource scheduling view that lets users see at a glance what their team members are working on and move tasks from one person to another. Users can also view and assign unassigned work, view over-allocations, and see task names and resource names.

Synchronization with SharePoint lists

In Project 2010 Professional, users can export project files to a list in Microsoft SharePoint Server 2010 or Microsoft SharePoint Foundation 2010. This provides a quick and easy way for a project manager to share status or create reports that can be viewed across the organization. Project Web Access (PWA) is not required to synchronize with a SharePoint list.

Manual scheduling

Project 2010 changes how projects are scheduled. Factors such as task dependencies and the project calendar no longer automatically adjust task dates when a task is manually scheduled. This feature can be especially useful for early planning when the duration of a task might not yet be known. Users can place a manually scheduled task anywhere in their schedules, and Project 2010 will not move it. Project managers who are accustomed to automatic scheduling with past versions of Project can turn the new manual scheduling feature off for specific tasks or the entire project. Some projects may require the powerful scheduling engine of Project to handle scheduling.

Placeholder tasks

Placeholder tasks let users create a plan by using task names only. Users can enter any combination of start date, finish date, and duration and fill in the rest later.

Inactive tasks

Users can make tasks inactive and still keep them in their projects. The main value of this feature is that custom field information, resource assignments, and all other data stays in the task. (Note that these factors do not contribute to roll-ups.)Inactive tasks often have important information (such as cost information) that can be valuable for archival purposes and what-if planning.

Top-down summary

Creating subtasks and then rolling them up into summary tasks is no longer restricted. In Project 2010, users can create summary tasks first, and the summary tasks can have dates that do not exactly match the roll-up dates of the subtasks. At the beginning of the planning phase, users might only have some high-level information about key deliverables and major milestones of their projects. In Project 2010, users can divide projects into high-level phases based on the overall timeline and budget. This means that it is not necessary for dates of individual work items to line up exactly with dates of the high-level phases. 

Compare projects

The compare projects feature in Project 2010 now includes Gantt bars to help users see more clearly how one version of a project differs from another version.

Timeline

Project 2010 now includes a timeline view. For new files, the timeline view is automatically displayed above most other views. This shows a concise overview of the entire schedule. Otherwise, users can turn on the timeline view manually. Users can add tasks to the timeline, print it, or paste it into an e-mail message for an easy-to-view project summary.

Enhanced copy and paste

This feature lets users copy and paste content between Microsoft Office programs and Project 2010, and keep formatting, outline levels, and column headers.

Excel-like features

Features similar to those in Microsoft Excel are available in Project 2010. This includes the following: 


Simplified adding of new columns. A user can click the Add New Column heading at the right end of a sheet view, and then type or select the name of a new or existing column. An existing column can also be quickly renamed by clicking its title and typing a different column name.


Enhanced filter UI makes it easier for users to find tasks and resources.


32-bit color support and text wrapping enable users to create views that are similar to Excel reports.

Find commonly used commands quickly

The most commonly used commands can now be found easily. By right-clicking any item in a view, such as bar, table cell, or chart, a mini-toolbar with a quick list of commonly used commands is displayed.

The view slider

In Project 2010, users can quickly zoom in and out of the time phased section of a view by using a slider in the status bar. Move the view slider to the right to zoom in a schedule and move the slider to the left to zoom out. The view slider works in the Gantt chart, network diagram, calendar, and all graph views.

Backwards compatibility

Project 2010 is compatible with previous versions of Microsoft Project.

Users can create files in Office Project 2007 or earlier and then open and edit them in Project 2010, although certain features of Project 2010 are not enabled. If you save the earlier version files in the Project 2010 format, all Project 2010 is available.

In addition, you can create files in Project 2010 and then convert them to the Office Project 2007, Project 2000, and Project 2003 file formats.

What’s changed

This section summarizes the feature changes in Project 2010.

Application settings

The following dialog boxes contain features that are changed: 


Spelling options

Customize

Service options

Options
What’s removed

This section provides information about removed features in Project 2010.

Custom forms

The ability to create and use custom forms through the user interface (Tools | Customize | Forms) is removed in Project 2010.  If users previously created custom forms in their application, the forms can no longer be accessed.

This is an outdated and rarely used feature. The amount of effort required to maintain the feature (for example, updating the controls to be compatible with Project 2010) is not feasible. Use Microsoft Visual Basic for Applications (VBA) to create custom forms that replace the previously created forms. Customers usually use VBA, Visual Studio Tools for Office (VSTO), or other methods to perform the same task.

OWC resource availability graphs

Because OWC is removed in Microsoft Office 2010, resource availability graphs have changed in Project 2010, and users can no longer see proposed availability on the selected task without temporarily assigning a resource to the task. In addition, users lose the split when they select to see the graph, can no longer graph multiple resources together (you must do this one at a time), and do not see numbers next to the graph saying how high the bars are. The team builder experience is also different from the assign resource experience. Team builder starts PWA, and the assigned resource uses resource graphs in Project 2010. The new graphs are customizable and are now printable.

Add-ins, sample macros, and project guide

Add-ins, sample macros, and sample project guide are not included with Project 2010.

The following add-ins are incorporated into Project 2010:


Compare Project Versions


Adjust Dates

The following add-ins are removed: 


Pert Analysis


Copy picture (no longer automatically creates an Office document and cannot export to the JPG format)


Format_Duration


ResMgmt_TaskEntry


Rollup_Formatting


Toggle_Read_only


Update_File

Save as Excel Pivot Table

Save as Excel Pivot Table is replaced by Desktop Reports in Project 2010, Professional and Standard.

The ability to save directly into a pivot table is removed.

The File | Save As menu used to include the following:


Save as XLS


Save as XLS Pivot Table

The File | Save As menu now includes the following:


Save as XLS


Save as XLSX


Save as XLSB

Project 2010 now supports the new file formats in Microsoft Excel 2010. Users should use desktop reports to generate a normalized version of their tasks in Excel 2010.

Migration considerations

When planning a migration to Project 2010, review what is new, changed, and removed for Project 2010.

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 was updated to VBA 7.0. VBA 7.0 settings were reset to their defaults after migration instead of automatically repopulating. This occurred because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	Office 2000 through Office 2007
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\7.0\Common


To correct this problem, copy the VBA 6.0 registry keys from the 6.0 hive to the 7.0 hive.

For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx) and Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=185841).

Changes in Publisher 2010

This article lists changes in Microsoft Publisher 2010 since Microsoft Office Publisher 2007 and migration considerations.

In this article:


What’s new

What’s changed

What’s removed

Migration considerations
What’s new

This section highlights new features in Publisher 2010.

The ribbon

The ribbon, part of the Microsoft Office Fluent user interface (UI), was designed to optimize key Publisher scenarios to make them easier to use. The ribbon in Publisher 2010 provides quicker access to all the commands and allows for easier future additions and customizations. You can also customize the ribbon. For example, you can create custom tabs and custom groups to contain frequently used commands. To help maximize the note-taking space on the page, the ribbon can also be hidden while writing.

Backstage view

The Microsoft Office Backstage is part of the Fluent UI and a companion feature to the ribbon. The Backstage view, which can be accessed from the File tab, helps you find frequently used features for managing your Publisher 2010 files. (The File tab replaces the Microsoft Office Button and File menu that were used in earlier releases of Microsoft Office.) The Backstage is used to manage files and the data about the files, such as creating and saving files, inspecting for hidden metadata or personal information, and setting file options.

Simplified, cleaner workspace

In the new workspace, users will see object boundaries only when they want them (for example, when they pause on or select an object), and alignment guides when they need them (for example, as they drag an object). Users can also move from page to page quickly by using the new page navigation pane, which displays single-page or double-page thumbnails.
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Note: 

The ribbon and the Backstage view are features of the Microsoft Office Fluent user interface, which is a feature of Microsoft Office 2010 applications. This it easier for users to find and use Office 2010 features. For more information about the Microsoft Office Fluent user interface, see Microsoft Office Fluent User Interface Resource Center (http://go.microsoft.com/fwlink/?LinkID=111045).

Integrated print and preview experience

Print and Print Preview are integrated so that it is easier for users to get a more accurate view of what their publications will look like when they are printed. This includes the ability to make print adjustments while viewing the effect of the changes in a large preview of their publication. Users can view multiple pages at the same time, view page boundaries, page numbers, and sheet rulers while in print preview, and even view a simulation of a two-sided document as if it were held up to a light — to see the front and back at the same time, as the publication will look when printed.

Save file as .pdf or .xps

Users can save files in the .pdf or .xps file format. This feature can be blocked by using Group Policy. Also, .pdf files can be password-protected for an added layer of security.

64-bit edition

Publisher 2010 64-bit edition can be installed on Windows 64-bit operating systems, and is backward-compatible with other versions of Publisher. Users can open, edit, and save any Publisher 2003, Office Publisher 2007, Publisher 2010 32-bit edition, or Publisher 2010 64-bit edition file on a computer that is running either a 32-bit or 64-bit Windows operating system. For more information, see 64-bit editions of Office 2010.

What’s changed

This section summarizes the feature changes in Publisher 2010.

Improved picture technology

Users can more easily work with pictures in their publications with the following picture technology improvements:


Cropping   Users can rotate and resize pictures, crop them into non-rectangular shapes, and preview the images while keeping the picture in the desired size, shape, and location.


Replacing pictures   Users can replace pictures by drag-and-drop, swap two pictures in a single operation, and paste pictures copied outside from Publisher into a placeholder in Publisher.


Using picture placeholders   Users can maintain placeholder dimensions when a picture is inserted. For example, pictures either too small or too large for a placeholder are automatically resized.


Add captions   Users can now add captions to their pictures, choosing from a gallery of caption designs and layouts, and make changes easily.

Object alignment

Users can use visual alignment guides to align objects to other objects or text, but can ultimately determine where they want to place their objects. This includes the ability to offset-align an object.

Improved access to templates and building blocks online

Users can use templates and insert building blocks of content (for example, mastheads, borders, and graphics) to create professional-looking pages. Publisher 2010 makes it easier for users to access the Publisher online community to get pre-built templates and building blocks, and share ones they create.

Catalog merge

Catalog merge, which lets users merge text and images from a database (such as Microsoft Excel, Microsoft Access, or Microsoft Outlook) is more easily accessed through the UI. Users will be able to initiate catalog merge at any point while making their publications.

What’s removed

This section provides information about removed features in Publisher 2010.

Web mode

Creating new Web sites and Web publications is not available in Publisher 2010. However, users can still edit Web publications created in an earlier version of Publisher. Publisher 2010 does not display a folder of Web site templates, or a user interface access point to change a publication to Web mode. However, users see a Web mode tab when they open a Web publication created in an earlier version of Publisher.

Outdated application settings

Users no longer have access to several settings that were available in Tools | Options. This includes changes to the following dialog boxes: Spelling options, Customize, Service options, and several tabs in Options. This also includes removal of or changes to the following in Settings: Show basic colors in color palette, Show TipPages + Reset Tips button, Show underline for merge fields and business information fields, Automatically synchronize formatting, and Use a wizard for blank publications.

Migration considerations

When planning a migration to Publisher 2010, review what is new, changed and removed for Publisher 2010. 

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 was updated to VBA 7.0. VBA 7.0 settings were reset to their defaults after migration instead of automatically repopulating. This occurred because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	Office 2000 through Office 2007
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\7.0\Common


To correct this problem, copy the VBA 6.0 registry keys from the 6.0 hive to the 7.0 hive.

For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx)and Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=185841).

See Also
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Changes in SharePoint Designer 2010

This article lists changes in Microsoft SharePoint Designer 2010 since Microsoft Office SharePoint Designer 2007 and migration considerations.

In this article:

What’s removed
Migration considerations
What’s removed

This section provides information about removed features in SharePoint Designer 2010.

Contributor Settings

In Office SharePoint Designer 2007, Contributor Settings was used to configure and enable Contributor mode, a limited access mode. Users who opened a site for editing in Office SharePoint Designer 2007 had access to different commands or features, depending on which Contributor group they were assigned to and which editing restrictions had been assigned to that Contributor group. Contributor Settings worked at the site level, and the settings could not be inherited by any subsites of a parent site. Contributor Settings was not a security feature, it was designed to be used in an environment where site managers were confident of the intentions of the users and was intended to help prevent accidental changes to a Web site.

Contributor Settings is removed in Microsoft SharePoint Designer 2010 because the feature was complicated, underused, and did not integrate well with the SharePoint Products and Technologies permission model, because users could bypass the restrictions imposed by the feature. The functionality is replaced by a mix of reliance on the SharePoint Products and Technologies permission model and the SharePoint Role Designer feature.

Database features

The database features in Microsoft FrontPage and Office SharePoint Designer 2007 do not apply to SharePoint Product and Technologies Web sites and are not supported in Microsoft SharePoint Designer 2010. The features that are removed in Microsoft SharePoint Designer 2010 include the following:


Database Interface Wizard   Creates a new database-driven Web site in Office SharePoint Designer 2007.


Database Results Wizard   Creates Web pages that contain the database results Web component, also known as a WebBot, in Office SharePoint Designer 2007. SharePoint Designer 2010 does not support the Database Results WebBot. When you view a Web page or if you use Design view in SharePoint Designer 2010 to open an existing database results page, the Database Results WebBot is rendered as an HTML comment.


Database tab of the Site settings dialog box   Manages database connection settings in Office SharePoint Designer 2007.

Layout tables

In Office FrontPage 2003 and Office SharePoint Designer 2007, you could create Web page layouts by using layout tables and cells. A layout table is the framework you create for a page layout. Layout cells are the regions within that framework that contain the content in a page, including text, images, Web parts, and other elements. Together, layout tables and cells represent horizontal and vertical regions that users can add to Web pages, which provide visual structure for your content.

CSS layout features have replaced the layout tables feature in Microsoft SharePoint Designer 2010, and the extensive HTML comments that layout tables rely on are not recognized. If you open a Web page that contains an existing layout table in SharePoint Designer 2010, the layout table functions correctly. However, you cannot use SharePoint Designer 2010 to insert a new layout table.

Microsoft Script Editor (MSE)

In Office SharePoint Designer 2007 and previous versions of Microsoft FrontPage, you could use the Microsoft Script Editor (MSE) to add text, edit HTML tags, and edit any Microsoft Visual Basic Scripting Edition (VBScript) code in a data access page. MSE also provided IntelliSense features for script creation and editing. You could also use the Script Editor to view your page as it would appear in a Web browser. Microsoft SharePoint Designer 2010 does not include Microsoft Script Editor.

Publish, backup, and restore remote Web site

SharePoint Designer 2010 is designed for users to work on — instead of designing and publishing — SharePoint Products and Technologies Web sites. In contrast, Microsoft FrontPage was designed as a server-agnostic Web site creation and management tool. Legacy features for publishing and connecting to remote Web sites and managing the transfer of Web sites and Web content are removed in SharePoint Designer 2010.

SharePoint Designer 2010 is not designed to take the place of server administration tasks such as backup or restore. Operations — such as backup, restore, content migration, and other management tasks that affect entire SharePoint Products and Technologies Web sites — should be completed by using the Central Administration Web page.

Back up a Web site

SharePoint Designer 2010 is designed to work with content on an existing SharePoint Products and Technologies Web site. To back up a Web site, an administrator for the SharePoint Products and Technologies Web site uses the Central Administration Web site for the collection.

Restore a Web site

SharePoint Designer 2010 is designed to work with content on an existing SharePoint Products and Technologies Web site. To restore a Web site, an administrator for the SharePoint Products and Technologies Web site uses the Central Administration Web site for the collection.

FTP

FrontPage provided a built-in FTP client for connecting to servers without Microsoft FrontPage server extensions. The built-in FTP client enabled users to open sites over FTP and then publish an entire Web site or manage individual files on the remote Web server. Because SharePoint Designer 2010 is designed for working with SharePoint Products and Technologies Web sites, and these servers already have the necessary underlying code installed, an FTP client is not required and is removed.

Import Web site wizard

SharePoint Designer 2010 is designed to work with content on an existing SharePoint Products and Technologies Web site. Therefore, the ability to import a Web site from another server or from a file location is removed.

Publish Web site

SharePoint Designer 2010 is designed to work with content on a SharePoint Products and Technologies Web site. Therefore, the ability to create, edit, or publish a disk-based Web site and work with remote Web sites is removed. Unlike SharePoint Designer 2010, Office SharePoint Designer 2007 did support disk-based Web sites. When you edited Web pages from a Web site folder, metadata such as your logon name was saved for each file edited and used to display the author information, such as Created by or Modified by, for files in the Office SharePoint Designer 2007Web Site views and File Properties dialog box. By clearing the Manage the Web site using Office SharePoint Designer 2007 metadata files check box in the Site Settings dialog box, you could choose to remove the metadata from the Web site folder on your local computer. Because the ability to open and work with disk-based Web sites is removed, this privacy concern does not apply to SharePoint Designer 2010.

Web package

A Web package can contain Web pages, templates, Web components, themes, graphics, style sheets, and other elements. Web packages are CAB files (with .fwp file name extensions) that you use to import or export from a Web site. When working with a SharePoint Products and Technologies Web site, SharePoint Designer 2010 provides direct access to importing or exporting Web packages. SharePoint Designer 2010 does not import Web package files. 

There are two alternative methods that we recommend to deploy packaged functionality when you are working with a SharePoint Products and Technologies Web site. The first method is that you can use a custom site template. Custom site templates are stored as an .stp file in the SharePoint database. Second, you can use the Windows SharePoint Services solution framework. You can use solutions to package and deploy custom features, site definitions, templates, Web parts, and assemblies. The Windows SharePoint Services solution framework lets you bundle all the components for extending Windows SharePoint Services in a solution file. A solution file is a cabinet format file but it has a .wsp extension. A solution is a deployable, reusable package that contains a set of features, site definitions, and assemblies that apply to sites, and that you can individually enable or disable. You can use the solution file to deploy the contents of a Web Part package. This includes assemblies, class resources, .dwp files, and other package components.

Views

Views in FrontPage and Office SharePoint Designer 2007 offered various ways to view the files and edit Web pages in your Web site. Each view offered its own advantages for performing Web site creation, editing, maintenance, and management tasks. SharePoint Designer 2010 includes changes to the Reports, Navigation, and Hyperlinks views.

Reports view

In Office SharePoint Designer 2007, Reports view enables you to run reports for information such as the number and kind of images on your page, broken or outdated hyperlinks, or pages that might be slow to load. In FrontPage and Office SharePoint Designer 2007, Reports view provides access to statistics that let you monitor all aspects of your Web site. You can examine detailed information about the performance of your Web site and also information about your visitors. You can also use the reports to find and fix many common problems, keep track of the development on your Web site, and continue to improve and tailor your Web site to enhance the user experience.

SharePoint Designer 2010 changes the way that you access reports and has removed those reports that are not useful in a SharePoint Products and Technologies Web site.

Navigation view

In FrontPage or Office SharePoint Designer 2007, the Navigation view provides an overhead look at the navigation structure of your Web site and shows the Web pages that are a part of the navigation structure of the Web site as a flowchart. The Navigation view and Navigation task pane do not work well with SharePoint Products and Technologies Web sites and have been replaced by new features such as site navigation and the quick launch bar.

Hyperlinks view

Hyperlinks view provides a visual representation of all the hyperlinks related to a specific Web page in a Web site. When you select a Web page in the hyperlinks view, all the other Web pages in that Web site that contain hyperlinks that connect to the selected Web page are displayed, and a line connects the Web pages. Along with displaying these hyperlinks, the hyperlinks from the Web page to any resource — image, Web page, or other object — is displayed together with an indication of the link validity.

The Hyperlinks view is removed from SharePoint Designer 2010, because this approach to hyperlinks is not useful in a SharePoint Products and Technologies Web site. The error checking features in SharePoint Designer 2010 let you check for broken links, unused pages, cascading style sheets usage, and master page usage.

Migration considerations

When planning a migration to SharePoint Designer 2010, review what is new, changed, and removed for SharePoint Designer 2010.

Changes in SharePoint Workspace 2010

This article lists changes in Microsoft SharePoint Workspace 2010 since Microsoft Office Groove 2007.


What’s new

What’s changed

What’s removed

Migration considerations
What’s new

This section highlights new features in SharePoint Workspace 2010.

SharePoint integration

SharePoint Workspace 2010 enables SharePoint Server 2010 users to create a personal SharePoint workspace, which is a local, synchronized cache of document and list content on a SharePoint site. This feature allows information workers who have access to a SharePoint site to easily access and contribute to SharePoint document libraries and lists from offline locations and when they are working online.

SharePoint Workspace user interface

The appearance and behavior of the Fluent user interface (UI) in SharePoint Workspace 2010 is optimized for familiarity to SharePoint users.

What’s changed

This section summarizes the feature changes in SharePoint Workspace 2010.

SharePoint Workspace product

The Groove client application is now the Microsoft SharePoint Workspace client application. Like Office Groove 2007, SharePoint Workspace 2010 enables users to create a local, synchronized cache of document content on a SharePoint site. However, in SharePoint Workspace this is achieved by creating a personal, synchronized SharePoint workspace instead of using a SharePoint Files tool in an Office Groove 2007 workspace. Like Office Groove 2007, SharePoint Workspace 2010 enables users to create Groove workspaces and shared folders. The appearance and behavior of the SharePoint Workspace 2010 user interface is updated for more continuity with SharePoint team spaces.

Tools location

The list of tools has moved from the horizontal tab arrangement in the lower part of Workspace Explorer to a vertical arrangement on the File tab in SharePoint Workspace 2010. Reordering tools by dragging them to a new location in the UI is no longer supported. However, SharePoint Workspace 2010 users can now decide to order tools by type or alphabetically. This change makes tools more visible to users.

User credentials

To improve consistency with other Microsoft Office 2010 applications, SharePoint Workspace 2010 has changed its security approach from a Groove-specific logon password or smartcard to Windows logon credentials for authenticating users. Elimination of the Groove-specific logon credentials helps provide a more secure and manageable environment. When users log on to SharePoint Workspace 2010, a message appears indicates that a Groove password or smartcard is no longer required for logging on to Groove and that accounts will be protected by using their Windows logon credentials. Authentication to SharePoint sites is unchanged. SharePoint Workspace 2010 users authenticate to SharePoint sites by using SharePoint Server credentials, as in Office Groove 2007.

Roles and permissions

In SharePoint Workspace 2010, permissions are automatically defined for Roles in Groove 2010 workspaces. Permissions continue to be editable in Groove 2007 workspaces.

Workspace Manager

The Office Groove 2007 Workspace Manager displays a list of a user’s workspaces. This includes the workspace type, status information, and the last unread date and time. In SharePoint Workspace 2010, the Workspace Manager no longer exists as separate feature because the Launchbar provides comparable functionality.

What’s removed

This section provides information about removed features in SharePoint Workspace 2010. The following Office Groove 2007 capabilities are not supported in SharePoint Workspace 2010, usually because the capability is unnecessary, or to avoid confusion with or duplication of similar functionality that is provided by another application.

Alerts on contacts

The Office Groove 2007 option to set an alert on specific contacts to indicate their online presence in a workspace is removed in SharePoint Workspace 2010. Alerts that were set on contacts in Microsoft Office Groove 2007 do not appear in SharePoint Workspace 2010. Instead of setting an alert on a contact, SharePoint Workspace 2010 users can use Microsoft Communicator to “tag” the contact.

E-mail invitation

Support of the mailto protocol for sending Groove workspace invitations and contact information through e-mail clients other than Microsoft Outlook 2010 is removed in SharePoint Workspace 2010. The Send e-mail invitations using Microsoft Outlook check box is removed from the Preferences dialog box. Users who have Outlook 2010 as their e-mail client will not be affected by this change. However, users who have other e-mail clients or instant messaging applications must copy the invitation and paste it into the message. Limitations of the mailto protocol prevented it from working correctly for all languages and from providing the internationalization support that users required.

Groove Forms Designer

The Groove Forms Designer is removed in SharePoint Workspace 2010. The Groove Forms Designer functionality is replaced by the Lists tool, which includes a designer capability that lets developers import Microsoft InfoPath 2010 form templates. When Office Groove 2007 users upgrade to SharePoint Workspace 2010, the forms in existing Groove workspaces will work as expected. Application developers must use a Office Groove 2007 client installation to maintain or modify legacy custom forms in existing Groove workspaces.

Groove InfoPath Forms

The Groove InfoPath Forms Designer is removed in SharePoint Workspace 2010. After upgrading, the forms in existing Groove workspaces will work as expected. We recommend that you use Microsoft InfoPath 2010 to edit or create forms. SharePoint Workspace 2010 users can import new forms that are created in InfoPath 2010 into a Groove workspace.

Custom tools

The Custom tool feature is removed in SharePoint Workspace 2010. SharePoint Workspace users cannot add a custom tool or create custom groupings of tools. In Office Groove 2007, a user could find the Custom Tool option in the Add tool dialog box.

Groove Workspace Explorer contact list

The area of the Workspace Explorer that contains tools and lists and the ability to display a contact list as part of Workspace Explorer is removed in SharePoint Workspace 2010. The functionality of working with contacts is otherwise unchanged and users can continue to work with contacts on the Launchbar.

Groove Workspace Explorer workspace list

The area of the Workspace Explorer that contains tools and lists and the ability to display a workspace list as part of Workspace Explorer is removed in SharePoint Workspace 2010. The functionality of working with a workspace is otherwise unchanged and users can continue to work with workspaces on the Launchbar.

Lite Chat invitations

Microsoft Communicator is integrated into Office 2010. Because Communicator supports multiuser chat, support for Lite Chat invitations in SharePoint Workspace 2010 is removed as a redundant feature. 

Connect tool

SharePoint Workspace enables users to create a local, synchronized cache of document content on a SharePoint site through a personal, synchronized SharePoint workspace. This process replaces the Office Groove 2007 Connect tool. Therefore, the Connect tool is removed.

Navigate Together feature

The Navigate Together feature in the Office Groove 2007 Options menu is removed in SharePoint Workspace 2010. By using this feature, one person could navigate through the UI and then have all users who were in Navigate Together mode navigate through the workspace UI together. In SharePoint Workspace 2010, users who need to move through the UI with other users must coordinate directly with the other users during the session, either by telephone or by instant messaging.

Communicator

The Windows API-based Microsoft Communicator integration is removed in Microsoft SharePoint Workspace 2010 because Microsoft Office-based integration replaces it. This provides a richer, more robust, and more consistent experience across all Office 2010 applications. Users can see information and actions available on SharePoint Workspace 2010 contacts.

Suspended icon overlay

When members are suspended in an Office Groove 2007 workspace, their contact name is marked with a Suspended icon and they are grouped under a Suspended heading in a member's lists. In SharePoint Workspace 2010, the Suspended icon is removed and suspended users are grouped under a Suspended heading only if the Members pane is sorted by status.

Tooltip information about user entering tool

In Office Groove 2007, every time that a user enters a tool in any workspace, every user receives a ScreenTip: "<User A> has entered <tool name>". To improve performance and to minimize the distraction that users experience, especially in workspaces with many members, this ScreenTip notification functionality is removed in SharePoint Workspace 2010. Users can still use the numbered presence indicator on the tool name to see the names of the users in a tool.

Multiple identities

In Office Groove 2007, a user could create multiple identities within a single account. This feature was sometimes confusing for users. Therefore, the ability to create multiple identities for an account is removed in SharePoint Workspace 2010. SharePoint Workspace 2010 supports one account for one identity only. If existing Office Groove 2007 accounts have multiple identities, upon upgrade, those identities are maintained as part of the account. Note that the ability to create multiple accounts is still supported.

Push-to-talk and voice memos

Office Groove 2007 provided a button UI that users could click to converse by voice over IP. This functionality was not always effective and rarely used. Therefore, it is removed in SharePoint Workspace 2010. Similarly, Office Groove 2007 voice memos that could be attached to an instant message are removed in SharePoint Workspace 2010.

Ink chat

The Office Groove 2007 chat capability provided Ink mode options that let users draw chat entries by dragging with the mouse. Ink mode options were not of prime importance to most users and do not exist in SharePoint Workspace 2010. 

Migration considerations

Application developers must use an Office Groove 2007 client installation to maintain or modify any legacy custom forms that are retained in a Groove workspace after migration from Office Groove 2007 to SharePoint Workspace 2010. Forms Designer functionality is replaced by the Lists tool, as mentioned earlier in this article.
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Deploy SharePoint Workspace 2010 (http://technet.microsoft.com/library/24ec9cec-361b-4862-b5c3-d7ad5650c425(Office.14).aspx)
Changes in Visio 2010

This article lists changes in Microsoft Visio 2010 since Microsoft Office Visio 2007 and migration considerations. If you are upgrading from Microsoft Office Visio 2003, see also Changes in Office Visio 2007 (http://go.microsoft.com/fwlink/?LinkId=169007).
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
Migration considerations
What’s new

This section highlights new features in Visio 2010.

Fluent UI

The Visio 2010 user interface is redesigned and now uses the Microsoft Office Fluent user interface (UI). First introduced in the 2007 Microsoft Office system, the Fluent UI is designed to make it easier for people to find and use the full range of features that Office applications provide, and to preserve an uncluttered workspace. For more information about the Fluent UI, see the resources in Microsoft Office Fluent User Interface Resource Center (http://go.microsoft.com/fwlink/?LinkID=111045).

The ribbon

The ribbon, part of the Fluent UI, was designed to optimize key Visio design scenarios to make them easier to use. The ribbon provides quicker access to all the commands in Visio 2010 and allows for easier future additions and customizations. You can also customize the ribbon. For example, you can create custom tabs and custom groups to contain frequently used commands. To help maximize the editing of your presentation space on the page, the ribbon can also be hidden while you write. All existing Visio Software Development Kit (SDK) sample applications will be changed to use the RibbonX extensibility framework.

Backstage view

The Microsoft Office Backstage is part of the Fluent UI and a companion feature to the ribbon. The Backstage view, which can be accessed from the File tab, helps you find frequently used features for managing your Visio drawings. (The File tab replaces the Microsoft Office Button and File menu that were used in earlier release of Microsoft Office.) The Backstage view is used to manage files and the data about the files, such as creating and saving files, inspecting for hidden metadata or personal information, and setting file options.

ShapeSheet IntelliSense

If you are new to ShapeSheet formulas in Visio, they are similar to the formulas in Excel, except you can use them to program and recalculate shapes. A ShapeSheet spreadsheet stores information for every Visio shape. Within a ShapeSheet, formulas from previous versions of Visio are still valid. 

The IntelliSense is new to Visio 2010. This feature does an automatic lookup and auto-complete for formulas.

Some of the benefits of ShapeSheet IntelliSense are as follows:


Keyword lookup


Keyword auto-complete


Keyword definition pop-up


Function signature hints pop-up


Parenthesis matching


Multi-line formula input for developers


Supports local and cross-sheet references 
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What’s changed

This section summarizes the changes in Visio 2010.

Status bar

The following status items are removed from the status bar in Visio 2010, but still appear in the Size & Position window:


X


Y


Begin X


Begin Y


End X


End Y

Customize ink pens

The Customize Pens dialog box is removed in Visio 2010 and replaced with the new Pens model that is used by OfficeArt and OneNote. Visio 2010 no longer persists settings for five distinct pens in the registry. Users can no longer see an entry point for the Customize Pens dialog box or access the dialog box by any means. Instead, users can customize ink pen properties by using the controls on the Ink Tools tab.

Color by Value

The Color By Value add-on no longer functions in Visio 2010. It is replaced by the Data Graphics feature set, which provides more functionality. You can no longer see the Color By Value add-on in the Add-Ons hierarchical control. Shapes no longer contain right-click actions to open the add-on. Object model calls from shapes that invoke the legacy Color By Value add-on result in an alert about the new Data Graphics functionality and a suggestion to view the Data Graphics Help files.

Visual Studio Add-in/Add-on Wizard

The Visual Studio Add-in/Add-on wizard, which is included with the Visio 2010 SDK, was changed from the earlier version. The wizard in Visio 2010 SDK creates Visio add-on projects, but no longer creates add-in projects. Wizard support for Visio 2010 VSTO add-in projects is available natively in Microsoft Visual Studio 2010. 

What’s removed

This section provides information about removed features in Visio 2010.

ShapeStudio

The ShapeStudio tool available in previous versions of the Visio SDK has been removed from the Visio 2010 SDK. 

Status bar 

The following status items are removed from the status bar in Visio 2010:


Begin


End


Dx


Dy


Snap


Top


Bottom


Left


Right


Tile


Tile Row


Tile Column


Ancestor

The status bar in the Fluent UI focuses on higher priority status items, many of which have the added utility of being actionable.

Find Shape feature

The Find Shape server feature previously available in Visio enabled users to search for shapes installed on Microsoft Web sites. Additional, new, and updated shapes were then made available together with those already on the local computer.

The Find Shape feature no longer connects to the Internet to look for additional Visio shapes as did in previous versions. The Find Shape feature no longer connects to additional Web servers that an administrator might have set up to host additional shapes. Instead, users must download the content from Office Online. Users can access download instructions by using the Find Shapes Online command on the More Shapes menus.

With this change, the Find Shape feature will display search results found only on the local computer.

In Visio 2010, the user can toggle the user interface on and off by using the Search for Shapes toggle available on the More Shapes menu.

Stencil docking

The redesign of the Shapes Window in Visio 2010 is now optimized for the vertical orientation of the window. Therefore, in Visio 2010, stencils are docked on the left or right of the Shapes Window with docking in the top and bottom positions no longer allowed.
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Migration considerations

This section provides information about features and changes that administrators should consider when migrating from Microsoft Office Visio 2007 to Microsoft Visio 2010. A noticeable change is that Visio has joined the rest of the Microsoft Office products design and uses the Microsoft Office Fluent user interface (UI). In Visio 2010, you navigate the features by using the ribbon, the Quick Access Toolbar, and the Microsoft Office Backstage view.

Process Repository

In Visio 2010, you can easily manage collections of process diagrams that are typically stored on network file shares. You can ensure that you are editing the most recent version and updating a user if any changes were made to the process diagrams. For many administrators and managers who supervise these document repositories, ensuring diagrams comply with internal standards and tracking all the processes involved can be overwhelming. The Visio Process Repository, a new site template that is included with Microsoft SharePoint Server 2010, uses the collaborative features in SharePoint Server 2010, including:


Check in/Check out


Versioning


Workflow

These features integrate with several new process management features in Visio 2010. The result is that, in a few clicks, a SharePoint administrator can create a Visio Process Repository that is preconfigured for easy storage and management of Visio process diagrams. A Repository site contains a library for documentation, a task list, and a discussion board. The Process Diagrams document library is designed to store processes and comes prepopulated with several templates that can be used to create new process diagrams.

Publish a process diagram to a repository

You can check a diagram for validation issues prior to publishing by using the Validation feature. When you are ready, you can save the document back to the repository by using the Save to SharePoint billboard in the Backstage view. To save a document to the repository, follow these steps:

1.
In the Backstage view, click the File tab.

2.
Click Save & Send.

3.
Under Save & Send, click Save to SharePoint.

4.
Select the desired Process Diagrams document library and file type.

5.
Click Save As to save the document.

6.
The process diagram will be listed in the Process Diagrams document library at this point. The document library has two special columns:

a.
Keywords   This column displays the swim-lane headings of each cross-functional flowchart in the document library.

b.
Category   This column displays the validation status of each document. When used with the Diagram Validation feature in Visio 2010, it is easier for administrators and managers to monitor whether the processes in the repository meet their organization’s standards.

Because the Process Repository is built on top of SharePoint Server 2010, you can take advantage of other SharePoint features. For example, you can:


Set up workflows.


Set up automatic e-mail notifications when documents change.


View revision history for a given document.


Visio Services in SharePoint Server 2010 is a service application that lets users view the processes in a browser with one click, even if they do not have Visio installed on their computers. For more information, see Visio Services overview (SharePoint Server 2010) (http://go.microsoft.com/fwlink/?LinkId=184088).

Visio Viewer

Visio Viewer 2002 and Visio Viewer 2003 have been discontinued. If you use Visio Viewer 2007, ensure that you have the latest upgrades or you can move to the Visio 2010 (Beta) Viewer. The Visio 2010 Viewer has all the functionality of the previous viewers, and includes all the security fixes. If you do not want to update to the Visio 2010 Viewer, you must update your existing viewer by following these steps:

1.
If you use Viewer 2002 or Viewer 2003, uninstall it and install Visio 2007 Viewer.

2.
Install Visio Viewer 2007 Service Pack 1.

3.
Install the security update for Visio Viewer 2007. For more information, see Microsoft Knowledge Base article 973709: Security Update for Microsoft Office Visio Viewer 2007 (http://go.microsoft.com/fwlink/?LinkId=184092).

You can also update the view by using Microsoft Update. However, it might involve multiple runs of Microsoft Update to download the relevant updates.

Customization and options

In Visio 2010, there are many settings and customizations that can be made to personalize the user experience. For more information, see Plan customizations and options for Visio 2010 (http://technet.microsoft.com/library/bc6f56d7-a1c5-487f-9078-b2a668252b92(Office.14).aspx).

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 was updated to VBA 7.0. VBA 7.0 settings were reset to their defaults after migration instead of automatically repopulating. This occurred because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	Office 2000 through Office 2007
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\7.0\Common


To correct this problem, copy the VBA 6.0 registry keys from the 6.0 hive to the 7.0 hive.

For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx) and Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=185841).
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Changes in Office 2010
System requirements for Office 2010
Changes in Word 2010

This article lists changes in Microsoft Word 2010 since Microsoft Office Word 2007 and migration considerations. If you are upgrading from Microsoft Office Word 2003, see also Changes in Office Word 2007 (http://go.microsoft.com/fwlink/?LinkId=169004).
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What’s new

This section highlights new features in Word 2010.

Fluent UI

The Word 2010 user interface is redesigned and now uses the Microsoft Office Fluent user interface (UI). Introduced in the 2007 Microsoft Office system, the Fluent UI is designed to make it easier for people to find and use the full range of features that Office applications provide, and to preserve an uncluttered workspace. For more information about the Fluent UI, see the resources in Microsoft Office Fluent User Interface Resource Center (http://go.microsoft.com/fwlink/?LinkID=111045).

The ribbon

The ribbon, part of the Fluent UI, was designed to optimize key Word 2010 documentation scenarios to make them easier to use. The ribbon provides quicker access to all the commands in Word 2010 and allows for easier future additions and customizations. You can also customize the ribbon. For example, you can create custom tabs and custom groups to contain frequently used commands. To help maximize the editing of your documentation space on the page, the ribbon can also be hidden while you write.

Backstage view

The Microsoft Office Backstage is part of the Fluent UI and a companion feature to the ribbon. The Backstage view, which can be accessed from the File menu, helps you find frequently used features for managing your Word documentation files. (The File tab replaces the Microsoft Office Button and File menu that were used in earlier release of Microsoft Office.) The Backstage view is used to manage files and the data about the files, such as creating and saving files, inspecting for hidden metadata or personal information, and setting file options.

File format

The Word 2010 file format enables new features such as sharing on the Web, co-authoring, and versioning. Word 2010 works with Office Word 2007 documents.

Protected View

Files from a potentially unsafe location (such as the Internet or an e-mail attachment) or files that contain active content (such as macros, data connections, or ActiveX controls) are validated and can open in Protected View. When you open files in Protected View mode, the editing functions are disabled. You can open and edit files from trusted sources by clicking Enable Editing. You can also explore data about the files in the Backstage view.

Collaboration and sharing features

Word 2010 supports concurrent editing of documents by multiple users when the file is .docx and is located on a server that is running Microsoft SharePoint Server 2010 (or a cobalt-enabled server). For example, a group of users can work on a document at the same time, or a single user can work on the same document from different computers at the same time, all without locking the file. When working with documents that are not located on a server that runs SharePoint Server 2010, Word 2010 only supports single-user editing. The changes are as follows:


New content is automatically highlighted. 


Author information for any added or shared content is identified by a color-coded bar showing the author’s initials.


Version support lets users see when and by whom changes were made to a document, and automatically highlights changes relative to earlier versions of the document.


Faster synchronization of pages so that changes are displayed to all authors in near real-time.

Document authoring and graphic enhancements

Word 2010 provides improved editing tools with a new set of Picture Tools that enable you to transform your documents into artistically engaging documents. New editing tools are as follows:


Picture Correction Options


Artistic Effect Options


Background Removal


Picture Layout Options
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What’s changed?

This section summarizes the changes in Word 2010.

Cut, copy, and paste

Cut, copy, and paste is the most common way to move content between applications. Word 2010 can copy and paste content in many formats. Word 2010 has many options available at paste time through the Preview before you paste. Paste options include the following:


Keep Source Formatting


Merge Formatting


Use Destination Theme


Keep Text Only

Document map

The authoring experience is improved with new ways to navigate content by heading, page, or object. The document map is replaced by the navigation pane. Instead of the document map, users see a new navigation pane in its place. Users can see all the headings of a document, their relative positions, and the current location. With that available, moving between various headings is made by clicking parts of the pane. Outlines can be collapsed to hide nested headings, for long complex documents. Users can no longer see revision marks on headings within the map. Instead, users see the final result of the revisions within the pane.

The overall benefit of this change is a cleaner interface that matches the look of the ribbon. Users also have access to some new functionality as follows:


Manipulate the headings within the pane to rearrange the content in the document.


Integration with the Find feature, highlighting the headings with the find results.

The resizable pane consists of the following:


A text box for the new Find feature


A view switcher for changing view types


Buttons for skipping to the Next and Previous items


The main region, a list of navigable items, with scrolling when it is necessary

The pane is shown by default, but can be hidden through a toggle button at the top of the scroll bar, via the View tab, or the navigation control in Reading mode. The check box to access the navigation pane is the same as the former document map (only the name is changed).

Print preview

The Print preview experience and the Print dialog box have been combined into the Print Place via the Backstage. This feature is consistent across all Office applications. It can be invoked through the object model for third-party developers to create add-ins for Word 2010. The workflow process is still the same by using CTRL+P or by selecting Print in the Backstage. The Print Preview Edit Mode was fully deprecated.

RTF file format

The RTF file format is no longer enhanced to include new features and functionality. Features and functionality that are new to Word 2010 and future versions of Word are lost when they are saved in RTF. In addition, Word 2010 supports a new converter interface based on Open XML Formats.

Smart tags

Text is no longer automatically recognized by a smart tag recognizer and will no longer display a purple dotted underline. Instead, users will be able to trigger recognition and view custom actions associated with text by selecting the text and clicking the Additional actions on the context menu. Once the user has moved the IP outside the current paragraph, the text tagging will be cleared for that paragraph. There are changes to the object model to reflect that text marked by a smart tag recognizer will not be stored in the document.

Views

In Word 2010, when you click the View tab, the options are as follows:


Print Layout


Full Screen Reading


Web Layout


Outline


Draft (Normal)

What’s removed

This section provides information about removed features in Word 2010.

Person Name removal of smart tag

The Person Name (Outlook E-mail Contacts) smart tag will be removed and replaced with functionality that uses the Global Address List (GAL) through Microsoft Office Communicator. In Word the functionality will be replaced by the “additional actions” functionality described earlier in this article, but in Excel the functionality will be completely removed. The 2007 Office system will be the last version that supports this functionality.

AutoSummary

AutoSummary is the feature that lists the Title, Subject, Author, Keywords, and Comments. This feature was available from the Tools menu. In Word 2010, this feature is no longer used. If you insert an abstract into the document, that is not AutoSummary data and will remain. However, if the document was in a summary view when it is saved, it will not be after you open it.

Microsoft Office Document Imaging (MODI)

MODI provided a common document imaging and scanning solution for Office. It was also the basis of the Fax feature for Office. When MODI was installed, it was the default handler for .tif, .tiff, and .mdi files. In Office 2010, MODI is fully deprecated. This change also affects the setup tree, which no longer shows the MODI Help, OCR, or Indexing Service Filter nodes on the Tools menu. The Internet Fax feature in Office 2010 uses the Windows Fax printer driver to generate a fixed file format (TIF). MODI and all its components are deprecated for 64-bit Office 2010.

Research and Reference pane

The Research and Reference pane is removed from Windows Internet Explorer 7. Therefore, the shortcut ALT+Click in Microsoft Word 2010 no longer takes users to that pane. The Research and Reference feature brought up a research pane to search all Intranet sites and portals. 

Mail Merge by using a Works database

Users cannot perform a mail merge in Microsoft Word 2010 or Microsoft Publisher 2010 by using a Microsoft Works database, because of a change in the object model. This primarily affects users who have configured a recurring mail merge that reads content from a Works database. We recommend that you use Works to export the data and then create a new data source for performing the mail merge operation.

 Search Libraries button

The Search Libraries button is removed from the Insert Citations menu (on the References Tab).

WLL (Word Add-in Libraries)

WLL files are deprecated for both 32-bit and 64-bit Office 2010. A WLL is an add-in for Microsoft Word that you can build with any compiler that supports building DLLs.

Migrations considerations

This section describes changes to consider when you migrate from Office Word 2007 to Word 2010.

Migrating Word files

The default file format has not changed in Microsoft Office 2010. The XML-based file format was introduced in the 2007 Microsoft Office system and continues to be used. For a review of the XML file format, see Overview of the XML file formats in the 2007 Office system (http://go.microsoft.com/fwlink/?LinkId=182085). 

When you open a document in Word 2010, it will open in one of three modes:


Word 2010


Word 2007 compatibility mode


Word 97-2003 compatibility mode

To determine which mode the document is in, check the document’s title bar. If (Compatibility Mode) appears after the file name, the document is in either Word 2007 compatibility mode or Word 97-2003 compatibility mode. You can continue to work in compatibility mode or you can convert your document to the Word 2010 file format.

1.
Click the File tab.

2.
Perform one of the following:


To convert the document without saving a copy, click Info, and then click Convert.


To create a new copy of the document in Word 2010 mode, click Save As, type a new name for the document in the File name box, and then click Word Document in the Save as Type list.

3.
Click Info, and then click Convert.

Compatibility Checker

The Compatibility Checker lists elements in a document that are not supported or that will behave differently in Word 2007 or in Word 97-2003 format. Some of these features will be permanently changed and will not be converted to Word 2010 elements, even if you later convert the document to Word 2010 format.

Embedded Word 2010 objects

Open XML embedded objects can be converted to enable users on earlier versions of Word to be able to change them.

1.
Right-click the embedded object.

2.
Point to Document Object, and then click Convert.

3.
In the Convert dialog box, click Convert To.

4.
In the Object type list, select Microsoft Word 97-2003 Document.

Equations

If you save a document in Word 97-2003 format, equations will be converted to images that you cannot edit. However, if you later convert the document to Word 2010 file format and no changes have been made to the equation images in an earlier version, the equations will become text and you will be able to change them.

SmartArt graphics

When you save a document that contains a SmartArt graphics in Word 97-2003 format, the graphics will be converted to static images. You will be unable to change text inside a graphic, change its layout, or change its general appearance. If you later convert the document to Word 2010 format and no changes have been made to the images in an earlier version, the graphic will be changed back to a SmartArt object.

Migration considerations from Office 97-2003 to Office 2010

Many of the changes from Office 97-2003 to Office 2010 are no different from Office 97-2003 to the 2007 Office system.

For a list of migration considerations from Office 97-2003 to the 2007 Office system, see Migration considerations for Word 2007 (http://go.microsoft.com/fwlink/?LinkId=182089).

The following changes in Word 2010 might affect migration:


AutoText is being moved back to Normal.dotm to facilitate autocomplete. For users going from Office Word 2003 to Word 2010, we recommend that you move the document to %AppData%\Word\Startup, and then follow the steps to upgrade a document. Office Word 2007 users will find their autotext automatically moved.


AutoText gallery is now available in the Quick Parts gallery. Therefore, users no longer have to remember to move their autotext to the Quick Parts gallery.


Word will automatically migrate building blocks to Word 2010 when you first start the application. This is done by creating a copy of the existing building blocks file and putting it in a new directory, %AppData%\Document Building Block\{||cc}\14, and the striping the building blocks that were provided with Office Word 2007 from the file.


Similarly to Word 2007, Word 2010 gives you a new Normal.dotm on the first start. Your old normal file will be named normalold.dotm. If you want to restore your setting from Word 2007, right-click the file, and then click Open. Once in Word, you should use the Upconvert button in the OutSpace to convert the normal file to Word 2010 format.

VBA settings migration

In Office 2010, Visual Basic for Applications (VBA) 6.0 was updated to VBA 7.0. VBA 7.0 settings were reset to their defaults after migration instead of automatically repopulating. This occurred because the registry settings for VBA are in a different hive in Office 2010, as shown in the following table.

	Version
	Registry subkey

	Office 2000 through Office 2007
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\6.0\Common

	Office 2010
	HKEY_CURRENT_USER\SOFTWARE\Microsoft\VBA\7.0\Common


To correct this problem, copy the VBA 6.0 registry keys from the 6.0 hive to the 7.0 hive.

For more information, see Migrate user data registry keys in Office 2010 (http://technet.microsoft.com/library/4d763016-a153-4d22-b7bb-fec28ea57892(Office.14).aspx) and Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=185841).
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This section provides a summary of changes in the 2007 Microsoft Office system for IT administrators who might not be familiar with that version of the product. The 2007 Office system introduced features and improvements that help IT administrators configure, deploy, and maintain their Office installations. These features provided benefits that let administrators work more efficiently and help reduce administrative costs.

In this section:

	Article
	Description

	Setup changes introduced in the 2007 Office system
	Provides a summary of the Setup changes that were introduced in the 2007 Office system. This includes changes in Setup architecture, language architecture, and customization model.

	Product and feature changes introduced in the 2007 Office system
	Provides a summary of the product and feature changes that were introduced in the 2007 Office system. This includes changes in file format, security, and user interface, and object model.


Setup changes introduced in the 2007 Office system

This article provides a summary of the Setup changes that were introduced in the 2007 Microsoft Office system.

In this article:


Setup architecture

Language-neutral architecture

Customization model
Setup architecture

The Setup program for the 2007 Office system was redesigned to support a more efficient installation process. Most of the tools and procedures were new but the overall objective was the same as it was for any previous deployment of Office: to install the correct configuration on users' computers as efficiently as possible. 

In the 2007 Office system release, much of the complexity of this process was absorbed by the new Setup program. Setup handles the most difficult parts for you behind the scenes, and the steps that you take to customize and distribute the product are simpler than in any earlier version. This information also applies to the Office 2010 release of the product because the basic Setup architecture has not changed in this release.

Setup features comparison

The following table compares Setup features that were introduced in the 2007 Office system release to their closest counterparts in previous versions (Microsoft Office 2000, Office XP, and Office 2003). This information also applies to Office 2010.

	Previous version
	2007 Office system and Office 2010 release
	Function

	Windows Installer (Msiexec.exe)
	Setup program (Setup.exe)
	Installation program

	Administrative installation point
	Local installation source (LIS)
	Location of stored program files

	One MSI file per product
	Multiple MSI files per product
	Windows Installer files

	Core English version plus MUI Pack
	Language-neutral architecture
	Deploy multiple languages at the same time

	Setup.ini file
	Config.xml file
	Customize installation file

	Setup command line
	Config.xml file
	Customize installation file

	Custom Installation Wizard
	Office Customization Tool (OCT)
	Customize installation of products

	Custom Maintenance Wizard
	Office Customization Tool
	Customize installation of products

	Office Profile Wizard
	Group Policy settings
	Group Policy Management Console (GPMC) and Group Policy Object Editor Microsoft Management Console (MMC) snap-ins are used to manage policy settings


Setup files

In versions of Office earlier than the 2007 Office system, each product consisted of a single Windows Installer package (MSI file). The chief role of Setup.exe was to call Windows Installer (Msiexec.exe) to install the package. Because Setup passed its command line to Windows Installer, it was possible to manage the installation process by setting Windows Installer properties on the command line. 

Starting with the 2007 Office system release, a single Office product consists of multiple MSI files. This is the same in the Office 2010 release of the product as the basic Setup architecture has not changed in this release. Setup — not Windows Installer — combines the language-neutral core product package with one or more language-specific packages to create a complete product. No individual MSI file represents a product that anyone can install or use, and Setup is required to assemble the correct set of MSI files and to coordinate the installation process from start to finish.

The Office product that you install is defined in the XML files on the installation point. Setup reads data in these XML files, assembles the required set of MSI files for the product, copies all the necessary files to the local installation source, and only then calls Windows Installer to complete the installation process.
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Note: 

You cannot use the Windows Installer command line (Msiexec.exe) to install any product in the 2007 Office system release or in Office 2010, nor can you set Windows Installer properties on the Setup command line. However, you can use the new deployment tools to customize all aspects of the installation process, exactly as you did in previous versions. For more information, see Setup architecture overview for Office 2010 (http://technet.microsoft.com/library/f022a92a-2c32-44b7-996d-09e671a41e9c(Office.14).aspx).

Language-neutral architecture

If you installed previous versions of Office in an international setting, you first installed the core English version and then deployed one or more Multilingual User Interface (MUI) Packs to provide additional language versions to users. You may have used the Custom Installation Wizard to configure the MUI Pack, and then edited the Setup.ini file to chain the MUI Pack installation to the primary English installation. 

The language-neutral architecture that was introduced in the 2007 Office system eliminates the need to chain language packs and condenses the process to a single installation. This also applies to Office 2010 as the language architecture has not changed in this release. After you create your initial network installation point (which always includes a core product), you copy all the additional language folders that you need to the same location. These language folders contain the language-specific packages, or building blocks, that Setup combines with the core product to create a complete product in any language (including English). After you create a network installation point with multiple languages, you can enable Setup to manage the process of assembling the correct language version for each user automatically from the available language options. 

When users run Setup for a particular Office product, Setup detects that there is more than one language available and automatically combines the core package with the language that matches the user locale, which is set in Windows. Only one language version is copied to the local installation source; only one product appears in Add or Remove Programs in Control Panel. Without additional steps on your part, other than dragging language folders to the network installation point, you ensure that users in New York get the English language version, users in Tokyo get the Japanese language version, users in Paris get the French language version, and so on. 

Customizing a multi-language installation is similarly streamlined. You create only one customization file per product, regardless of the number of languages that you are deploying. Most configuration options apply to the core product. The minority of language-specific customizations — for example, the feature installation state for the Japanese Input Method Editor (IME) — are applied where appropriate and otherwise ignored.
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Note: 

When you customize the installation, you can specify that Setup install more than one language on users' computers or that Setup install a particular language regardless of the user locale setting. For more information about the new multi-language architecture, see "Language-neutral design" in Setup architecture overview for Office 2010 (http://technet.microsoft.com/library/f022a92a-2c32-44b7-996d-09e671a41e9c(Office.14).aspx).

Customization model

In versions of Office products earlier than the 2007 Office system, several tools were required to customize Setup and to manage Office after installation. However, the 2007 Office system introduced a consistent, streamlined customization model. You can use one of several methods to customize the installation, although the best method depends on what you are customizing and whether you want users to be able to change the default configuration. This also applies to Office 2010 as the customization model has not changed in this release.

Choosing a customization tool

The following table summarizes the customization methods introduced in the 2007 Office system and describes the recommended or required scenarios for each method. This also applies to Office 2010. 

	Tool or method
	Scenarios
	Results

	Use the Office Customization Tool to create a Setup customization file (.msp file). 
	Recommended for most customizations, including:


Accepting License Terms and entering a volume license key


Running Setup without user interaction


Customizing features and user settings


Distributing an Outlook profile
	Setup installs a default configuration on all computers to which this .msp file is applied. 

Users can modify most settings after the installation.

	Edit the Config.xml file.
	Required for the following customizations:


Specifying the path of the network installation point


Specifying languages to install


Pointing Setup to a custom Config.xml or Setup customization file


Copying the local installation source to the user's computer without installing Office


Chaining additional products to the primary installation
	Setup installs the specified products and languages on all computers installed with this Config.xml file.

Settings specified in Config.xml take precedence over duplicate settings in the Setup customization file.

	Add options or properties to the Setup command line.
	Available for only the following customizations:


Pointing Setup to a custom Config.xml or Setup customization file


Modifying an existing installation


Repairing the product


Uninstalling the product
	Setup applies your customizations when it first installs Office or when it runs in maintenance mode. 

You cannot set Windows Installer properties on the command line.

	Use the Group Policy Object Editor Microsoft Management Console (MMC) snap-in to specify policy settings.
	Used to configure highly restricted or lightly managed configurations for user and computer settings.
	Administrators use Group Policy to define configurations once and then rely on the operating system to enforce that state. 

Group Policy for computers is applied at computer startup and Group Policy for users is applied when users log on. Group Policy is also applied subsequently in the background periodically.


Product and feature changes introduced in the 2007 Office system

This article provides a summary of the product and feature changes that were introduced in the 2007 Microsoft Office system.

In this article:


File format

Security

User interface

Object model

Access 2007

Excel 2007

Outlook 2007

Word 2007, PowerPoint 2007, and OneNote 2007
File format

The 2007 Office system release introduced a default file format for Office Word 2007, Office Excel 2007, and Office PowerPoint 2007. The default format was changed to XML in response to customer requests. XML format provides the following benefits:


Enables more rapid document creation from different data sources


Enables easier data mining and content reuse


Reduces the size of Word, Excel, and PowerPoint files


Improves data recovery in corrupted files

Service Pack 2 (SP2) for the 2007 Office system also added support for the following:


OpenDocument Format (ODF). SP2 lets you open, edit, and save documents in version 1.1 of the ODF for Word, for Excel, and for PowerPoint. Users of these Office programs can now open, edit, and save files in the OpenDocument Text (*.odt), OpenDocument Spreadsheet (*.ods), and OpenDocument Presentations (*.odp) formats.

Group Policy settings and Office Customization Tool (OCT) settings were added for managing OpenDocument Format and Open XML Formats in the 2007 Office system. For more information, see Group Policy and Office Customization Tool settings that address OpenDocument Format and Open XML Formats in the 2007 Office system (http://go.microsoft.com/fwlink/?LinkId=158303).


Extensible File Formats: Word, Excel, and PowerPoint now include a converter interface that lets you plug third-party custom file formats into these Office programs. A developer can create a converter for files of a particular extension. When this converter is installed on a user’s computer, the custom file format effectively behaves like a built-in file format. Specifically, users can open files of this format and save them by using the Open or Save UI. They can even set the custom format as their default file format.


Built-in Save As PDF/XPS support was also added in SP2. PDF/XPS support is built into SP2 for Word, for Excel, and for PowerPoint. Users no longer have to download the add-in separately.

For more information about the file format changes that were introduced in the 2007 Office system, see File format reference for the 2007 Office system (http://go.microsoft.com/fwlink/?LinkId=155218).

Security

The Trust Center was introduced in the 2007 Office system, and hosts all security settings for Office applications in one location. The Trust Center also provides a document menu bar that replaces the security prompts when a file opens. By default, potentially dangerous content is blocked in the file without prompting. Therefore, there are no security decisions when the file opens. If content is blocked, the document menu bar appears and informs the user. Clicking the document menu bar displays a dialog box that has the disabled content and the options to enable or disable the content.

The Trust Center also has new security settings (previously Low, Medium, High, and Very High) that are more descriptive and provide more flexibility.

To learn about security features that were introduced in the 2007 Office system, see the resources in the Security and protection for the 2007 Office release (http://go.microsoft.com/fwlink/?LinkId=155221) section. 

User interface

Office Word 2007, Office Excel 2007, Office Access 2007, Office PowerPoint 2007, and Office Outlook 2007 introduced a new ribbon interface (Microsoft Office Fluent user interface) instead of the menu bar in previous versions. The ribbon is an area across the top of the screen that is divided into tabs. Commands are organized within each tab. This change greatly improves the user's ability to use and find features in the 2007 Office system. 

Most commands continue to work as before. There is minimal need to edit macros or application code due to the new ribbon interface. 

For more information about the Microsoft Office Fluent user interface introduced in the 2007 Office system, see the Microsoft Office Fluent User Interface Resource Center (http://go.microsoft.com/fwlink/?linkid=111045). In Office 2010, additional applications add the fluent UI. 

Object model

Because of improvements introduced in the 2007 Office system, there are differences in the object model. Because of these changes, you should test all applications to ensure they are compatible with the 2007 Office system. Some features of the object model were added, changed, or removed. In some instances, the functionality might still be available, but might be removed in future versions of Office. For more information about object model changes in 2007 Office system, see Differences in the 2007 Office system (http://go.microsoft.com/fwlink/?LinkId=155230). 

Access 2007

Office Access 2007 introduced a new file format. Whereas versions of Access earlier than Office Access 2007 used the MDB format, Office Access 2007 saves files in the new ACCDB format. One key feature of the ACCDB format is the ability to store complex data. Storing complex data requires the presence of a new system table, MSysFlattenedMapping, plus a series of built-in schema tables. The MSysFlattenedMapping table and the built-in schema tables are automatically created when a new ACCDB file is created. 

Excel 2007

In addition to the new user interface and file format changes, Office Excel 2007 introduced major changes in the following areas:


Grid size. The grid size for Office Excel 2007 worksheets was greatly expanded to 1,000,000 rows by 16,000 columns (compared to 65,536 rows by 256 columns in Office Excel 2003). This change could result in Range Names that conflict with the new references, and can also affect the ability to save a worksheet to an earlier version.


Formulas and functions. The Analysis ToolPak was integrated into Office Excel 2007 to improve the installation process. This required that calls to Analysis ToolPak functions are changed so that the syntax is the same as the syntax used for built-in functions. Also, some integrated functions might conflict with user-defined functions. Changes to statistical functions provide more precision. By using multi-threaded calculation, Office Excel 2007 provides increased performance when it runs on computers that have more than one logical processor. 


Charting. Charts created in Office PowerPoint 2007 or Office Word 2007 (not in compatibility mode) are native charts, not Microsoft Graph OLE objects. The data for a Graph in PowerPoint or Word is now in Office Excel 2007, instead of in the Graph datasheet. Macros written to use the Microsoft Graph object model must be changed. Existing macros continue to work in Office Excel 2007, but charts should transition to the new object model. 


Charting. Charts created in Office PowerPoint 2007 or Office Word 2007 (not in compatibility mode) are native charts, not Microsoft Graph OLE objects. The data for a Graph in PowerPoint or Word is now in Office Excel 2007, instead of in the Graph datasheet. Macros written to use the Microsoft Graph object model must be changed. Existing macros continue to work in Office Excel 2007, but charts should transition to the new object model. 

Outlook 2007

Office Outlook 2007 introduced improvements in the Calendar, Tasks, and other features. One of the biggest changes was that instead of using the Exchange Security Form (ESF), a custom form for administering Office Outlook 2007 security options when you are connected to a Microsoft Exchange Server mailbox, you use Group Policy. This changes the method that you use to lock down Office Outlook 2007 in a network environment. Some situations still require use of the ESF, because of Group Policy restrictions. For example, hosted Exchange situations still require using the ESF to lock down Office Outlook 2007. 

Word 2007, PowerPoint 2007, and OneNote 2007

Office Word 2007, Office PowerPoint 2007, and Office OneNote 2007 introduced changes as follows.


Word changes included: new XML file formats; new user interface, graphics, and formatting capabilities; improved proofing tools; new sharing and collaboration features; new security features; and improved troubleshooting and recovery features.


PowerPoint changes included: new XML file formats; new user interface, graphics, and formatting capabilities; improved proofing tools; new sharing and collaboration features; new security features; and improved troubleshooting and recovery features. 


OneNote changes included: Deleted Pages feature was removed; Show Ink Groups feature on the Tools menu was removed; and the title area in Microsoft Office OneNote 2007 was removed

For more information about feature changes that were introduced in the 2007 Office system, see Differences in the 2007 Office system (http://go.microsoft.com/fwlink/?LinkID=155230).

Technical diagrams for Office 2010

These resources are visual representations of recommended solutions. They include poster-sized documents available in formats including Microsoft Office Visio 2007 files (.vsd), PDF files, and XPS files. You might need extra software to view these files. See the following table for information about opening these files. 

	File type
	Software

	.vsd
	Office Visio 2007, or the free Visio viewer (http://go.microsoft.com/fwlink/?LinkId=118761&clcid=0x409)

If you use the Visio viewer, right-click the VSD link, click Save Target As, save the file to your computer, and then open the file from your computer.

	.pdf
	Any PDF viewer, such as Adobe Reader (http://go.microsoft.com/fwlink/?LinkId=134751&clcid=0x409)

	.xps
	Windows Vista, Windows XP with .NET Framework 3.0, or XPS Essentials Pack (http://go.microsoft.com/fwlink/?LinkId=134750&clcid=0x409)


Models

Models are 34-by-44-inch posters that detail a specific technical area. These models are intended to be used with corresponding articles on TechNet. These models are created by using Microsoft Visio 2010 or Office Visio 2007. You can modify the Visio files to illustrate how you plan to incorporate Microsoft Office 2010 in your own environment.

	Title
	Description

	Deployment Options for Microsoft Office 2010
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Download (http://go.microsoft.com/fwlink/?LinkID=168621)
	Describes and illustrates the client deployment methods for Office 2010. Deployment options include network share, Group Policy startup scripts, managed deployment, and virtualization. Use this model with the following article: Choose an option for deploying Office 2010 (http://technet.microsoft.com/library/e68bd7d9-afa2-45ab-8788-fc7c68e6efb5(Office.14).aspx).

	Deploy Multilanguage Packs for Microsoft Office 2010
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Download (http://go.microsoft.com/fwlink/?LinkID=168622)
	Describes and illustrates how to deploy multilanguage packs for Office 2010. Elements include evaluation criteria, planning considerations, and deployment tasks. Use this model with the following article: Plan for multilanguage deployment of Office 2010 (http://technet.microsoft.com/library/f458a0cb-a3a5-4d4a-9f98-a4a81a17ee3a(Office.14).aspx).

	64-bit Client Installation of Microsoft Office 2010
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Download (http://go.microsoft.com/fwlink/?LinkID=168620)
	Describes and illustrates the 64-bit client installation of Office 2010. Elements include setup overview, processes, requirements, deployment considerations, and supported scenarios. Use this model with the following article: 64-bit editions of Office 2010.

	Virtualization Overview - Architecture
[image: image15.png]



Download (http://go.microsoft.com/fwlink/?LinkID=168624)
	Describes and illustrates the architectural overview of virtualization technology and the different models that are possible. Use this model with the following article: Plan for virtualization for Office 2010 (http://technet.microsoft.com/library/75fe8f8b-e455-4c54-a516-8e6cce77664f(Office.14).aspx).

	Application Virtualization - Delivery Methods
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Download (http://go.microsoft.com/fwlink/?LinkID=168624)
	Describes and illustrates delivery methods of virtualization, focused on sequencing. Use this model with the following article: Plan for virtualization for Office 2010 (http://technet.microsoft.com/library/75fe8f8b-e455-4c54-a516-8e6cce77664f(Office.14).aspx).

	Application Virtualization for the Mobile User
[image: image17.png]



Download (http://go.microsoft.com/fwlink/?LinkID=168624)
	Describes and illustrates stand-alone delivery method of virtualized applications for mobile users. Use this model with the following article: Plan for virtualization for Office 2010 (http://technet.microsoft.com/library/75fe8f8b-e455-4c54-a516-8e6cce77664f(Office.14).aspx).

	Volume Activation of Microsoft Office 2010
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Download (http://go.microsoft.com/fwlink/?LinkID=188811)
	Describes the volume activation methods for Office 2010 and illustrates typical network scenarios. Use this model with the following article: Plan volume activation of Office 2010 (http://technet.microsoft.com/library/c6545579-4cca-4ad1-829d-cfecbb917dc4(Office.14).aspx).


Help and support for Office 2010

There are several support options for the Microsoft Office 2010 suites. This article describes some of the options that are available.

In this article:


Support options in the Backstage

Other support options
Support options in the Backstage

The Microsoft Office Backstage is new feature within the Fluent user interface (UI) throughout the Office 2010 suites. The Backstage view provides the following options for finding help:


Getting Started   Links to the Getting Started Web site, which helps users quickly learn Office 2010 applications.


Contact Us   A link to connect users to the Microsoft Help and Support Web Pages where you can find Product Solution Centers and Customer Service Solution Centers.

Other support options

Outside of the Backstage, you can still find help as it was in the previous versions. Other support options include the following:


F1   The standard help Function key still brings up the Microsoft Help and How-To within each product in the Office 2010 suites. This command can be easily added to the Quick Access Toolbar for quick reference.


Microsoft Download Center   You can download help and product updates from the Microsoft Download Center (http://go.microsoft.com/fwlink/?LinkID=162268).


Office 2010 Resource Centers   You can find information for IT administrators about Office 2010 on the Office 2010 resources page (http://go.microsoft.com/fwlink/?LinkId=167841). Specific resources include Evaluate and Get Started, Plan the Deployment, Configure and Deploy, Application Compatibility, Migration and Upgrade, Volume Activation and Licensing, Feature Changes, and System Requirements.

Assessing the compatibility of Office 2010

This section describes some of the tools and methods that are available to help you assess your current environment in preparation for the deployment of Microsoft Office 2010.

In this section:

	Article
	Description

	System requirements for Office 2010
	Describes the system requirements for the products in the Microsoft Office 2010 suites.

	Assessment tools for Office 2010
	Describes some of the tools that are available to help complete the assessment step in the planning process for deploying Office 2010.

	Application compatibility assessment and remediation for Office 2010
	Provides the primary resources for Office 2010 application compatibility information and includes links to the new application compatibility tools and documentation.

	Document compatibility assessment and remediation for Office 2010
	Provides the primary resources for Office 2010 document compatibility information and includes links to the new document compatibility tools and documentation, such as the Office Migration Planning Manager (OMPM).

	64-bit editions of Office 2010
	Provides information about 64-bit versions of Office 2010 products, including supported scenarios, deployment considerations, and an overview of the Setup process.


System requirements for Office 2010

This article describes the system requirements for the Microsoft Office 2010 suites. A hardware upgrade should not be necessary when you upgrade to Office 2010 from Microsoft Office 2003 or the 2007 Microsoft Office system. You might need to upgrade a supporting operating system. If you upgrade to Office 2010 from Microsoft Office 2000 or Microsoft Office XP, you must ensure that the hardware and operating system meet the minimum system requirements for the Office 2010 suites.
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Note


Office 2010 is supported for both 32-bit and 64-bit client applications.


We recommend that you install Microsoft Silverlight 3 along with Office 2010 to improve the online experience and to power the Office 2010 interactive guides.

In this article:


Microsoft Office Professional Plus 2010

Microsoft Office Home and Student 2010

Microsoft Office Home and Business 2010

Microsoft Access 2010

Microsoft Excel 2010

Microsoft InfoPath 2010

Microsoft OneNote 2010

Microsoft Outlook 2010

Microsoft PowerPoint 2010

Microsoft Project Professional 2010

Microsoft Publisher 2010

Microsoft SharePoint Workspace 2010

Microsoft Visio 2010 (Premium, Professional, Standard)

Microsoft Word 2010
When you choose the product suite or individual program to deploy in the environment, evaluate the computer prior to deployment to ensure it meets the minimum operating system requirements.

Microsoft Office Professional Plus 2010

The following table lists the system requirements for Microsoft Office Professional Plus 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher; 1 gigahertz (GHz) required for Outlook with Business Contact Manager

	Memory
	256 megabytes (MB) of RAM or higher; 512 MB recommended for graphics features, Outlook Instant Search, Outlook with Business Contact Manager, Communicator, and certain advanced functionality

	Hard disk
	3.5 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher-resolution monitor; 1024 × 576 or higher for Excel 2010, OneNote 2010, Outlook 2010, PowerPoint 2010, and Word 2010

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1 (32-bit or 64-bit), Windows Server 2003 R2 (32-bit or 64-bit) with MSXML 6.0 installed, Windows Server 2008 (32-bit or 64-bit), Windows 7 (32-bit or 64-bit). Terminal Server and Windows on Windows (WOW) (which allows installing 32-bit versions of Office 2010 on 64-bit operating systems) are supported

	Additional
	Requirements and product functionality can vary based on the system configuration and operating system. Use of graphics hardware acceleration requires DirectX 9.0c compatible graphics card with 64 MB or higher video memory.

	Other
	
Certain inking features require running Windows XP Table PC edition or later. Speech recognition functionality requires a close-talk microphone and audio output device. Information Rights Management features require access to a Windows Server 2003 with SP1 or later running Windows Rights Management Services.


Connectivity to Microsoft Exchange 2000 Server or later is required for certain advanced functionality in Office Outlook 2007. Instant Search requires Windows Desktop Search 3.0. Dynamic Calendars require server connectivity.


Connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality. Microsoft Office SharePoint Server 2007 is required for certain advanced functionality. PowerPoint Slide Library requires Office SharePoint Server 2007. To share data among multiple computers, the host computer must be running Windows Server 2003 with SP1, Windows XP Professional with SP2 or later.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply)


512 MB of RAM or higher recommended for Outlook Instant Search. Grammar and contextual spelling in Word 2010 is not turned on unless the computer has 1 GB memory.


Silverlight plug-in. See Get started with Microsoft Silverlight  (http://go.microsoft.com/fwlink/?LinkID=169372).


Microsoft Office Home and Student 2010

The following table lists the system requirements for Microsoft Office Professional Plus 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) of RAM or higher; 512 MB recommended for graphics features, Outlook Instant Search, Outlook with Business Contact Manager, Communicator, and certain advanced functionality

	Hard disk
	3 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher-resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1 (32-bit or 64-bit), Windows Server 2003 R2 (32-bit or 64-bit) with MSXML 6.0 installed, Windows Server 2008 (32-bit or 64-bit), Windows 7 (32-bit or 64-bit). Terminal Server and Windows on Windows (WOW) (which allows installing 32-bit versions of Office 2010 on 64-bit operating systems) are supported.

	Additional
	Requirements and product functionality can vary based on the system configuration and operating system. Use of graphics hardware acceleration requires DirectX 9.0c compatible graphics card with 64 MB or higher video memory.

	Other
	
Certain inking features require running Windows XP Table PC edition or later. Speech recognition functionality requires a close-talk microphone and audio output device. Information Rights Management features require access to a Windows Server 2003 with SP1 or later running Windows Rights Management Services.


Connectivity to Microsoft Exchange 2000 Server or later is required for certain advanced functionality in Office Outlook 2007. Instant Search requires Windows Desktop Search 3.0. Dynamic Calendars require server connectivity.


Connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality. Microsoft Office SharePoint Server 2007 is required for certain advanced functionality. PowerPoint Slide Library requires Office SharePoint Server 2007. To share data among multiple computers, the host computer must be running Windows Server 2003 with SP1, Windows XP Professional with SP2 or later.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply). Internet Explorer 7 or later required to receive broadcast presentations.


512 MB of RAM or higher recommended for Outlook Instant Search. Grammar and contextual spelling in Word 2010 is not turned on unless the computer has 1 GB memory.


Silverlight plug-in. See Get started with Microsoft Silverlight  (http://go.microsoft.com/fwlink/?LinkID=169372).


Microsoft Office Home and Business 2010

The following table lists the system requirements for Microsoft Office Professional Plus 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) of RAM; 512 MB recommended for graphics features and certain advanced functionality.

	Hard disk
	3 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher-resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1 (32-bit or 64-bit), Windows Server 2003 R2 (32-bit or 64-bit) with MSXML 6.0 installed, Windows Server 2008 (32-bit or 64-bit), Windows 7 (32-bit or 64-bit). Terminal Server and Windows on Windows (WOW) (which allows installing 32-bit versions of Office 2010 on 64-bit operating systems) are supported.

	Additional
	Requirements and product functionality can vary based on the system configuration and operating system. Use of graphics hardware acceleration requires DirectX 9.0c compatible graphics card with 64 MB or higher video memory.

	Other
	
Certain inking features require running Windows XP Table PC edition or later. Speech recognition functionality requires a close-talk microphone and audio output device. Information Rights Management features require access to a Windows Server 2003 with SP1 or later running Windows Rights Management Services.


Connectivity to Microsoft Exchange 2000 Server or later is required for certain advanced functionality in Office Outlook 2007. Instant Search requires Windows Desktop Search 3.0. Dynamic Calendars require server connectivity.


Connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality. Microsoft Office SharePoint Server 2007 is required for certain advanced functionality. PowerPoint Slide Library requires Office SharePoint Server 2007. To share data among multiple computers, the host computer must be running Windows Server 2003 with SP1, Windows XP Professional with SP2 or later.


Internet Explorer 6 or later, 32-bit browser only. Internet Explorer 7 or later required to receive broadcast presentations. Internet functionality requires Internet access (fees might apply)


512 MB of RAM or higher recommended for Outlook Instant Search. Grammar and contextual spelling in Word 2010 is not turned on unless the computer has 1 GB memory.


Silverlight plug-in. See Get started with Microsoft Silverlight  (http://go.microsoft.com/fwlink/?LinkID=169372).


Microsoft Access 2010

The following table lists the system requirements for Microsoft Access 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) of RAM or higher

	Hard disk
	2 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 (32-bit or 64-bit), Windows 7 or later operating systems.

	Other
	
Connectivity with Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality. Collecting data via e-mail requires Office Outlook 2007.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Importing data from Excel 2010 or Outlook 2010 requires Excel 2010 or Outlook 2010.


Integration with Business Connectivity Services requires Microsoft .NET Framework 3.5.


Product functionality and graphics can vary based on your system configuration. Some features can require additional or advanced hardware or server connectivity. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Microsoft Excel 2010

The following table lists the system requirements for Microsoft Excel 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) RAM or higher

	Hard disk
	2 gigabyte (GB) available disk space

	Display
	1024 × 576 or higher resolution monitor

Video card requirements: Pixel Shader 20 and Vertex Shader 2.0. Driver date later than Nov. 1, 2004. WHQL certified.

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit or 64-bit), Windows 7 or later operating systems.

	Other
	
Certain inking features require running Microsoft XP Tablet PC edition or later. Speech recognition functionality requires a close-talk microphone and audio output device. Information Rights Management features require access to a Windows Server 2003 with SP1 or later running Windows Rights Management Services.


Connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Connectivity to a compute cluster is required for running user-defined functions on a compute cluster.


Internet Fax is not available on Windows Vista Starter, Windows Vista Home Basic, or Windows Vista Home Premium.


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Microsoft InfoPath 2010

The following table lists the system requirements for Microsoft InfoPath 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) RAM or higher

	Hard disk
	2 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows 7 or later operating systems.

	Other
	
Email based collaboration requires Microsoft Outlook 2010.


Connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality. Outlook 2010 required for e-mail-based collaboration. Sending forms as e-mail message requires Outlook 2010. Conversions of Word documents require Word 2010. Conversion of Excel worksheet requires Excel 2010. Microsoft SharePoint Server 2010 required for browser-enabled InfoPath forms and additional collaboration functionality.


Internet Explorer 6 or later versions, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Internet Fax is not available on Windows Vista Starter, Windows Vista Home Basic, or Windows Vista Home Premium.


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Microsoft OneNote 2010

The following table lists the system requirements for Microsoft OneNote 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) RAM or higher

	Hard disk
	1.5 gigabyte (GB) available disk space

	Display
	1024 × 576 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit or 64-bit), Windows 7 or later operating system.

	Other
	
Some features require Windows Desktop Search 3.0, Windows Media Player 9.0, Microsoft Active Sync 4.1, microphone, audio output device, video recording device (such as a webcam), TWAIN-compatible digital camera or scanner. Sharing notebooks requires that users to be on the same network.


WDS 4 preferred, DirectX no longer needed, router with UPnP no longer needed, Windows Mobile no longer needed.


OneNote functionality works on both 32-bit and 64-bit.


Sharing notebooks requires that users to be on the same network.


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


For the OneNote print driver: Microsoft .NET Framework 3.0 or later, Windows XPS features installed on Windows Vista, Windows 7, Windows Server 2008,  Windows Server 2008 R2, XPS features installed before Office install on operating system.


1.2-gigahertz (GHz) processor or higher and 1 GB OF RAM or higher recommended for OneNote Audio Search. Close-talking microphone required. Audio Search not available in all languages.


Microsoft Outlook 2010

The following table lists the system requirements for Microsoft Outlook 2010, along with resources to help evaluate the applications and hardware that you might need to get the most out of Outlook 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	512 megabytes (MB) OF RAM recommended for accessing Outlook data files larger than 1GB.

	Hard disk
	2 gigabyte (GB) available disk space

	Display
	1024 × 576 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit and 64-bit), Windows 7 or later operating system.

	For integration with Microsoft Exchange Server 2010 (optional)
	For a list of some of the new Outlook 2010 features that are enabled with Microsoft Exchange Server 2010, see Changes in Outlook 2010 and What's New in Exchange Server 2010 (http://go.microsoft.com/fwlink/?linkId=164425).

Exchange 2010 System Requirements (http://go.microsoft.com/fwlink/?linkId=164426)

Learn more about Microsoft Exchange Server 2010 (http://go.microsoft.com/fwlink/?linkId=164427)

	For integration with Microsoft Communicator Server 2007 R2 (optional)
	For a list of some of the new Outlook 2010 features that are enabled with Microsoft Communicator 2007 R2, see Changes in Outlook 2010.

Supported Topologies and Infrastructure Requirements (http://go.microsoft.com/fwlink/?linkId=164429)

Learn more about Microsoft Office Communications Server 2007 R2 (http://go.microsoft.com/fwlink/?linkId=164430)

	Other
	
Microsoft Exchange Server 2003 is the earliest version for using Exchange Server with Outlook 2010.


Certain inking features require running Windows XP Tablet PC Edition or later; speech recognition functionality requires a close-talk microphone and audio output device; Information Rights Management features require access to a Windows Server 2003 with SP1 or later running Windows Rights Management Services.


Connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality. Connectivity to Office SharePoint Server 2007 is required for certain advanced functionality.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Grammar and contextual spelling in Outlook is not turned on unless the computer has 1 GB memory.


Microsoft PowerPoint 2010

The following table lists the system requirements for Microsoft PowerPoint 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) OF RAM or higher. When embedding video, 512 MB OF RAM is recommended.

	Hard disk
	1.5 gigabyte (GB) available disk space

	Display
	1024 × 576 or higher resolution monitor

Video card requirements: Pixel Shader 20 and Vertex Shader 2.0. Driver date later than Nov. 1, 2004. WHQL certified.

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit or 64-bit), Windows 7 or later operating systems.

	Other
	
Certain inking features require running Windows XP Table PC edition or later; speech recognition functionality requires a close-talk microphone and audio output device; Information Rights Management features require access to a Windows Server 2003 with SP1 or later running Windows Rights Management Services.


Connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services is required for certain advanced collaboration functionality. PowerPoint Slide Libraries require Office SharePoint Server 2007.


Internet Explorer 6, 32-bit browser only. Internet functionality required Internet access (fees might apply).


User of graphics hardware acceleration requires DirectX 9.0c compatible graphics card with drivers dated 11/1/2004 or greater.


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Internet Fax not available on 64-bit operating system.


Microsoft Project Professional 2010

The following table lists the system requirements for Microsoft Project Professional 2010.

	Component
	Requirement

	Computer and processor
	700-megahertz (MHz) processor or higher

	Memory
	512 megabytes (MB) RAM or higher

	Hard disk
	2 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit or 64-bit), Windows 7 or later operating systems.

	Other
	
Windows Server 2008 with SP2 (64-bit) or later running Microsoft SharePoint Server 2010 is required for certain advanced collaboration functionality. Office Outlook 2003 SP2 or later is required to use the Import Outlook Tasks feature. Visual Reports require Office Excel 2003 SP2 or later and Microsoft Office Visio Professional 2007 or later.


Microsoft Project Server 2010 is required for Enterprise Project, portfolio, and resource management capabilities. Microsoft Project Web App and Microsoft Exchange Server 2007 SP1 or later are required for importing tasks to the Outlook calendar or tasks list.


SharePoint Server 2010 (installed with Project Server 2010) is required for publishing projects and Windows Workflow Foundation. Microsoft .NET Framework version 3.5 is required for the Resource Substitution Wizard.


Internet Explorer 7 or later. Internet functionality requires Internet access (fees might apply).


To enable the feature that allows synchronizing Project 2010 with a SharePoint task list, you must install either Microsoft Access 2010 or Microsoft Visio 2010.


Before installing Project 2010 to use Visual Reports with Office 2010, you must install Office 2010, Visio 2010 and Microsoft SQL Server 2008 Analysis Services 10.0 OLE DB Provider (available as a free download from Microsoft SQL Server 2008 Feature Pack, October 2008 (http://go.microsoft.com/fwlink/?LinkID=110393).


Certain online functionality requires a Windows Live ™ ID.

Product functionality and graphics can vary based on your system configuration.

Some features might require additional or advanced hardware or server connectivity.


Microsoft Publisher 2010

The following table lists the system requirements for Microsoft Publisher 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) RAM or higher

	Hard disk
	1.5 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit or 64-bit), Windows 7 or later operating system.

	Other
	
Certain inking features require running Windows XP Tablet PC Edition or later; speech recognition functionality requires a close-talk microphone and audio output device.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Internet connectivity and a Windows Live ID, to share Templates and Building Blocks.


Microsoft SharePoint Workspace 2010

The following table lists the system requirements for Microsoft SharePoint Workspace 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) RAM or higher

	Hard disk
	1.5 gigabyte (GB) available disk space

	Display
	1024 × 576 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 (32-bit or 64-bit), Windows 7 or later operating systems.

	Other
	
Integration with SharePoint Services requires connectivity to Microsoft SharePoint Server 2010.


No support exists for downgrading or reverting to a previous version of an Office Groove 2007 account after starting the upgrade process.


Internet Explorer 7 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Each computer will need to be upgraded to SharePoint Workspace 2010 to run SharePoint Workspace accounts on multiple computers.


Microsoft Visio 2010 (Premium, Professional, Standard)

The following table lists the system requirements for Microsoft Visio Premium 2010, Microsoft Visio Professional 2010, and Microsoft Visio Standard 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) RAM, 512 MB RAM recommended for certain advanced functionality.

	Hard disk
	2 gigabyte (GB) available disk space

	Display
	1024 × 768 or higher resolution monitor

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit or 64-bit), Windows 7 or later operating (32-bit and 64-bit) systems.

	Other
	
Certain advanced collaboration functionality requires connectivity to Windows Server 2003 with SP1 or later running Windows SharePoint Services.


Multi-touch features require Windows 7 and a touch enabled device.


Certain inking features require running Microsoft XP Table PC edition or later.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Microsoft Word 2010

The following table lists the system requirements for Microsoft Word 2010.

	Component
	Requirement

	Computer and processor
	500-megahertz (MHz) processor or higher

	Memory
	256 megabytes (MB) RAM; 512 MB RAM recommended for certain advanced functionality.

	Hard disk
	2 gigabyte (GB) available disk space

	Display
	1024 × 576 or higher resolution monitor

Video card requirements: Pixel Shader 20 and Vertex Shader 2.0. Driver date later than Nov. 1, 2004. WHQL certified.

	Operating system
	Windows XP with Service Pack (SP) 3 (32-bit), Windows Vista with SP1, Windows Server 2003 R2 with MSXML 6.0, Windows Server 2008 with SP2 (32-bit or 64-bit), Windows 7 or later operating systems.

	Other
	
Certain inking features require running Windows XP Tablet PC edition or later; speech recognition functionality requires a close-talk microphone and audio output device.


Publications can be sent by using Office Outlook 2007, Outlook Express 6.0, or Windows Live Mail; recipients can view in a variety of e-mail clients and Web-based services.


Internet Explorer 6 or later, 32-bit browser only. Internet functionality requires Internet access (fees might apply).


Actual requirements and product functionality might vary based on the system configuration and operating system. See http://www.office.com/products (http://go.microsoft.com/fwlink/?LinkId=169378).


Co-authoring requires Microsoft SharePoint Foundation 2010 or SkyDrive, and might require more memory.


Grammar and contextual spelling in Word 2010 is not turned on unless the computer has 1 GB memory.


Assessment tools for Office 2010

This article describes some of the tools that are available to help complete the assessment step in a planning process.

Assessment tools

	Area
	Tool
	Description
	Resources

	Project assessment / business case
	Microsoft Rapid Economic Justification guide
	The Microsoft Rapid Economic Justification guide walks you step-by-step through the project assessment process in two to four weeks — from fiscal analysis to boardroom presentation. It includes tools, templates, and how-to information to help you make a compelling business case for an IT project.
	Microsoft Rapid Economic Justification guide (http://go.microsoft.com/fwlink/?LinkId=152858LinkId=152858)

	Hardware inventory / compatibility 
	Microsoft Assessment and Planning (MAP) Toolkit 
	The Microsoft Assessment and Planning (MAP) Toolkit is an inventory, assessment, and reporting tool that can securely run in small or large IT environments without requiring the installation of agent software on any computers or devices. 

The MAP Toolkit performs a detailed analysis of hardware and device compatibility for migration to the 2007 Microsoft Office system, Windows 7, Windows Server 2008, Windows Server 2008 R2, Microsoft Application Virtualization (App-V), Windows Vista, and more. The hardware assessment examines the installed hardware and determines whether migration is recommended. If it is not recommended, the reports tell you why it is not.

In addition, MAP has expanded its capabilities into assessment areas of Hyper-V server virtualization, desktop security, and Microsoft SQL Server 2008 migration.
	Microsoft Assessment and Planning (MAP) Toolkit for Microsoft Office 2007 (http://go.microsoft.com/fwlink/?LinkId=152859)

	Software inventory
	Microsoft Software Inventory Analyzer (MSIA)
	With the Microsoft Software Inventory Analyzer (MSIA), you can generate an inventory of core Microsoft products installed on a local computer, or throughout a network. 

The MSIA is built specifically to be a starting point to work with Microsoft Software Asset Management. To that end, MSIA works with networks that have 250 computers or fewer, and locates only Microsoft software.
	Microsoft Software Inventory Analyzer (http://go.microsoft.com/fwlink/?LinkId=152860) 

Microsoft Software Asset Management (http://go.microsoft.com/fwlink/?LinkId=152861)

	Office add-ins
	Office Environment Assessment Tool
	The Office Environment Assessment Tool (OEAT) is designed to help an organization determine the types of add-ins and the extent to which add-ins for Microsoft Office applications are used on users’ computers. OEAT collects and reports add-in information about Microsoft Office 2000 and later versions.
	Office Environment Assessment Tool (OEAT) user's guide for Office 2010


	User settings
	User State Migration Tool
	You can use Windows User State Migration Tool (USMT) 4.0 to migrate user files and settings during large deployments of Windows Vista and Windows 7 operating systems. USMT captures desktop and application settings, user accounts and users' files, and then migrates them to a new Windows installation. 

One component of the USMT is ScanState. ScanState scans the source computer, collects the files and settings and creates a store. ScanState does not modify the source computer. By default, ScanState compresses the files and stores them as an image file (USMT4.mig). 
	User State Migration Tool 4.0 User's Guide (http://go.microsoft.com/fwlink/?LinkId=152865)

	File / document management
	Office Migration Planning Manager (OMPM)
	The Office Migration Planning Manager (OMPM) checks for, and reports on, file properties to help you analyze an environment and determine any issues that you might experience when you convert from Office 97-Office 2003 file formats to the file formats for the 2007 Office system and Microsoft Office 2010 systems.

OMPM for Office 2010 supports two new types of scanning: macro scanning and x64 migration scanning. The macro scanner optionally scans any macros it encounters for migration concerns, reports any issues it finds in the database, and optionally inserts comments into the macros identifying the issue with links to possible resolutions. The x64 migration scanner scans macros, ActiveX controls, and other COM objects (such as add-ins) in Office files for incompatibilities (for example, declaring 4-byte pointers instead of 8-byte pointers).
	Office Migration Planning Manager (OMPM) for Office 2010

	Security
	Microsoft Security Assessment Tool 4.0
	Microsoft Security Assessment Tool (MSAT) 4.0 consists of more than 200 questions that cover infrastructure, applications, operations, and people. The questions, associated answers, and recommendations are derived from generally accepted best practices, standards such as ISO 17799 and NIST-800.x, and recommendations and prescriptive guidance from the Microsoft Trustworthy Computing Group and other external security sources.
	Microsoft Security Assessment Tool (http://go.microsoft.com/fwlink/?LinkId=152866)

	Security
	System Center Configuration Manager
	Microsoft System Center Configuration Manager 2007 can assess, deploy, and update servers, client computers, and devices — across physical, virtual, distributed, and mobile environments.

Client status reporting in System Center Configuration Manager 2007 R2 provides up-to-date information about the manageability of client computers in a System Center Configuration Manager 2007 hierarchy. A site administrator can use this information to identify individual client problems and to maintain a more accurate site database. The information can also help increase software distribution success rates.
	System Center Configuration Manager TechCenter (http://go.microsoft.com/fwlink/?LinkId=152867)

	Licensing
	Microsoft Volume Licensing
	Microsoft Volume Licensing provides many online reporting services and tools that you can use to track and manage your existing Microsoft software assets.
	Manage Your Volume Licenses (http://go.microsoft.com/fwlink/?LinkId=152868)

	Configurations
	Group Policy Management Console (GPMC)
	The Group Policy Management Console (GPMC) is the UI console to author and manage domain-based Group Policy objects (GPOs). The GPMC displays linking, permissions, and security filtering information relevant to a GPO. It also generates settings reports on a GPO in either HTML or XML format.
	Group Policy Management Console Technical Reference (http://go.microsoft.com/fwlink/?LinkId=152869) 

	Configurations
	View XML content from Office Customization Tool (OCT) customization files 
	See View XML content from Office Customization Tool customization files (http://go.microsoft.com/fwlink/?LinkId=169720) for a sample Microsoft Visual Basic script that administrators can use to view the settings that are stored in OCT .msp files.
	View XML content from Office Customization Tool customization files (http://go.microsoft.com/fwlink/?LinkId=169720)

	Help
	Microsoft Desktop Deployment Planning Services (DDPS)
	Microsoft Desktop Deployment Planning Services (DDPS) offers customers 1 to 15 days of deployment planning services, based on how much Microsoft Software Assurance they purchase on Office software. Customers work with consultants to develop a high-level desktop deployment plan for their environments and to assess the overall cost of upgrading to the latest versions of Windows and Office.
	Microsoft Volume Licensing Software Assurance(http://go.microsoft.com/fwlink/?LinkId=152871)

You can find a Desktop Deployment Planning Services provider in your area by using the Microsoft Solution Finder (http://go.microsoft.com/fwlink/?LinkId=152872).


Application compatibility assessment and remediation for Office 2010

This section provides the primary resources for Microsoft Office 2010 application compatibility information and includes links to the new application compatibility tools and documentation. These resources are especially useful for IT professionals who have to evaluate application compatibility issues and implement a plan for fixing incompatible Microsoft Office applications.

In this section:

	Article
	Description

	Application compatibility assessment and remediation guide for Office 2010
	Describes the application compatibility testing and remediation process for a deployment of Office 2010. This information is useful to IT professionals who will evaluate application compatibility issues and implement a plan for fixing incompatible applications.

	Office Environment Assessment Tool (OEAT) user's guide for Office 2010
	Contains information about how to use the Office Environment Assessment Tool (OEAT) to assess your existing environment before you deploy Office 2010.

	Microsoft Office Code Compatibility Inspector user's guide
	Describes how to use the tool to inspect VBA code that you created in previous versions of Microsoft Office and also how to use the tool to help you to make any Windows Application Programming Interface (API) calls in your code compatible with the 64-bit edition of Office 2010.


Application compatibility assessment and remediation guide for Office 2010

This article describes the application compatibility testing and remediation process for Microsoft Office 2010 deployments. This information is useful primarily to IT professionals who will evaluate application compatibility issues and implement a plan for fixing incompatible applications. Developers who are upgrading Office applications might also find this information useful. After completing the process described in this article, administrators and developers will have a better understanding of which add-ins and applications interact with Office and how to migrate them to Office 2010.

This article does not cover file compatibility, conversion, or migration. For information about how to convert legacy Office files to Office 2010, see Plan a migration and upgrade strategy for Office 2010 (http://technet.microsoft.com/library/757c1fda-2dbe-4cf3-8e21-49b07a95cc6c(Office.14).aspx) and Office Migration Planning Manager (OMPM) overview for Office 2010.

In this article:


Introduction to application compatibility in Office 2010

The application compatibility assessment and remediation process

Plan for compatibility testing

Assess the environment

Test and remediate compatibility issues
Introduction to application compatibility in Office 2010

Developers and expert users have been writing code to extend Office since the first Office products were introduced. As Office has evolved with feature changes, feature removals, and changes to file formats, so too has the likelihood that older add-ins and customizations might not work correctly when they are used with Office 2010. Not surprisingly, the topic of application compatibility can be challenging for organizations that have Office files dating back a decade or more. 

Office 2010 has many product improvements and other changes that might affect compatibility with existing files, macros, add-ins, and Microsoft Visual Studio solutions. The following list describes some of those changes.


Feature deprecations   Add-ins and applications can break when they have dependencies on features (and their corresponding object models) that are removed from Office 2010. 


Feature changes   Updated features and their object models can cause add-ins and applications not to operate as expected. Sometimes these changes are obvious, and other times they are only discovered after thorough testing.


64-bit incompatibilities   Office 2010 is available in both 32-bit and 64-bit versions. The 64-bit version is designed for users who need more memory capacity when they work with complex Microsoft Excel spreadsheets or Microsoft Project files. If you plan to deploy the 64-bit version of Office, you must consider that ActiveX controls, add-ins, and Microsoft Visual Basic for Applications (VBA) solutions created to work on 32-bit client computers might not work with the 64-bit versions of Office 2010. 

Several tools and solutions are available to assess and remediate application compatibility issues with Office 2010. For IT administrators, the new Office Environment Assessment Tool (OEAT) can help to identify add-ins and applications that interact with Office. Developers can perform additional testing by using the new Microsoft Office 2010 Code Compatibility Inspector tool to pinpoint potentially incompatible code within VBA projects or Visual Studio code. In cases where applications cannot be fixed, administrators can use solutions such as Remote Desktop Services (Terminal Services), parallel installations, and the new Microsoft Application Virtualization (App-V) to maintain the previous, compatible Office environment alongside Office 2010.

The following sections briefly describe the Office 2010 application compatibility assessment tools. 

Office Environment Assessment Tool (OEAT)   OEAT is a new scanning tool for Office 2010 that identifies add-ins that are installed on users’ computers. OEAT collects and reports add-in information for Microsoft Office 97, Microsoft Office 2000, Microsoft Office XP, Microsoft Office 2003, and the 2007 Microsoft Office system. OEAT also compares the list of discovered third-party add-ins to a list of compatible add-ins that is tracked by the Independent Software Vendor (ISV) Application Compatibility Visibility Program.

To download OEAT, see Office 2010 Tool: Office Environment Assessment Tool (http://go.microsoft.com/fwlink?linkid=171092).

ISV Application Compatibility Visibility Program   This new program tracks independent software vendors (ISVs) who pledge that their products are compatible with Office 2010. ISVs submit information about their products through a special ISV portal, and Microsoft publishes this list to the Compatibility for Microsoft Office 2010 Resource Center (http://go.microsoft.com/fwlink/?LinkId=186766). OEAT also uses this list to highlight known compatible add-ins in the summary report. 

To view the current list of ISVs that participate in this program, see Compatibility for Microsoft Office 2010 (http://go.microsoft.com/fwlink/?LinkId=186766).

Microsoft Office 2010 Code Compatibility Inspector (OCCI)   The Microsoft Office 2010 Code Compatibility Inspector compares existing VBA, Visual Basic .NET, and C# source code for object model API calls that are incompatible with Office 2010. The tool integrates with both Microsoft Visual Basic for Applications 7.0 (VBA 7) and Microsoft Visual Studio 2008 or Microsoft Visual Studio 2010 and includes a basic scanner. When an inspector tool finds code that is incompatible with Office 2010, the tool adds a comment to the code for the developer to reference and fix later. The inspector tool also scans code for Declare statements and references to DLLs used by ActiveX controls that need to be updated to be compatible with 64-bit Office 2010.

To download OCCI, see Office 2010 Tool: Compatibility Inspector (http://go.microsoft.com/fwlink?linkid=181874).

The following table describes the kinds of Office-based customizations that many organizations will encounter and the tool that is used to assess each customization. Because some of these customizations were common for earlier versions of Office, the links to additional information often point to developer documentation for Office 2003 and earlier.

	Type of customization
	Description
	Assessment tool

	Automation add-ins (.xll or .wll)
	Automation add-ins let developers incorporate an existing Office 2010 application’s functionality into custom applications. An example of an Office Automation add-in is a CRM application that writes customer’s billing data to a Microsoft Excel worksheet.

For more information about Automation add-ins, see Excel COM add-ins and Automation add-ins (http://go.microsoft.com/fwlink/?LinkId=186622).
	OEAT

	COM add-in (Windows .dll)
	Introduced as part of Microsoft Office 2000, COM add-ins let developers use the programming language and environment of their choice when they create Office-based solutions. After a COM add-in is written, it is then compiled as a .dll file. The .dll file can be loaded by one or more Office applications and can interact with Office object models. 

For more information about COM add-ins, see What Is a COM Add-in? (http://go.microsoft.com/fwlink/?LinkId=186623).
	OEAT

	Office 97–2003 format VBA add-ins  (.dot, .wll, .xla, .xll, .ppa)

Office 2007–2010 format VBA add-ins  (.dotm, .xlam, .ppam)
	VBA template add-ins are created by using Microsoft Visual Basic for Applications (VBA). 

For more information about VBA add-ins, see Getting Started with VBA in Office 2010 (http://go.microsoft.com/fwlink/?LinkId=186624). For clarification about the differences between Microsoft Word templates and add-ins, see Word Document Templates vs. Word Add-ins (Global Templates) (http://go.microsoft.com/fwlink/?LinkId=186625).
	OEAT and OCCI

	Office 2007–2010 format  VBA macro-enabled files (.docm, .xlsm, .pptm)
	These files contain VBA macro code but are not saved as add-ins. 

OEAT will detect macro-enabled Word and Excel files that are stored in the Startup folder or that are loaded as global templates. OEAT will not discover macro-enabled files that are stored in other locations, nor will OEAT discover macro-enabled PowerPoint files in any location.

For more information about macro-enabled files, see File formats supported in the 2007 Office system (http://go.microsoft.com/fwlink/?LinkId=186628).
	OEAT and OCCI 

	Office add-ins created by using Visual Studio
	Office add-ins created by using Visual Studio let organizations customize Office applications to add specific features that are needed for business processes.

Visual Studio supports two kinds of solutions that might be used in your organization: 


Document-level customizations   These customizations consist of an assembly that is associated with a single document, workbook, or template in Microsoft Word or Microsoft Excel. Features in document-level customizations are available only when the associated document is open. These customizations cannot make application-wide changes, such as displaying a new menu item or ribbon tab when any document is open.


Application-level add-ins   These add-ins consist of an assembly that is associated with an Office application. The add-in can call into the object model to automate and extend the application, and it can use any of the classes in the Microsoft .NET Framework.

OEAT can be used to detect application-level add-ins only. 

For more information about Office add-ins created by using Visual Studio, see Office Solutions Development Overview (http://go.microsoft.com/fwlink/?LinkId=188380).
	OEAT and OCCI


The application compatibility assessment and remediation process

The following figure shows a summary of the application compatibility assessment and remediation process. Each task defined in this figure has a corresponding section in this article. 
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Note: 

This guide does not cover file compatibility, conversion, or migration. For information about how to convert legacy Office files to Office 2010, see Plan a migration and upgrade strategy for Office 2010 (http://technet.microsoft.com/library/757c1fda-2dbe-4cf3-8e21-49b07a95cc6c(Office.14).aspx) and Office Migration Planning Manager (OMPM) overview for Office 2010.

Plan for compatibility testing

Planning for the assessment, remediation, and piloting of add-ins and applications is an important first step in the overall process of application compatibility testing. Although it might be tempting to rely on previous results of the 2007 Office system compatibility testing, we do not recommend this and it will only delay a successful deployment. 

Plan for assessment

The following sections describe planning tasks that will help you prepare to assess the add-ins and applications in your organization.

Create central repository for assessment documentation and results

To help manage the assessment and remediation process, we recommend that you build a central repository of discovered applications and their status. A solution such as Microsoft SharePoint Server 2010 can help keep all project members up-to-date and the project itself on track.

Identify stakeholders

Stakeholders are the people or groups who approve and allocate resources to the project. By identifying stakeholders early in the planning process, the application compatibility project team can communicate and validate the project deliverables to those that have a vested interest.

The following table describes the typical stakeholder roles in an application compatibility project.

	Role
	Responsibility

	Application Owner
	Ensures that the business process done by using the previous Office version continues uninterrupted after the upgrade.

	Project Sponsor
	Promotes the success of the Office upgrade and positive publicity within the organization.


Assign roles for the project participants

The following table describes possible roles and their respective responsibilities that have to be filled in an application compatibility project.

	Role
	Responsibility

	Project manager
	Ensures the overall flow of the project, and manages overall resources, metrics, and risks.

	Compatibility validation tester
	Follows the test plan and tests Office components for any potential incompatibility issues, including file format, macros, add-ins, or Office Automation. 

	 OEAT operator
	Understands and performs setup and configuration of OEAT.

	Remediation lead
	Performs the actions that resolve compatibility issues on Office customizations.

	Regression tester
	Ensures that the remediation performed on an Office object is successful. This role is often filled by the remediation lead.

	User acceptance tester
	Representative of an affected business unit who determines that the remediation of an application was successful and that it does not interfere with other customizations or actions. This should never be the person who performs the remediation or regression testing.

	Business analyst or owner
	Owns the code and documentation of the applications and add-ins that are critical to the business unit.

	Deployment group lead
	Owns and tracks the timeliness of the complete technical process. Might delegate some reporting or administration activities.

	Application packaging group
	Owns the Office 2010 installation package.

	Client (Desktop) team
	Owns the deployment of the Office 2010 package via the organization’s configuration management tool, such as Systems Center Configuration Manager (SCCM).

	Service desk
	Provides functional support of Office for the testers and, when the migration is complete, the users.


Identify and interview business units

The next step in assessment planning is to identify your departmental or business unit groupings and interview their representatives to understand how the current set of add-ins is fulfilling their business needs. Knowing the importance of each add-in, its purpose, why it was made, what it does, and who made it are all important in making an informed decision about how to remediate the add-in and correct issues as they are found. 

Some add-ins for Office applications might have been created informally within your organization. Therefore, you might need to do some investigative work to track down an owner and the original source code, if it still exists. 

You can use the following form as a template for an interview questionnaire.

	Application information

	Business unit

	Application name

	Application contact/owner

	AppID

	Version

	Priority

	Tier

	Office 2010 compatibility status if known (Pass, Fail)

	Compatibility issue description if available

	Number of users

	Office version used by the application (XP, 2003, 2007, 2010, and so on)

	Describe the kind of usage (for example, exports an Office document, add-in to Office application, and so on)

	Office suite components used by the application

	Word

	Excel

	Access

	PowerPoint

	Other

	Does this application use complex Office objects such as charts, PivotTable reports, or drawing art?

	Is this a data entry or front-end application? If yes, provide details.

	Which language(s) does the application support?


Identify client computers to scan

After you determine the different business units that need their client computers scanned, you can start the process of identifying a statistically relevant sampling of client computers for each business unit. Not every client computer in your organization needs to be scanned. However, in some cases (depending on the size of the organization), scanning the entire environment or an entire group or organizational unit (OU) might be less restrictive (or easier) than delineating separate client computers to participate. A statistically relevant sampling of no more than 20 percent should provide enough information to successfully assess and remediate the compatibility issues in your Office 2010 environment.
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Important: 

All client computers that run OEAT must have Microsoft .NET Framework 2.0 or later installed. For more information about OEAT requirements, see Office Environment Assessment Tool (OEAT) user's guide for Office 2010.

If your organization lacks an up-to-date client inventory, consider running the Microsoft Assessment and Planning (MAP) Toolkit to generate a client inventory and assess Office 2010 readiness. From this inventory, you can work with business group leaders to select a subset of client computers for assessment by using OEAT. For more information about the MAP Toolkit, see Microsoft Assessment and Planning Toolkit (http://go.microsoft.com/fwlink/?LinkId=149448).

Plan for remediation

The following sections will help you establish baseline criteria to classify and remediate incompatible applications. Coming to an agreement early in the planning process will help you avoid disagreements or other delays after the assessment and testing results are available.

Determine how applications will be classified and prioritized

Enterprises develop, deploy, and maintain a variety of Office-based applications and add-ins, all of which might have significantly different values to the organization. Therefore, it is important to organize applications into classes or tiers based on the value of the application to the business. A simple method is to classify an application as either mission-critical or not. Additional classifications to consider are as follows:


In-house and third-party applications


Departmental applications


Unmanaged solutions, such as templates, add-ins, and macros that are created by end-users


Number of users of the application


Use of the application by executives


Expected lifetime of the application

The following table describes how an organization might classify and prioritize different kinds of Office customizations. 

	Customization
	Mission critical
	Non-mission critical

	Automation add-ins 
	Proactive OEAT scan, test, and remediation
	React to user discovered

	COM add-ins
	Proactive OEAT scan, test, and remediation
	React to user discovered

	VBA add-ins
	Proactive OEAT and OCCI scan, test, and remediation
	React to user discovered


To further help prioritize mission-critical applications, you can classify them as Tier 1, Tier 2, or Tier 3. Sample classification guidance for each tier is as follows:


Tier 1: Mission Critical   Failure of mission-critical applications is damaging to business continuity or revenue of the organization. Any application that is used by executives should be considered mission-critical, regardless of the number of users or business priority of the application. This tier also includes applications that are used by more than 10 percent of the organization’s users.


Tier 2: Business Critical   These applications are business-critical or are used by 10 percent or more of the organization’s users. This tier can also include applications that are used by 1 to 10 percent of the organization’s users and be of any business priority. These are not mission-critical or revenue affecting applications. However, they could indirectly increase expenses or reduce revenues by affecting productivity.


Tier 3: Business Applications   These applications are not mission-critical and can affect as few as 10 employees or up to 1 percent of the organization. They are usually tools that help small tasks and that have a low impact on the business.

Identify remediation strategies

After you define criteria to classify applications, you should identify potential remediation strategies. Although the actual remediation work is difficult to plan, you can establish generic strategies that can guide the resolution of issues for each kind of customization. The following table provides suggested remediation strategies based on the kind of application and its expected lifetime.

	Type
	Potential strategy

	In-house application that has a limited lifetime
	Retire the application and find a new process.

	In-house application that has a long lifetime
	Rewrite or rework the code to fit the new object model.

	Third-party application that has a limited lifetime
	Retire the application and find a new process.

	Third-party application that has a long lifetime
	Contact the vendor for update or replacement.

	Application is not working
	Reinstall the application with a new directory structure or create a virtual environment for the application.


As you remediate the applications, you might find that their priority can change from your initial assessment. You should put a strict process in place for remediation assessments to only allow an application to move up in tier (but not down). For information about how Microsoft IT categorized and prioritized applications, see Deploying the 2007 Office System at Microsoft (http://go.microsoft.com/fwlink/?LinkId=178278).

Microsoft also has prescriptive information on TechNet about known issues that occur when you migrate Office customizations. For more information, see Product and feature changes in Office 2010. There are also Microsoft partners who have tools that help the remediation process.

Plan for piloting

The project team must consider how add-ins and applications will be piloted. Specifically, the team should identify the following:


Which users will participate in the pilot.


How users in the pilot will report issues.


Whether helpdesk employees will assist in the pilot and, if so, how they will be trained.


When the pilot will begin. For example, some organizations begin pilot testing early, during the planning phase, to obtain early feedback as they move through the process.

The following resources are available to help you plan for piloting. These resources are not specific to Office 2010 compatibility testing. However, many of the principles covered in these resources still apply.


Designing a Pilot Project (http://go.microsoft.com/fwlink/?LinkId=186680)


Microsoft Operations Framework: Conduct a Pilot Test (http://go.microsoft.com/fwlink/?LinkId=186683)


Understanding the Migration Process (http://go.microsoft.com/fwlink/?LinkId=186684)

Assess the environment

During the assessment phase, you collect an inventory of add-ins and applications by running OEAT against a statistically relevant subset of client computers. After you analyze the results and prioritize applications, you will be ready for the testing and remediation phase.

Run OEAT

OEAT can be run from a network share or distributed to users. OEAT scans client computers and then saves the results of the scans to a designated location, usually a network share. After the scans are completed, you can use OEAT to compile the results into a Microsoft Excel spreadsheet for use during the remediation process. 

Depending on your environment, you can deploy OEAT in one of the following ways:


Active Directory environments   Deploy OEAT by using an Active Directory Login script. As users log in, OEAT is executed automatically and the results are saved to the designated location.


Managed environments   Deploy OEAT by using a management solution such as Systems Management Server (SMS) or System Center Configuration Manager (SCCM).


Unmanaged or non-centralized IT environments   Create a share for OEAT and provide instructions to users on how to manually run a scan. 

For information about how to deploy and use OEAT, see Office Environment Assessment Tool (OEAT) user's guide for Office 2010. To download OEAT, see Office 2010 Tool: Office Environment Assessment Tool (http://go.microsoft.com/fwlink?linkid=171092).

Review OEAT results

When the client computer scans are complete, use the Compile results option in OEAT to create a spreadsheet that summarizes the results of all client computers that were scanned. The spreadsheet contains multiple worksheets, including the following:


SummaryReport   This worksheet contains summary information that will help you determine whether your scanned client computers are ready for Office 2010. The worksheet includes data on average free space, processors, computer manufacturers, Windows installations (including service pack levels), Office installations, and antivirus information (current state). The resulting data could be interesting from a configuration management perspective in that client computers might not be running the versions of Office or Windows that you expect. 


MicrosoftOfficeAddins   This worksheet contains a list of all add-ins that are included with Office. 


AddinsNotShippedWithOffice   This worksheet contains a list of all add-ins that are not included with Office. Much of your assessment and planning will come from this report. You can sort the list by application, view the last accessed or modified dates, and view the number of client computers on which the add-in was detected. You can also compare version numbers of the same add-ins to determine whether some subsets of the client computers are out-of-date, which could indicate an issue with configuration management processes in your organization.

On the AddinsNotShippedWithOffice worksheet, start with the Compatibility column to see the compatibility status of each add-in. OEAT generates the data for this column by comparing the discovered add-ins with the list of compatible add-ins that are tracked by the ISV Compatibility Program. The possible compatibility status results are as follows:


UNKNOWN   The add-in is currently not in the Microsoft vendor list of Office 2010-compatible add-ins. Therefore, the status of this add-in is unknown. Note that this status could change as new vendor data is made available to OEAT. Each time that you compile the spreadsheet, you have the option to download new vendor data.


YELLOW   The add-in has the same company name and product name as an add-in on the compatible list, but the version numbers do not match. Contact the ISV for an updated version.


GREEN   The add-in is on the list of vendor add-ins that are compatible with Office 2010.

Finalize remediation plans

At this point, you are ready to correlate OEAT results with the prioritization criteria that you established during the planning phase. When you set a schedule for this work, make sure that you allow additional time to investigate and prioritize add-ins that were not identified during the business unit interviews. To understand the scope of incompatibilities of VBA add-ins and Visual Studio add-ins, the development team can run OCCI during this phase to understand how much of the underlying code will need to be changed.

Test and remediate compatibility issues

During this phase, you and your development team will start to test mission-critical and other high-priority add-ins and applications to find specific compatibility issues with Office 2010. After the incompatibilities are identified, the development team will begin remediating incompatible add-ins and applications based on the work that you did in the planning phase. 

As multiple applications and add-ins are remediated, you cannot assume that these remediations will function together. You have to test all remediations together and then pilot these in a real-world scenario. Each step is important in validating the remediations, stabilizing the overall deployment of Office 2010, and ultimately creating a more successful migration.

Test add-ins and applications

The following flowcharts provide general guidance for developers who are testing different kinds of applications to identify incompatibilities with Office 2010. For additional guidance, see the following resources: 


Planning and Testing for Application Deployment (http://go.microsoft.com/fwlink/?LinkId=186685)


LOB Application Compatibility Using Microsoft IT’s LOB Application Compatibility Testing Processes (http://go.microsoft.com/fwlink/?LinkId=186686)

General application testing

The following flowchart provides a high-level view of application testing. Subsequent flowcharts in this section describe the testing process for specific kinds of Office applications, such as add-ins, macros and scripts, and Office Automation testing. 
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Office add-in testing
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Macros and scripts testing
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Office Automation testing
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Run Office Code Compatibility Inspector tool

As part of the overall testing process, developers can run the OCCI tool to scan for known changes or deprecations to object model members. OCCI also scans VBA Declare statements and references to DLLs used by ActiveX controls that need to be updated to be compatible with 64-bit Office 2010. When the tool encounters potential compatibility issues, it adds a comment in the code to bring the issue to the developer’s attention.

Each time that an Inspector scan is complete, a summary and detailed report of what was found in the project is provided. Items that are scanned include the following:


Changes   Any syntactical change to an object model member is flagged. OCCI detects usage of any object model member that has changed since Office 97.


Deprecations   Any usage of a deprecated object model member is flagged. OCCI detects usage of any object model member that has been deprecated since Office 97.

For more information about how to use OCCI, see Microsoft Office Code Compatibility Inspector user's guide.

Remediate add-ins and applications

There are several approaches to correct an application or add-in that has a compatibility issue with Office 2010. The following sections briefly describe remediation options.

Get updates from vendors

OEAT reports provide links to add-ins known to be compatible. However, some applications might not be on this list. In this case, you have to contact the vendor directly. Be prepared to develop temporary workarounds if the updated add-in will not be available in time for your migration, or if the add-in will not be updated (or the vendor is no longer in business). If a temporary workaround is not available, consider virtualization or a parallel installation.

Update internal applications

When you have the source code and understand how the add-in or application functions, or you have documentation and the original development team is still active or can be consulted, you have an ideal situation to update an internal application. The process of updating internal applications is greatly simplified with the use of OCCI, which identifies incompatible functions within the source code. The development team will still need to perform the necessary fixes themselves. However, they will have a much easier time locating the incompatible code by using OCCI.
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Note: 

If the platform for writing the internal application is very old (such as Visual Basic 6, or earlier versions), we recommend that you consider a complete rewrite of the tool by using the .NET Framework.

The following guidance is useful for developers who need to update internal applications.

Add-ins created by using Visual Studio

The runtime components for Office 2010 were created so that Microsoft Visual Studio Tools for Applications (VSTA) and Visual Studio 2008 .NET add-ins, document solutions, and spreadsheet solutions will all run on 64-bit Office 2010. These runtime components are installed with Office 2010. Therefore, an administrator does not have to include a separate installation for this runtime. However, there are other considerations that are needed.

In a Visual Studio project, C# or Visual Basic code can be compiled into Microsoft Intermediate language (MSIL) when the Any CPU option is used. At runtime, the MSIL is Just in Time (JIT) compiled to the correct chip set, either AMD or Intel 32-bit or 64-bit. However, this technology does not apply to the .NET Framework in versions 1.0 and 1.1. These versions do not enable this 64-bit transformation.

Even conforming .NET Framework 2.0 code must be reviewed because any calls to a process invoke (p/invoke) in your code are native (processor architecture specific). If you try to call native API methods by using p/invoke, you can have issues with your VSTO solution running correctly on 64-bit Office 2010. 

Issues can also occur if the code makes deliberate calls to a Win32 API that does not have exactly the same signature (method name, parameter list, and DLL name) of an equivalent Win64 API. This is true for any solution, whether it is an Office solution or Windows-based solution. 

For more information about how to author solutions for 64-bit Office 2010, see 64-bit Applications for Visual Studio 2005 (http://go.microsoft.com/fwlink/?LinkId=178279) and 64-bit Applications for Visual Studio 2010 (http://go.microsoft.com/fwlink/?LinkId=152431) in the MSDN technical library.

VBA solutions and macros

Solutions and macros that are created by using Visual Basic for Applications (VBA) will function as long as they interface with the Office 2010 object model. However, certain calls might be deprecated and will no longer function. If VBA code uses Windows API calls, these calls are likely to 32-bit DLLs. A simple fix is to update the code so that the Declare statements use the PtrSafe keyword. OCCI can be used to identify these Declare statements. For more information about VBA 64-bit compatibility, see Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=186639).

ActiveX controls

ActiveX controls that are native 32-bit controls (which are likely to be any controls that are compatible with the 2007 Office system and previous Office versions) are not supported in 64-bit Office 2010. Remediation for any of these controls will require a recompile (if the source code is available), asking or waiting for a vendor update, or using a virtualization method. Again, for more information about VBA 64-bit compatibility, see Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=186639).

Use parallel installations or virtualization

When there is no practical recode or rewrite solution, there are additional options that can assist you in finding a solution to a compatibility issue. 


If you are waiting for vendor updates for an add-in that might be delivered at some date past your deployment date, you can opt to install Office 2003 or earlier in parallel with Office 2010 (or just the specific applications that are waiting for vendor updates, for example, such as Office Excel 2003).
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Note: 

If you are moving to a 64-bit version of Office 2010, you cannot have a parallel installation of the 2007 Office system (or earlier version) installed at the same time. All previous versions are available only in 32-bit versions.


If you are running Windows 7, you can install a parallel installation of Office 2003 (or earlier) in Windows XP compatibility mode, or if you are on an older version of Office, you can install it in a virtual computing environment.


Use App-V (formally known as SoftGrid). For more information about App-V, see Microsoft Application Virtualization 4.6  (http://go.microsoft.com/fwlink/?LinkId=143973).


Use Windows Terminal Services and perform one of two options:


If you have Windows Server 2003, you can use Windows Terminal Services to provide desktop computers that can run these solutions remotely with an earlier version of Office. 


 If you have Windows Server 2008, you can install RemoteApp. This will give users the feeling of the legacy application and the legacy version of Office on their client computers. For more information about RemoteApp, see Deploy Windows Server 2008 Terminal Services RemoteApp (http://go.microsoft.com/fwlink/?LinkId=178280).

Pilot remediated add-ins and applications

Conducting the pilot is the last major step before deployment of Office 2010. The pilot is the ultimate proving ground for the remediated options, and it should be part of the project team’s role to remain involved throughout the piloting of Office 2010 to capture and correct any problems that occur. During the pilot, your release management team monitors a controlled environment in which users perform their typical business tasks by using the new features, including remediated applications and add-ins that interact with Office 2010. This demonstrates that the remediations function as expected and that the organization’s business requirements are met.

As issues are reported in the pilot, an iterative approach should be taken to remediate the problems found, design a new test case, perform tests, and then deploy the updated applications back into the pilot for additional review. Specific focus should be given to how well these options work, user feedback, and any issues that limit the scope or functionality of the add-in or application that was remediated. 

For more information about how to stabilize and pilot applications, see Stabilize Service Management Function (http://go.microsoft.com/fwlink/?LinkId=115624) in Microsoft Operations Framework 4.0 in the TechNet technical library.

See Also
Compatibility for Microsoft Office 2010 Resource Center on TechNet (http://go.microsoft.com/fwlink/?LinkId=186766)
Office Environment Assessment Tool (OEAT) user's guide for Office 2010
Microsoft Office Code Compatibility Inspector user's guide
Upgrading Solutions to Office 2010 with Application Compatibility Tools and Guidance (MSDN) (http://go.microsoft.com/fwlink/?LinkId=178588)
Office 2010 Development Resources by Application (MSDN) (http://go.microsoft.com/fwlink/?LinkId=187499)
Send feedback about the Office 2010 compatibility tools
Office Environment Assessment Tool (OEAT) user's guide for Office 2010

This article is the user’s guide for the Office Environment Assessment Tool (OEAT). Before you use this guide, we recommend that you perform the planning steps described in Application compatibility assessment and remediation guide for Office 2010 and that you are ready to run OEAT to scan your organization’s client computers for add-ins and applications that interact with Microsoft Office.

To download OEAT, see Office 2010 Tool: Office Environment Assessment Tool (http://go.microsoft.com/fwlink?linkid=171092).

In this article:


About OEAT

OEAT requirements

Deploying OEAT

Working with OEAT data

Troubleshooting OEAT errors

Appendix
About OEAT

OEAT is a free downloadable executable (.exe) file that scans client computers for add-ins and applications that interact with Microsoft Office 97, Microsoft Office 2000, Microsoft Office XP, Microsoft Office 2003, the 2007 Microsoft Office system, and Microsoft Office 2010. You use OEAT during the assessment phase of your application compatibility and remediation project, which is described detail in Application compatibility assessment and remediation guide for Office 2010. The following figure shows how OEAT fits into the overall process of assessing application compatibility.
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OEAT detects add-ins and applications by using the following two methods:


OEAT checks a predetermined list of folders on each client computer for the presence of add-in file name extensions that are used for Microsoft Word, Microsoft Excel, and Microsoft PowerPoint. The add-in types include Automation add-ins, COM add-ins, VBA add-ins, and application-level add-ins created by using Visual Studio. 


Optionally, OEAT runs a passive scan against client computers to monitor for applications that call Office APIs. The passive scan works by enabling auditing on certain registry keys (over a configurable period of hours or days) that are used when Office APIs are called. Based on this auditing, OEAT can determine which applications are calling Office APIs. This includes each executable name and version, and the date and time that the executable was run. When the auditing period is complete, OEAT disables auditing on the registry keys.

You can customize how OEAT runs by using a built-in wizard to generate a settings file (Settings.xml). The options include whether to run a passive scan, whether to scan the client computer silently (with no user interaction), and the UNC path or local path where the scan results are saved. You deploy Settings.xml together with OEAT.exe, either in a central shared folder or deployed to individual client computers by using products such as Microsoft Systems Management Server (SMS) or Microsoft System Center Configuration Manager. You can also deploy an execution script (based on sample that is provided later in this article) to automate invoking the command-line version of OEAT from each client computer.

For each client computer that is scanned, OEAT generates a uniquely named .xml file that contains details about add-ins and applications that are detected, and also system information about each client computer, such as drive space, memory, and the versions of Office and Windows that are installed. OEAT can save each .xml file to a central shared folder, or you can use System Center Configuration Manager to collect .xml files saved on each client computer. 

When all client scans are complete, you can use a function within OEAT to compile the .xml scan results for each client computer into an Microsoft Excel spreadsheet. As part of this compilation, OEAT can compare the discovered add-ins and applications against the list of compatible add-ins that are tracked by the Microsoft Independent Software Vendor (ISV) Application Compatibility Visibility Program. You can then use the resulting spreadsheet to analyze and prioritize add-ins and applications for testing and remediation.

OEAT requirements

This section describes the requirements for running OEAT for scanning client computers and for managing the resulting data.

Requirements for scanning client computers

All client computers that run OEAT must have Microsoft .NET Framework 2.0 or a later version installed. In addition, each user account that runs OEAT must meet the following requirements:


If a user runs OEAT from the network, the user’s account must have the following permissions on the shared folder where OEAT.exe is stored: 


NTFS permissions   Read, Execute, and Write


Shared folder permissions   Change and Read


If you configure Settings.xml to enable passive scanning, each user account that runs OEAT must be a member of the Administrators group on the local computer. This membership is required so that the user’s account has permissions to enable auditing on registry keys for Word, PowerPoint, Excel, and Microsoft Outlook CLSID Automation keys. There are two workarounds available if you want to run passive scanning on client computers where users are not local administrators. For more information about these workarounds, see Troubleshooting OEAT errors later in this article. 

Requirements for managing OEAT

Administrators run OEAT to configure the Settings.xml file and to compile scan results. The computer from which you run OEAT for management purposes must meet the following requirements: 


The computer must have access to the Internet to download the latest compatibility data from the ISV Application Compatibility Visibility Program.


The following software must be installed on the computer:


Microsoft .NET Framework 2.0 or a later version


2007 Office system or Office 2010 (for compiling scan results into an Excel spreadsheet)

Deploying OEAT

This section describes the tasks that you perform when you deploy OEAT. The following flowchart shows the tasks in the process. Each task corresponds to a heading in this article. 
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Choose a deployment method

The Application compatibility assessment and remediation guide for Office 2010 provides guidance for choosing which client computers to scan. A statistically relevant sample of 20 percent of client computers in each business unit should be sufficient. As you choose which client computers to scan, you must consider whether you have a managed environment and whether you want OEAT to run locally on each client computer or over the network. Organizations will typically choose among one of the following deployment methods:


Managed deployment   Use System Center Configuration Manager or Systems Management Server to distribute OEAT.exe and its related files to each client computer. OEAT should be executed from the Startup folder or the Windows Run registry key. Configure Settings.xml to configure OEAT to save the scan results on each client computer and then use System Center Configuration Manager or Systems Management Server to collect all scan results and place them in a single folder.


Group Policy deployment   Use Group Policy to deploy OEAT.exe and its related files to each client computer. If you do not have a managed process for collecting the scan results, configure the settings file to save the scan results to a shared folder.


Unmanaged deployment   Copy OEAT.exe and its related files to a shared folder and provide instructions to users for running OEAT. For example, you can e-mail a link to a script that launches the command-line version of OEAT, or you can provide step-by-step instructions that describe how to launch the OEAT user interface and run the scan. Configure Settings.xml to save the scan results in a shared folder, or instruct users to e-mail the scan results. 
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Important: 

You can perform a passive scan only if you provide a script or instructions for launching OEAT from the command line. Running a scan by using the OEAT user interface will not invoke a passive scan, even if you configured OEAT to run a passive scan in the settings file (Settings.xml). The command-line parameters for OEAT are available in OEAT command-line parameters later in this article.

Create the OEAT settings file

After you download OEAT (http://go.microsoft.com/fwlink?linkid=171092), you can customize how OEAT runs by creating a settings file that specifies options such as passive scanning and the location (local or shared folder) where the results files are stored. You can create the settings file by using a wizard that is launched from the OEAT user interface. When you complete the wizard, OEAT creates the settings file (Settings.xml) in the same folder as OEAT.exe. Running the settings wizard is optional. However, if you do run the wizard and create a settings file, make sure that you distribute Settings.xml together with OEAT.exe.
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To configure OEAT settings

	1.
Double-click OEAT.exe. The OEAT user interface appears.
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2.
In the Run the settings file wizard section, click the Run wizard button.

3.
On the Welcome to the OEAT - Setup Wizard page, click Next.

4.
On the Environment Scanning Information page, click each more information link to view a list of the items that are scanned on each computer. To continue, click Next.

5.
On the Passive Scan Settings page, perform the following tasks: 

a.
Select Yes to perform a passive scan, if you want, and then specify the length of time that auditing will be enabled on registry keys used by Office API calls. 
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b.
Select the Run hidden (silent) on the client while scanning check box if you want the scan to run in the background without user interaction. Click Next.

6.
In the Results Folder Location page, type the local path, mapped drive, or UNC of the share to which scan results will be saved. For example: \\server name\share name\results. Click Next.

7.
On the Finished page, click Finish.

8.
Verify that Settings.xml was created in the same folder as OEAT.exe.


Create the OEAT execution script

To automate the scans performed by OEAT, you can create a script that executes OEAT.exe from the command-line and saves the script in the folder that contains OEAT.exe. In the script sample that follows, make sure that you replace <server> and <share> with the server and shared folder that contains OEAT.exe. You can distribute the script to designated users as a logon script or by another method. Regardless of how you distribute the script, it must run with administrative rights on the local computer. 

The following is a JScript code sample that you can edit to use in your environment.

// ***************************************************************

// Office Environment Assessment Tool Script

// CREATED: 8-14-2009

// VERSION:1.0

// PURPOSE:To launch the OEAT application from specified 

//              UNC share with the SCAN switch.

// ***************************************************************

/* create a scripting object */

w =  new ActiveXObject("WScript.Shell");

/* shell the OEAT.exe scanner */

w.run("\\\\<server>\\<share>\\oeat.exe -scan");

/* done */

Deploy OEAT and collect the scan results

Deploy OEAT by using the method that you chose in Choose a deployment method earlier in this article. If you chose passive scanning, make sure that you wait until the auditing period has passed before you try to collect or compile the scan results. 

Compile the scan results

After the scan results are collected in a central folder, use the following procedure to compile OEAT scan results into an Excel spreadsheet. This procedure assumes that the scans results from all client computers are located in the same folder as OEAT.exe.
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To compile scan results

	1.
Navigate to the folder that contains the scan results and the OEAT.exe file.

2.
Double-click OEAT.exe. 

3.
On the Welcome to the Office Environment Assessment Tool page, click Compile results.

A message box prompts you to choose whether to download the latest vendor list. Click Yes to download the vendor list. 

4.
A window opens with a progress bar that shows the progress of the compilation. The file OEAT Report.xlsx is automatically launched in Excel when the compilation is completed. 


Working with OEAT data

This section describes the contents of the OEAT report and provides some examples of how you can best use the results data. 

OEAT report overview

The compiled Excel file contains multiple worksheets, including the following:


SummaryReport   This worksheet contains summary information that will help you determine whether your scanned client computers are ready for Office 2010. The worksheet includes data on average free space, processors, computer manufacturers, Windows installations (including service pack levels), Office installations, and antivirus information (current state). The resulting data could be interesting from a configuration management perspective in that client computers might not be running the versions of Office or Windows that you expect. 


MicrosoftOfficeAddins   This worksheet contains a list of all add-ins that are installed with Office. 


AddinsNotShippedWithOffice   This worksheet contains a list of all add-ins that are not included with Office. Much of your assessment and planning will come from this report. You can sort the list by application, view the last accessed or modified dates, and view the number of client computers on which the add-in was detected. You can also compare version numbers of the same add-ins to determine whether some subsets of the client computers are out-of-date, which could indicate an issue with configuration management processes in your organization.

On the AddinsNotShippedWithOffice worksheet, start with the Compatibility column to see the compatibility status of each add-in. OEAT generates the data for this column by comparing the discovered add-ins with the list of compatible add-ins that are tracked by the ISV Compatibility Program. The possible compatibility status results are as follows:


UNKNOWN   The add-in is currently not in the Microsoft vendor list of Office 2010-compatible add-ins. Therefore, the status of this add-in is unknown. Note that this status could change as new vendor data is made available to OEAT. Each time that you compile the spreadsheet, you have the option to download new vendor data.


YELLOW   The add-in has the same company name and product name as an add-in on the compatible list, but the version numbers do not match. Contact the ISV for an updated version.


GREEN   The add-in is on the list of vendor add-ins that are compatible with Office 2010.

View top 10 add-ins

The MicrosoftOfficeAddins and AddinsNotShippedWithOffice tabs contain a count column that displays the number of times each add-in or application is detected. You can filter this list to show the top 10 add-ins and applications by using the following method:

1.
On the MicrosoftOfficeAddins or AddinsNoShippedWithOffice tab, in the count column heading, click the down arrow.

2.
Point to Number Filters, and then click Top 10. Adjust the AutoFilter if you want, and then click OK.

Organize results by application

Although you might want to study possible compatibility issues for each application in Office, at first you can focus on only one application. You can select to view the data from one Office application — such as Excel in the app column — and get a list of only the add-ins and applications that interface with Excel.

View unknown add-ins

After you have filtered the list by application and by the top 10, you can again filter the list of applications that are UNKNOWN or YELLOW in the compatibility column. By using filters again, you can also remove from the list all add-ins that are already known to be compatible with Office 2010.

Check for inconsistencies in configuration management

After you have compiled a list of add-ins per application that are not specifically known to work with Office 2010, you can then order the list from most to least common and are the top 10 of concern. From this point, you can perform the following steps:

Study the version information   From the items reviewed, check the version of the add-ins or applications. Do you already have the most recent version supported by the vendor? Is the application fully deployed? Can you contact the vendor to verify the latest version?

Note the last access date   Determine if an add-in or application was used in your environment recently. If it has an old access date, you can check the systems that report that particular add-in in the RawData worksheet to see whether it is used by current users.

Use the Load column   The Load column lets you know if the add-in is loaded when Office runs. OEAT notes this behavior as follows:


(0) Not loaded


(1) Loaded at next startup only


(2) Loaded on demand


(3) Loaded at startup

Create PivotChart and PivotTable reports

There other opportunities for displaying the data by using PivotChart reports or highlighting specific information by using PivotTable reports. For more information about Excel PivotChart and PivotTable reports, see Overview of Excel charts (http://go.microsoft.com/fwlink/?LinkId=178194) and Overview of PivotTable reports (http://go.microsoft.com/fwlink/?LinkId=178195).

Troubleshooting OEAT errors

This section helps you troubleshoot issues that you might encounter when you use OEAT. 

Passive scanning fails

If a user who is not a local administrator attempts to run a passive scan, a series of errors are written to an error file (errors.log) in the same folder as OEAT.exe. The errors in the log are as follows: 

... SCAN: Error setting permissions on registry keys. PERMISSION ERROR: System.UnauthorizedAccessException: Attempted to perform an unauthorized operation. … at OfficeAddinScanner.clsWatcher.addAudits()
If you need to run a passive scan against client computers without the user being a local administrator, you can perform the following workarounds:


Create a Group Policy object (GPO) that sets Change permissions for the user on the following audit keys. 


Excel = HKEY_CLASSES_ROOT\CLSID\{00024500-0000-0000-C000-000000000046}

PowerPoint = HKEY_CLASSES_ROOT\CLSID\{91493441-5A91-11CF-8700-00AA0060263B}

Word = HKEY_CLASSES_ROOT\CLSID\{000209FF-0000-0000-C000-000000000046}

Outlook = HKEY_CLASSES_ROOT\CLSID\{0006F03A-0000-0000-C000-000000000046}
For more information about how to set audit key values by using a GPO, see How to use Group Policy to audit registry keys in Windows Server 2003 (http://go.microsoft.com/fwlink/?LinkId=178196).


Deploy OEAT to run under the Local System account on each client computer by using a management solution such as Systems Management Server or System Center Configuration Manager. Configure the tool to run from the Startup folder or Windows Run registry key, and then collect the scan results file from each client computer. 

You receive the error “Old format or invalid type library” when you compile OEAT scan results

This error occurs when you are compiling OEAT scan results from a client computer that runs the English version of Excel and your current locale is configured for a language other than English. In this situation, Excel will try to locate the language pack for the configured language. If the language pack is not found, the error is reported. To work around this issue, change your locale to match the version of Excel that you are running on the client computer, and then try to compile the scan results again.

Appendix

This appendix describes OEAT command-line parameters and the locations where OEAT searches for add-ins and applications.

OEAT command-line parameters

You can run OEAT at the command prompt or in a script by using the set of parameters shown in the following table.

	Parameter
	Description

	-scan
	Runs OEAT.exe with the scan option. This parameter requires that Settings.xml file is saved to the same folder as OEAT.exe.

	-setup
	Runs the Setup wizard that creates the Settings.xml file.

	-compile
	Compiles the scan result files into an XML file. This file is saved to the folder that is specified in the Settings.xml file. If no Settings.xml file exists, the default configuration is used and the compiled data is saved to a file in the current folder.

	-help
	Opens the Help window. 

	-debug
	Stops the scan if there is an error and displays a message box that describes the error.


Locations scanned by OEAT

Folders scanned:
%programfiles%\Microsoft Office\Office9\Xlstart

%programfiles%\Microsoft Office\Office10\Xlstart

%programfiles%\Microsoft Office\Office11\Xlstart

%programfiles%\Microsoft Office\Office12\Xlstart

%programfiles%\Microsoft Office\Office9\STARTUP

%programfiles%\Microsoft Office\Office10\STARTUP

%programfiles%\Microsoft Office\Office11\STARTUP

%programfiles%\Microsoft Office\Office12\STARTUP

%programfiles%\Microsoft Office\Office14\STARTUP

%appdata%\Microsoft\Excel\XLSTART

%appdata%\Microsoft\Word\STARTUP

%appdata%\Microsoft\AddIns

Extensions discovered within the scanned folders:
PowerPoint: ppa, ppam 

Excel: xla, xlm, xll, xlam

Word: dot, dotm, .wll

Office: .dll

Registry locations scanned:
PowerPoint:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\PowerPoint\Addins

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\PowerPoint\AddIns

HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\PowerPoint\AddIns

HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\PowerPoint\AddIns

HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\PowerPoint\Addins

HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\PowerPoint\Addins

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\PowerPoint\Addins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\9.0\PowerPoint\AddIns

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\10.0\PowerPoint\AddIns

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\11.0\PowerPoint\AddIns

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\12.0\PowerPoint\Addins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\14.0\PowerPoint\Addins

Outlook:

HKEY_CURRENT_USER\Software\Microsoft\Office\Outlook\Addins

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Outlook\Addins

HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Outlook\Addins

HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Outlook\Addins

HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Outlook\Addins

HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Outlook\Addins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\9.0\Outlook\Addins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\10.0\Outlook\Addins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\11.0\Outlook\Addins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\12.0\Outlook\Addins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\14.0\Outlook\Addins

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\Outlook\Addins

Excel:

HKEY_CURRENT_USER\Software\Microsoft\Office\Excel\Addins\

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Excel\Add-in Manager

HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Excel\Add-in Manager

HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Excel\Add-in Manager

HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Excel\Add-in Manager

HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Excel\Add-in Manager

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\Excel\Addins\

Word:

HKEY_CURRENT_USER\Software\Microsoft\Office\Word\Addins\

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Word\Add-ins

HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Word\Add-ins

HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Word\Add-ins

HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Word\Add-ins

HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Word\Add-ins

HKEY_LOCAL_MACHINE\Software\Microsoft\Office\Word\Addins\

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Word\Options::STARTUP-PATH

HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Word\Options::STARTUP-PATH

HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Word\Options::STARTUP-PATH

HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Word\Options::STARTUP-PATH

HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Word\Options::STARTUP-PATH

HKEY_CURRENT_USER\Software\Microsoft\Office\9.0\Excel\Options::OPEN#

HKEY_CURRENT_USER\Software\Microsoft\Office\10.0\Excel\Options::OPEN#

HKEY_CURRENT_USER\Software\Microsoft\Office\11.0\Excel\Options::OPEN#

HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Excel\Options::OPEN#

HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Excel\Options::OPEN#

Registry keys monitored during passive scan:
{00024500-0000-0000-C000-000000000046}

{91493441-5A91-11CF-8700-00AA0060263B}

{000209FF-0000-0000-C000-000000000046}

{0006F03A-0000-0000-C000-000000000046}

See Also
Application compatibility assessment and remediation guide for Office 2010
Microsoft Office Code Compatibility Inspector user's guide

The Microsoft Office Code Compatibility Inspector is a tool that you can use in Microsoft Excel 2010, Microsoft PowerPoint 2010, Microsoft Word 2010, and Microsoft Visual Studio 2008 to troubleshoot and resolve issues with your Microsoft Visual Basic for Application (VBA) Macros and add-ins. The tool scans your code for known compatibility issues, and then notifies you if it finds items in the code from the object model that have changed in some way or have been removed. This article describes how to use the tool to inspect VBA code that you created in previous versions of Microsoft Office and also how to use the tool to help you to make any Windows Application Programming Interface (API) calls in your code compatible with the 64-bit edition of Microsoft Office 2010.

In this article:


About the Inspector

Installation

Inspecting VBA code

Inspecting Visual Studio code

Using the Inspector

Additional resources
About the Inspector

The Microsoft Office Code Compatibility Inspector for is designed to help an enterprise or small business update Visual Basic for Applications (VBA) and Visual Studio Tools for Office code so that it is compatible with Office 2010. The Inspector does not correct code; it inspects code, and then comments specific lines of code that reference items in the object model that have changed in some way or have been deprecated. (In VBA code, the tool also comments Declare statements for 64-bit compatibility.) You can then modify the code based on the comments, or use the links that are provided in the comments to view topics on the Web that are pertinent to a particular line of your code.

Again, it is up to you to modify the code if you determine that it needs to be modified.

The key features of the Office Code Compatibility Inspector include the following:


It consists of four add-ins that load, one add-in per application, in Excel 2010, PowerPoint 2010, Word 2010, and Visual Studio 2008.


It runs on a per-user or a per-document basis. For VBA, users open a document and run the tool from the Developer tab. For Visual Studio projects, the developer runs the tool from the Tools menu.


It scans the projects in the current document or Visual Studio Solution by using a simple text search, looking for parentObject.Property combinations, and scans Declare statements for 64-bit compatibility (in VBA).


It adds comments in the code where it finds other potential issues.


It displays a summary and a detailed report of its findings after it completes its inspection.

You cannot use this tool to inspect code from Microsoft Outlook or Microsoft Access. However, you can use the tool to inspect Excel, PowerPoint, and Word code for interaction with the Outlook object model.

Installation

To install the Office Code Compatibility Inspector, follow these steps:

1.
Download SetupOCCI.msi (http://go.microsoft.com/fwlink/?LinkId=171093) to your desktop or some other location that is convenient to you, and then double-click it to start the installation.


You can select to install only the Visual Studio add-in.


You can select to install only the Office add-ins.


Or, you can select to install both.

2.
Follow the prompts and then click Finish to complete the installation.

Displaying the Developer tab

For each Office application in which you plan to use the tool, do the following:

1.
Open Excel 2010, PowerPoint 2010, or Word 2010 if it is not already open.

2.
On the File tab, click Options.

3.
Click Customize Ribbon.

4.
Under Choose commands from on the left side of the dialog box, select Popular Commands.

5.
Under Customize the ribbon on the right side of the dialog box, select Main tabs, and then select the Developer check box.

6.
Click OK.

Enable VBA project access

For each Office application in which you plan to use the tool, do the following:

1.
Open Excel 2010, PowerPoint 2010, or Word 2010 if it is not already open.

2.
On the File tab, click Options.

3.
Click Trust Center.

4.
Click Trust Center Settings.

5.
Select Trust access to the VBA project object model.

Inspecting VBA code

To inspect a document for compatibility, follow these steps:

1.
Open the document in Excel 2010, PowerPoint 2010, or Word 2010.

2.
On the Developer tab, click Inspect VBA Code.

Figure 1. Code Compatibility Inspector options on the Developer tab
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3.
In the Inspect VBA Project dialog box, select or clear the options as appropriate, and then click Inspect.

Figure 2. Inspect VBA Project dialog box
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a.
Select Inspect Visual Basic for Application Projects to inspect your VBA project for items in the object model that have changed or have been removed.

b.
Select Inspect Declare statements if your project will only be run on Office 2010, or your project might run on a system that is running 64-bit Office 2010.

c.
Select Add comments to place comments in your code where the tool identifies potential compatibility issues. The comments that the Inspector adds look similar to the following example.

'<VBA_INSPECTOR>

'      <DEPRECATION>

'        <MESSAGE>Potentially contains ... </MESSAGE>

'        <ITEM>AnswerWizard.ResetFileList</ITEM>

'        <URL>http://go.microsoft.com/fwlink/?LinkID=171730</URL>

'      </DEPRECATION>

'<VBA_INSPECTOR>

d.
Select Detailed Report to create a report at the end of the inspection process. The report is a text file that looks similar to the following example.

SUMMARY:

========

Document scanned:        c:\TestFile.xls

Date Scanned:            Thursday, November 12, 2009

Total lines scanned:     101

Total items found:       1

Deprecated items:        0

Changed items:           1

Redesigned items:        0

Declare statements:      0

DETAILS:

========

MODULE:            Module1

FUNCTION:          Macro1

LINE:              19

TYPE:              CHANGE

ITEM:              Workbook.VBProject

URL:               http://go.microsoft.com/fwlink/?LinkID=170116

CODE:              For Each comp In

ActiveWorkbook.VBProject.VBComponents

4.
After the Inspector completes its scan, it displays a summary report similar to the following.

Figure 2a. Code Compatibility Inspector Summary
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
Total lines scanned – Total number of VBA code lines scanned in the document.


Total items found – Total number of problematic items that the Inspector found in the code, including Declare statements to update, changed items, deprecated items, and items affected by design changes.


Deprecated items – Items in the code that were removed from the object model, or are no longer supported in it. If your code is dependent on a deprecated item, you must rewrite that portion of the code.


Changed items – Items in the code that use a command whose syntax has changed. If your code uses outdated syntax, you must update the code.


Redesigned items – Items in the code whose syntax is the same and still exists, but whose updated design might yield unexpected results against your code. For example, formatting a particular text box might have changed because of new text services, and as a result, your code might create a text box, but the layout of the text in the box might be different from previous versions.


Declare statements – Total number of Windows API statements detected in the VBA code and then updated for 64-bit compatibility by adding the PTRSAFE keyword.

Inspecting Visual Studio code

To inspect a document for compatibility, follow these steps:

1.
Open the solution that you want to inspect in Visual Studio Tools for Office.

2.
On the Tools menu, click Inspect VSTO Code.

Figure 3. VSTO Tools menu
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3.
In the Inspect VSTO Project dialog box, select or clear the options as appropriate, and then click Inspect.

Figure 4. Inspect VSTO Project dialog box
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a.
Select Inspect Visual Studio Tools for Office Source (VB.NET and C#) to inspect your Visual Studio Tools for Office project for items in the object model that have been changed or removed.

b.
Select Add comments to place comments in your code where the tool identifies potential compatibility issues. The comments that the Inspector adds look similar to the following example.

//<VSTO_INSPECTOR>

//  <DEPRECATION>

//      <MESSAGE>Potentially contains removed items...</MESSAGE>

//      <ITEM>[mso]AnswerWizard.ResetFileList</ITEM>

//      <URL>http://go.microsoft.com/fwlink/?LinkID=171730</URL>

//  </DEPRECATION>

//</VSTO_INSPECTOR>

c.
Select Detailed Report to create a report at the end of the inspection process. The report is a text file that looks similar to the following example.

SUMMARY:

========

Solution scanned:        ExcelAddIn1

Date scanned:            Thursday, November 12, 2009

Total lines scanned:     43

Total items found:       3

Deprecated items:        3

Changed items:           0

Redesigned items:        0

DETAILS:

========

MODULE:      ThisAddIn.cs

FUNCTION:    ThisAddIn_Startup

LINE:        17

TYPE:        DEPRECATION

APP:         mso

ITEM:        AnswerWizard

URL:         http://go.microsoft.com/fwlink/?LinkID=171730

CODE:        xlApp.AnswerWizard.ResetFileList();

MODULE:      ThisAddIn.cs

FUNCTION:    ThisAddIn_Startup

LINE:        19

TYPE:        DEPRECATION

APP:         xls

ITEM:        SmartTagRecognizers

URL:         http://go.microsoft.com/fwlink/?LinkID=170614

CODE:        xlApp.SmartTagRecognizers.Recognize = true;

MODULE:      ThisAddIn.cs

FUNCTION:    ThisAddIn_Startup

LINE:        22

TYPE:        DEPRECATION

APP:         xls

ITEM:        SmartTags

URL:         http://go.microsoft.com/fwlink/?LinkID=170617

CODE:        MessageBox.Show(r.SmartTags.Count.ToString());

d.
Select Backup to back up your project files before inspecting your code.

4.
After the Inspector completes its scan, it displays a summary report similar to the following.

Figure 5. Code Compatibility Inspector Summary
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
Total lines scanned – Total number of Visual Basic .NET or C# code lines scanned in the document.


Total items found – Total number of problematic items that the Inspector found in the code, including changed items, deprecated items, and items affected by design changes.


Deprecated items – Items in the code that were removed from the object model, or are no longer supported in it. If your code is dependent on a deprecated item, you must rewrite that portion of your code.


Changed items – Items in the code that use a command whose syntax has changed. If your code uses outdated syntax, you must update the code.


Redesigned items – Items in the code whose syntax is the same and still exists, but whose updated design might yield unexpected results against your code. For example, formatting a particular text box might have changed because of new text services, and as a result, your code might create a text box, but the layout of the text in the box might be different from previous versions.


Declare statements – Total number of Windows API statements detected in the VBA code and then updated for 64-bit compatibility by adding the PTRSAFE keyword.

Using the Inspector

If the Inspector finds Changed, Deprecated, or Redesigned items in your code, you must debug your code and resolve any issues. We recommend that you perform a full test pass on your code, inspecting each function. As you debug your code, check for Office Code Compatibility Inspector comments above the lines that break your code. Those comments should help you to determine the underlying problem with that particular line of code. If the problem is not immediately obvious to you, paste the URL that is in the comments into your browser to get more information.

Removing comments in VBA

To remove the comments from the code after you complete the process and verify your code for Office 2010 compatibility, click Remove Comments on the Developer tab in your Office 2010 application.

The Inspector removes all comments that it placed in your VBA project and then notifies you how many items it removed.

Figure 6. Message that specifies the number of items removed
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Removing comments in Visual Studio

To remove the comments from the code after you complete the process and verify your code for Office 2010 compatibility, click Remove VSTO Inspector Comments on the Tools menu in Visual Studio.

The Inspector removes all comments that it placed in your Visual Studio Tools for Office project and then notifies you how many items it removed.

Figure 6a. Message that specifies the number of items removed
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Additional resources

For more information, see the following resources:


Office 2010 Tool: Office Environment Assessment Tool (http://go.microsoft.com/fwlink/?LinkId=171092)

Office 2010 Assessment and Remediation Guide (http://go.microsoft.com/fwlink/?LinkId=177407)

Office Environment Assessment Tool Quick Start Guide (http://go.microsoft.com/fwlink/?LinkId=177405)

Office Environment Assessment Tool User Manual (http://go.microsoft.com/fwlink/?LinkId=177406)

Office Migration Planning Manager (OMPM) overview for Office 2010
Document compatibility assessment and remediation for Office 2010

This section provides the primary resources for Microsoft Office 2010 document compatibility information and includes links to the document compatibility tools and documentation. These resources are especially useful for IT professionals who have to evaluate and resolve application compatibility issues.

In this section:

	Article
	Description

	Office Migration Planning Manager (OMPM) for Office 2010
	Provides an overview of the Office Migration Planning Manager (OMPM), which is a collection of tools that enables you to prepare an environment for migration to Office 2010.


Office Migration Planning Manager (OMPM) for Office 2010

The Office Migration Planning Manager (OMPM) is a collection of tools that helps you prepare an environment for migration to Microsoft Office 2010. OMPM can scan your environment in three ways: scan from an administrative computer, scan from a central share, and locally scan on the client computers. Because most users scan their environments from an administrative computer, that configuration is assumed. Other scanning scenarios are noted as needed.

	Article
	Description

	Office Migration Planning Manager (OMPM) overview for Office 2010
	Provides an overview of OMPM, including a description of the contents of the OMPM download package, requirements for running OMPM, and a high-level overview of using OMPM tools.

	Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
	Describes how to set up the OMPM File Scanner and install OMPM, and describes the kinds of files that are generated by an OMPM scan, including log files and .cab files. 

	Run the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
	Describes how to run the OMPM File Scanner from a command line on an administrative client computer, run from the central share, and run on each client computer. Also provides references to the Offscan.ini file.

	Import Office Migration Planning Manager (OMPM) log files into a database
	Describes how to import OMPM log files into a database, import data files, import action files, and fix import failures.

	Analyze Office Migration Planning Manager (OMPM) Reports for Office 2010
	Describes how to configure reports, review scan coverage and errors, review compatibility issues, and filter reports.


See Also
Office Migration Planning Manager (OMPM) reference for Office 2010 (http://technet.microsoft.com/library/eda24da3-1b47-479f-93bc-4fd487f38788(Office.14).aspx)
Office Migration Planning Manager (OMPM) overview for Office 2010

This article provides an overview of the Office Migration Planning Manager (OMPM). This includes a description of the contents of the OMPM download package, the requirements for running OMPM, and a high-level overview of using OMPM tools. 

In this article:


About OMPM

OMPM download package contents

OMPM installation point

How the OMPM File Scanner works

Using OMPM tools

OMPM required permissions

Client computer requirements

Administrative computer requirements
About OMPM

OMPM is a collection of tools that enables you to prepare an environment for migration to Microsoft Office 2010. OMPM checks for, and reports on, file properties and contents to help you analyze the environment and determine any issues that you might experience converting from Office 97 to Office 2003 file formats to Office 2010 file formats. OMPM can be a very important part of an Office migration plan. You can use the tools in OMPM to scan Office 97 through Office 2003 files for conversion issues, create reports to help you analyze the scan data, store the scan data, and convert older Office files into the Office 2010 file formats. OMPM includes the following components:


The OMPM File Scanner (Offscan.exe), a command-line tool that scans files for conversion issues and stores the results in XML log files in a configurable location and, optionally, can bundle these log files into .cab files. The OMPM File Scanner performs two kinds of scans:


A light scan that quickly identifies the Office documents on a user’s computer or network file system.


A deep scan that you can perform on Office documents to crawl document properties that provide indicators of potential conversion issues.
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Important: 

Files from Microsoft Outlook, Microsoft FrontPage, Microsoft OneNote, and Microsoft InfoPath are not included in either the light or deep scan.


A set of utilities that you can use to import the XML log files that are generated by the OMPM File Scanner into one or more Microsoft SQL Server 2000, Microsoft SQL Server 2005, or Microsoft SQL Server 2005 Express Edition databases. OMPM for Office 2010 will be updated with instructions to provide Microsoft SQL Server 2008 support.


A Microsoft Access 2010–based reporting solution that provides different reports for your analysis and enables you to define file sets for automated processing.


The Office File Converter (OFC), which lets you convert specific files to the Office 2010 file formats in bulk.


The Version Extraction Tool (VET), which lets you extract multiple saved versions of a document in Word 97–2003 format to individual, different version files in Office 2010.

OMPM download package contents

The OMPM download is packaged in a self-extracting executable file, MigrationPlanningManager.exe, which you can download from 2007 Microsoft Office System Migration Guidance: Microsoft Office Migration Planning Manager (http://go.microsoft.com/fwlink?linkid=75727). This download is the 2007 version of OMPM, which you can use to scan for conversion issues common to both 2007 Microsoft Office system and Office 2010. 

OMPM components are contained in the following redistributable subfolders:


Scan   The folder that contains the OMPM File Scanner.


Report   The folder that contains OMPM Reports. To export file lists from OMPM Reports, the database folder and related components must also be available.


Database   The folder that contains scripts to provision and populate the OMPM database.


Tools   The folder that contains tools, such as OFC the VET.

OMPM installation point

There are three possible scenarios for installing the downloaded OMPM executable in your environment:

1.
Centrally run installation   Download to an administrative client computer and use that computer to scan all environment client computers.

2.
SCCM deployment installation   Download to a central file share and use that share to scan all environment client computers.

3.
Logon script installation   Download to each environment client computer for local scanning.

How the OMPM File Scanner works

The OMPM File Scanner collects information about the computer and recursively scans the designated path for Office files. The OMPM File Scanner then records the results in an XML log file to the designated destination path.

In addition, OMPM includes the latest Access Compatibility Toolkit, which it uses automatically when you scan Access files by using it (provided you have set the AccessScan setting to 1 in the Offscan.ini file), and shows the results on the Access Compatibility tab of the reporting tool.

The OMPM File Scanner performs the following tasks in a single scan:


Scans the computer for Office files in the folder structure that is defined by the SourcePath setting specified in the configuration file Offscan.ini.


Scans the computer for properties, such as operating system, memory, and language ID.


Scans for file property information, such as file name, path, size, format, created date, modified date, and file owner.


If this is a deep scan, scans for compatibility issues.


Writes an XML log file to the destination path for each file that contains compatibility issues.


If the CABLogs setting is set to 1 in Offscan.ini, adds the XML log files to a series of .cab files for later transfer to a SQL Server computer.


Logs failures to the XML log files.
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Note

Using OMPM tools

The following is a high-level view of the process to use the OMPM tools in your Office migration.

1.
Use the OMPM file scanner to scan computers and generate log or .cab files that with scan results data. For more information, see Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010.

2.
Import the log or .cab files into the OMPM database. For more information, see Import Office Migration Planning Manager (OMPM) log files into a database.

3.
Use OMPM Reports to prepare reports from the data in the OMPM database. For more information, see Analyze Office Migration Planning Manager (OMPM) Reports for Office 2010.

4.
Use the reports to determine which actions to perform in your Office migration. For example, do one or both of the following:


Use the Office File Converter (OFC) to convert specific files from Office 2003 or Office 2007 file formats to the Office 2010 file formats in bulk.


Use the Version Extraction Tool to extract multiple saved versions of a file in Office Word 2003 or Word 2007 to different files in Office 2010.

OMPM required permissions

When you configure the environment for the use of OMPM, assign the permissions as shown in the following table. 

	Component
	Permission required

	Offscan.ini file
	Read/write permissions on all computers.

	Offscan.exe
	
Read for Offscan.ini


Read/write for any directory that stores scan logs


Read for any file to be scanned


Read/write for files to be scanned by using the /d option

	Database tools
	
Read for files that contain scan laws


Owner permission to the computer that is running SQL Server (configure/import data)

	Reporting tool
	
Read access to report ompm.accdr


Read/write access to the SQL database


Owner permission for OMPM 2007 SQL database

	Version Extraction Tool (VET)
	
Read to files to be converted


Read/write to the directory where converted files are stored

	Office File Converter (OFC)
	
Read to Ofc.ini (if you intend to modify it, you need Read/write


Read to files to be converted


Read/write to the directory where converted files are stored


Client computer requirements

The requirements in the following table are for client computers on which the OMPM File Scanner will run.

	Operating system/OMPM components
	Related components

	Windows 2000 SP4
	

	Windows Server 2003 SP1
	

	Windows XP SP3
	DAO 3.5 or later (included in Access 2000 and later versions and in Windows XP and later versions)

	Windows Vista SP3
	Windows Script 5.6 or later

	Windows 7
	Visual C Runtime (msvcrt.dll)

	Internet Explorer 5.0 or later versions
	

	Office File Converter (OFC) requirement for any computer that contains files to be converted.
	Microsoft Office Compatibility Pack (http://go.microsoft.com/fwlink/?LinkId=169257)

	Version Extraction Tool (VET) requirement for any computer on which Vet.exe will run.
	Microsoft .NET Framework V2.0 Redistribution Package (x86) (http://go.microsoft.com/fwlink/?LinkId=81886)

	If the Microsoft .NET Framework is not installed, individual components must be installed separately on the system variable PATH.
	Kernel32.dll

	
	Msjet40.dll

	
	Crypt32.dll

	
	Ole32.dll

	
	Oleaut32.dll

	
	User32.dll

	
	Advapi.dll

	OMPM Reports (on client computers that have data for analysis)
	Reports requires Access 2007 or later versions

	OMPM File Scanner (Office does not have to be installed to use)
	Performing deep scans of Access files requires Access 2007 or later versions

	OMPM File Scanner (Scanning doc storage systems)
	Web-based Distributing Authoring and Versioning IIS 6.0 required
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Warning: 

Only the IIS 6.0 version of WebDAV is supported. For SSL-enabled doc libraries, use Windows Vista WebDAV. Prior versions of WebDAV client are not supported.


Administrative computer requirements

The requirements in the following table are for the administrative computer on which the OMPM File Scanner will run.

	Operating system
	System components

	Requirements for OMPM database provisioning or data import tools on the administrative computer.
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Warning: 

Maintain import tools, log file share, and database on the same server for optimal performance, or keep on same subnet to reduce network traffic. 
	

	Windows 2000 SP4
	

	Windows Server 2003 SP1
	

	Windows XP SP3
	IExpress 2.0 runs on XP

	Windows Vista SP3
	IExpress 2.0 runs on Vista

	Windows 7
	IExpress 2.0 runs on Win7
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Warning: 

Create self-extracting packages using IExpress. Do not use self-installing packages.

	OMPM Reports
	Reports requires Office Access 2007 or later versions

	Database components
	System components

	SQL Server 2000
	4 GB free disk space

	SQL Server 2005 (Only English edition is supported)
	4 GB free disk space

	SQL Server 2008 (Planned)
	4 GB free disk space

	SQL Server 2005 Express Edition (http://go.microsoft.com/fwlink/?LinkId=95582)
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Warning: 

Only use for maximum 100,000 scan-able files. 
	2 GB free disk space

	SQLXML 3.0 SP3 (http://go.microsoft.com/fwlink/?LinkId=52919)
	Enables XML support for SQL Server 2005 database.

	Sqlcmd.exe command-line utility (bundled with SQL Server 2005 and SQL Server 2005 Express Edition)
	Sqlcmd.exe must be on client computer from which SQL provisioning and import tools are run.

	Bcp.exe command-line utility (bundled with SQL Server 2005 and SQL Server 2005 Express Edition)
	Bcp.exe must be on client computer from which SQL provisioning and import tools are run.

	Network
	System components

	File share required to stage XML log files collected by OMPM File Scanner. Needs read/write/create permissions.
	File share 1 GB free space


See Also
Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Run the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Import Office Migration Planning Manager (OMPM) log files into a database
Analyze Office Migration Planning Manager (OMPM) Reports for Office 2010
Office Migration Planning Manager (OMPM) reference for Office 2010 (http://technet.microsoft.com/library/eda24da3-1b47-479f-93bc-4fd487f38788(Office.14).aspx)
Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010

This article provides an overview of the Office Migration Planning Manager (OMPM) File Scanner. It also provides information about how the OMPM File Scanner works and how to set it up on the network.

In this article:


Set up the OMPM File Scanner

Install OMPM

 Files generated by an OMPM scan
Set up the OMPM File Scanner

The following files, which are contained in the Scan folder in the OMPM download package, are the required files for running the OMPM file scanner:


OFFSCAN.EXE – OMPM File Scanner program


ACCSCAN.DLL – Application library modules


OFFSCAN.INI – Configuration file


MSVBVM50.DLL – Visual Basic 5.0 runtime version


SYSTEM.MDW – Access system database

You have the following three options for distributing and running the OMPM File Scanner:


Centrally run method   Place all of the required OMPM File Scanner files (which consist of the contents of the Scan folder) on an administrative client computer. Run the OMPM File Scanner from that computer, scanning computers over the network by setting the value of FoldersToScan in offscan.ini. This is the most frequently used installation point and lets you change the OMPM file scanner configuration file (offscan.ini) on the administrative computer without having to redistribute them to every computer on the network.
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
SCCM deployment method   Place all of the required OMPM File Scanner files (which consist of the contents of the Scan folder) on a central share and run the OMPM File Scanner from that share, scanning local computer hard drives or servers. This method lets you change the OMPM File Scanner configuration file (offscan.ini) in the central location without having to redistribute them to every computer on the network. For this method, you also have the option of copying a script to each computer that starts the OMPM File Scanner from a file share.
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
Login script method   Distribute and run the OMPM file scanner files (the contents of the Scan folder) on each client computer and run the OMPM File Scanner locally.
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When you run Offscan.exe, it reads the Offscan.ini configuration file for specifics about how to run the file scan. For more information about how to run the file scanner and set the Offscan.ini file, see Run the Office Migration Planning Manager (OMPM) File Scanner for Office 2010.

Offscan.exe silently installs itself when it runs to ensure the executable file can be tracked and updated, if it is necessary. It also automatically uninstalls itself after it completes a scan. If installations of Offscan.exe remain on computer on the network after completing the scans, they can be safely removed.

Install OMPM
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To install OMPM

	1.
At a command prompt, type the following command, and then press ENTER: 

MigrationPlanningManager /extract:c\ompm
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Note: 

You can replace c:\ompm with another location that you prefer.

2.
For help with OMPM, at a command prompt, type the following command, and then press ENTER:

MigrationPlanningManager /?


 Files generated by an OMPM scan

The OMPM File Scanner collects information about the computer and recursively scans the designated path for Office files. The OMPM File Scanner then records the results in an XML log file to the designated destination path, optionally creating them as .cab files first.

In addition, OMPM includes the latest Access Compatibility Toolkit, which it uses automatically when you scan Microsoft Access files with it (provided you have set the AccessScan setting to 1 in the Offscan.ini file), and shows the results on the Access Compatibility tab of the reporting tool.

Log and .cab files generated by the OMPM File Scanner

For each computer that it scans, the OMPM File Scanner writes an XML log file to the destination folder that you specified in the accompanying Offscan.ini file. This initial log file contains both scan and computer details. After this, the OMPM File Scanner creates an XML log file for each additional Office file that it scans. The file name for each log file is in the form of a GUID, with a prefix that indicates the kind of log file.

The OMPM File Scanner creates four unique kinds of log files to record properties about the computer scanned, file scanned, scan summary, and errors. The following table shows a typical set of log files.

	File name
	Description

	Scan_{40D1300A-F0BE-4D68-ADBF-36C78EE030A1}.xml
	Scan log (one per scan)

	File_{F575D370-1E7A-486E-9FC6-4BB83C7770DD}.xml
	File properties log (one per unique file scanned)

	Sum_{75C5A590-A789-4B16-A2EB-E3934BCB01B1}.xml
	Summary log

	Err_{61CF0E6F-71E1-4878-9E9F-C1D35EBA3506}.xml
	Error log (one per unique error occurrence)


The individual log files can be compressed into .cab files to make transport to the Microsoft SQL Server database more efficient. To maximize disk space on the computer that is scanned, OMPM adds the log files to a .cab file after the file scanner writes 10,000 log files, and then deletes the original log files. When a .cab file reaches 10,000 log files, the OMPM File Scanner creates a new .cab file for the next 10,000 files. You can disable .cab file creation by changing the CABLogs setting in Offscan.ini from the default setting, 1, to 0 (not recommended, for performance reasons, if you scan more than several thousand files).

The .cab files use the file name from the ScanID GUID, with an index number appended. Three .cab files generated on the same computer might generate names such as the following:


Computer1 {2FA87EDF-4393-4BCF-8829-8776F82DEDD5}00001.cab


Computer1 {2FA87EDF-4393-4BCF-8829-8776F82DEDD5}00002.cab


Computer1 {2FA87EDF-4393-4BCF-8829-8776F82DEDD5}00003.cab

Creating .cab files can be harmful to performance if log files are saved over a network. Log files should generally be stored on computers that are geographically close to scanned computers and on the same subnet. Use the setting CABlogs=1 in the Offscan.ini file to disable the creation of .cab files.

Files scanned by the OMPM File Scanner

The following table shows the file types that are scanned by the OMPM File Scanner, together with file types that are included in the light scan and macro scan only.

	Microsoft Office program
	Light and deep scan file types
	Light scan only
	Macro scan only

	Access
	
.mdb


.mde


.mdz


.adp


.ade


.mdt


.mda


.accda


.accdb


.accdr


.accdu


.accde


.accdt


.accdc
	
	

	Excel
	
.xls


.xlt


.xla


.xlm


.xlw


.htm


.html


.mhtml


.mht
	
.xlc


.wk1


.wk3


.wk4


.wj1


.wj2


.wj3


.fj3


.fmt


.fm3


.all


.wks


.wq1


.dbf
	.xlsm

	PowerPoint
	
.ppt


.pot


.pps


.ppa
	
	.pptm

	Project
	
.mpp


.mpt
	
	

	Publisher
	.pub
	
	

	Visio
	
.vsd, 


.vss


.vst


.vdx


.vtx


.vsx
	
	

	Word
	
.doc


.dot


.wiz
	
	.docm


Files from Microsoft Outlook, Microsoft FrontPage, Microsoft OneNote, and Microsoft InfoPath are not included in either the light or deep scan.
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Note: 

The OMPM File Scanner does not scan documents that are password-protected or Information Rights Management (IRM)-protected. In addition, the OMPM File Scanner does not scan embedded objects within documents. However, it does report that the document contains embedded objects.

See Also
Office Migration Planning Manager (OMPM) overview for Office 2010
Run the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Import Office Migration Planning Manager (OMPM) log files into a database
Analyze Office Migration Planning Manager (OMPM) Reports for Office 2010
Office Migration Planning Manager (OMPM) reference for Office 2010 (http://technet.microsoft.com/library/eda24da3-1b47-479f-93bc-4fd487f38788(Office.14).aspx)
Run the Office Migration Planning Manager (OMPM) File Scanner for Office 2010

This article discusses how to run the Office Migration Planning Manager (OMPM) File Scanner from the command line, and provides information about the settings and values that you can specify in Offscan.ini, the configuration file that the OMPM File Scanner reads to obtain information about how to perform the scan.

In this article:


Run the OMPM File Scanner from an administrative client computer

Run the OMPM File Scanner from a central share

Run the OMPM File Scanner on each client computer by using System Center Configuration Manager or other similar tool

Run the OMPM File Scanner on each client computer

Offscan.ini settings
Run the OMPM File Scanner from an administrative client computer

To run the OMPM file scanner from an administrative client computer, put all of the OMPM required files on the administrative client computer and configure the Offscan.ini file to scan computers over the network. The Offscan.ini is in the same folder as Offscan.exe, which you run at a command line as described in the next section. Use the FoldersToScan and FoldersToExclude properties in Offscan.ini to control which locations on the network are scanned. For more information about how to set up the OMPM File Scanner, see Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010.
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Important: 

In a centrally run scan, the Microsoft Office Compatibility Pack must be located on the administrative client computer. In either the Microsoft System Center Configuration Manager 2010 or logon script scan, the Office Compatibility Pack must be located on the environment computers.
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To run OMPM File Scanner

	1.
Verify the requirements as shown in the Office Migration Planning Manager Table of Requirements section have been met on the administrative client computer “A”.

2.
Edit the settings in the Offscan.ini file that apply to the way that you want the scan to be performed.

3.
From a command line, change to the directory where the OMPM File Scanner files are located, and then type: offscan.exe.

To run the command in quiet mode, you can use the –q parameter; for example, offscan.exe –q.


Run the OMPM File Scanner from a central share

To run the OMPM file scanner from a central share, put all of the required files on the share, and then configure the Offscan.ini file to scan computers over the network. Run Offscan.exe as described in the previous section. Use the FoldersToScan and FoldersToExclude properties in Offscan.ini to control which locations on the network are scanned. 
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Run the OMPM File Scanner on each client computer by using System Center Configuration Manager or other similar tool

You can use Microsoft System Center Configuration Manager 2010, a third-party software distribution program, or a script to distribute the OMPM File Scanner and run it locally on each computer in the environment.

System Center Configuration Manager 2010 encrypts the data that it transmits. If you use another software distribution package, refer to the product documentation for information about whether it encrypts the data. If you are not using System Center Configuration Manager 2010, be aware that scanning files over a network could lead to potential security issues, in the same manner that reading or editing any document over a network can create security issues.

For a sample script that runs the OMPM file scanner from a central share, see Sample script to run the Office Migration Planning Manager (OMPM) File Scanner from a file share for Office 2010 (http://technet.microsoft.com/library/fd62888b-c8bb-4712-bbe7-ba4c95ef4902(Office.14).aspx). You can use System Center Configuration Manager 2010, another software distribution package, or a script to distribute the sample script.

You can also run the OMPM File Scanner from a central share by using a logon script. It is highly recommended that you store the log files in a central destination that is geographically close to the computers that are running scans and on the same subnet. For example, if you were scanning files in New York and Beijing, you would want to have a server near New York and one near Beijing to collect the scan XML and CAB files. You can configure the store location by using the DestinationPath property in Offscan.ini and distributing different versions of Offscan.ini to the scan jobs at each site. 

Run the OMPM File Scanner on each client computer

For computers that are not always connected to the network, such as portable computers and computers that are in branch offices, running OMPM locally is a good option. You can distribute all of the appropriate files via CD, user-initiated download, or logon script.

[image: image60.png]Offscan.exe runs locally

I’ thn dlient cnm@pu;; 3

Office Compatibilty Pack

o | eS|
5 e
L) u

Environment (D)

o) computers - B
% Version Extraction Tool ®)

S]
© @ Reports ”Bm

® e
© I s

Administrative client - A

SQLXML 3.0 SP3.
Administrative SQL database server

i % SQL Server 2005

1. Offscan.exe runs.
2. Creates XML

3. Adds XML to CAB
4. Transfers to database.

5. Read Access report.

6. Use Reports to investigate problem issues.

7. Use Version Extraction Tool to spit doc files with versions.
8. Use Office File Converter to convert formats.




If you want to distribute the OMPM File Scanner by using a logon script, you can use IExpress 2.0 to create a distribution package. For more information, see Use IExpress 2.0 to create a distribution package for Office Migration Planning Manager (OMPM) File Scanner in Office 2010 (http://technet.microsoft.com/library/6f23648e-2cbb-4f4d-8083-be14befebd6d(Office.14).aspx).

Offscan.ini settings

For information about how to edit the Offscan.ini file before you run OMPM, see the Offscan.ini settings table in Sample script to run the Office Migration Planning Manager (OMPM) File Scanner from a file share for Office 2010 (http://technet.microsoft.com/library/fd62888b-c8bb-4712-bbe7-ba4c95ef4902(Office.14).aspx).
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Note: 

The following properties support environment variables: [FoldersToScan], [FoldersToExclude], and [DestinationPath]. For example, you can specify %temp%, which resolves as the location to store temporary files. If the environment variable cannot be resolved due to a misspelling or another reason (for example, if you specified %temps% instead of %temp%), the OMPM File Scanner treats the entry like a folder name and not an environment variable.

See Also
Office Migration Planning Manager (OMPM) overview for Office 2010
Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Import Office Migration Planning Manager (OMPM) log files into a database
Analyze Office Migration Planning Manager (OMPM) Reports for Office 2010
Office Migration Planning Manager (OMPM) reference for Office 2010 (http://technet.microsoft.com/library/eda24da3-1b47-479f-93bc-4fd487f38788(Office.14).aspx)
Import Office Migration Planning Manager (OMPM) log files into a database

This article provides procedural information that describes how to import Office Migration Planning Manager (OMPM) log files into a database and fix import failures. 

In this article:


Create an OMPM database

Import log files into an OMPM database

Fix import failures

Delete an OMPM database
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Note: 

Before you perform the procedures in this article, verify that you meet the database requirements for OMPM. For more information, see Office Migration Planning Manager (OMPM) overview for Office 2010.

Create an OMPM database

Use CreateDB.bat to create and provision an OMPM database in Microsoft SQL Server 2000, SQL Server 2005, SQL Server 2005 Express Edition, SQL Server 2008, or SQL Server 2008 R2 Express. To use CreateDB.bat, type the following at the command prompt: CreateDB.bat <Computer/SQLServerName> <DatabaseName>.

Import log files into an OMPM database

The import tool automates the process of importing the XML log file data or .cab files directly into a database server. The following two batch files are included in the Database folder:


ImportScans.bat   Lets you import scan logs into the database.


ImportActions.bat   Lets you import action logs into the database.

You can start to import as soon as you have .xml files or .cab files generated by the OMPM File Scanner. You do not have to wait until all the data is collected. However, we recommend that you wait until all of the data from a specific computer is collected. You can run the import tool multiple times to add new information to the database when the data is collected.

Use the following procedures to import scan and action data into the database. Before you run either procedure, be aware that you should not run more than one import at the same time. Always let one import to complete before you start the next import. Running more than one import at the same time could result in data corruption. You can obtain help for either command by typing the following at a command line: ImportScans.bat /? or ImportActions.bat /?.

Import OMPM File Scanner data files into the database

Use the following procedure to import log files that contain scan data obtained by the OMPM File Scanner. We recommend that you keep databases smaller than 1 million scan records if you plan to use the OMPM reporting tool. This can be accomplished by ensuring that individual scan runs of Offscan.exe do not include more than 1 million files, or by importing the data from a single run of more than 1 million files into multiple databases. (Tip: 100 scan .cab files contain 1 million or fewer files.) Include the Scan_{GUID}.XML in all databases if you choose the second option. For more information about Scan_{GUID}.XML, see Fix import failures later in this article.
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To import OMPM File Scanner data files into the database

	1.
Verify that you have the following permissions:


Database operator permissions


Read/write permissions for the storage location

2.
At a command prompt, navigate to the folder where OMPM is installed, navigate to the Database folder, and then type:

ImportScans.bat <ComputerName>\<SQLServerName> <DatabaseName> <PathToLogFiles>


Import OMPM File Scanner action files into the database

Use the following procedure to import log files that contain action data obtained by the OMPM File Scanner, Office File Converter, or Version Extraction Tool.
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To import OMPM File Scanner action files into the database

	1.
Verify that you have the following permissions:


Database operator permissions


Read/write permissions for the storage location

2.
At a command prompt, navigate to the folder where OMPM is installed, navigate to the Database folder, and then type:

ImportActions.bat <ComputerName>\<SQLServerName> <DatabaseName> <PathToLogFiles>


Parameters for ImportScans.bat and ImportActions.bat

The parameters for ImportScans.bat and ImportActions.bat are shown in the following table. You can obtain more information about either command by typing the following at a command line: ImportScans.bat /? or ImportActions.bat /?.

	Parameter
	Description

	ComputerName
	The name of the computer that is hosting the Microsoft SQL Server database.

	SQLServerName
	The name of the SQL Server computer where the new database is created. Required.

	DatabaseName
	The name of the database. Required.

	PathToLogFiles
	The local (or UNC) path of the folder where the log files are stored. The operator must have read/write/create permissions to this location. Required.
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Note: 

The default path for scan data log files in offscan.ini is C:\OMPM\SCANDATA. The default path for action log files is C:\OMPM\ACTIONLOGS.


For example, if the computer name is COMPUTER1, the database server is SQLEXPRESS, the database name is OMPM001, and the log files are stored in C:\OMPM\SCANDATA, type the following at the command prompt: 

ImportScans.bat COMPUTER1\SQLEXPRESS OMPM001 c:\OMPM\SCANDATA

When the log files are successfully imported, the contents move to the imported subfolder in the original <PathToLogFiles> folder.

Files that were stored in <PathToLogFiles> are moved to the subfolder OMPMImported. To run the import by using the same set of files to a different database, copy the files back to <PathToLogFiles>.

Fix import failures

If you encounter a fatal error when you import the scan data, the OMPM database might be corrupted or you might be missing one file associated with the first .cab file. The scanner produces a single SCAN_{GUID}.xml with the first .cab file that it creates. The .xml file describes the configuration of the scan run. This includes RunID, folders to scan, and all the other properties set in the offscan.ini configuration file. For an import to be successful, the scan .xml file must be present. If you cannot find that first .cab file or the scan .xml file inside it, run the scan again to create a new scan .xml file. Because the database is populated with information from .cab files, you can use the .cab files to restore the data. If you still have all of the .cab files, you have not lost any data. The high-level process for fixing this situation is as follows:


Delete the existing database.


Create a new database.


Move all of the .cab files out of the OMPMImported folder.


Re-import the scan data and action .cab files.

You can use the following procedure to delete and restore the OMPM database.
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To fix import failures

	1.
At a command prompt, navigate to the OMPM\Database folder, and then type:

DeleteDB.bat <ComputerName>\<SQLServerName> <DatabaseName>
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Warning: 

This will delete the entire database. All data previously entered into the database will be lost.

For example, if the computer name is COMPUTER1, the database server is SQLEXPRESS, and the database name is OMPM001, type the following at the command prompt:

DeleteDB.bat COMPUTER1\SQLEXPRESS OMPM001

2.
At a command prompt, navigate to the OMPM\Database folder, and then type:

CreateDB.bat <ComputerName>\<SQLServerName> <DatabaseName>
For example, if the computer name is COMPUTER1, the database server is SQLEXPRESS, and the new database name will be OMPM001, type the following at the command prompt:

CreateDB.bat COMPUTER1\SQLEXPRESS OMPM001

3.
Move all of the .cab files that are in the OMPM\SCANDATA\OMPMImported folder up one level to the OMPM\SCANDATA folder, or to another folder if you prefer. Move all of the folders that are in the OMPM\ACTIONLOGS\OMPMImported folder up one level to the OMPM\ACTIONLOGS folder, or to another folder if you prefer.

4.
At a command prompt, navigate to the OMPM\Database folder, and then type:

ImportScans.bat <ComputerName>\<SQLServerName> <DatabaseName> <PathToLogFiles>

For example, if the computer name is COMPUTER1, the database server is SQLEXPRESS, the database name is OMPM001, and the log files are stored in C:\OMPM\SCANDATA, type the following at the command prompt:

ImportScans.bat COMPUTER1\SQLEXPRESS OMPM001 c:\OMPM\SCANDATA

5.
At a command prompt, navigate to the OMPM\Database folder, and then type:

ImportActions.bat <ComputerName>\<SQLServerName> <DatabaseName> <PathToLogFiles>

For example, if the computer name is COMPUTER1, the database server is SQLEXPRESS, the database name is OMPM001, and the log files are stored in C:\OMPM\ACTIONLOGS, type the following at the command prompt:

ImportActions.bat COMPUTER1\SQLEXPRESS OMPM001 c:\OMPM\ACTIONLOGS


Delete an OMPM database

Use DeleteDB.bat to delete an existing OMPM database. All data stored in the database will be lost. To use DeleteDB.bat, type the following at the command prompt: DeleteDB.bat <Computer/SQLServerName> <DatabaseName>.

See Also
Office Migration Planning Manager (OMPM) overview for Office 2010
Run the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Analyze Office Migration Planning Manager (OMPM) Reports for Office 2010
Schema for the Office Migration Planning Manager (OMPM) database in Office 2010 (http://technet.microsoft.com/library/bb985d2c-8e57-430c-be9a-6aceb8821602(Office.14).aspx)
Analyze Office Migration Planning Manager (OMPM) Reports for Office 2010

This article provides procedural information for using Office Migration Planning Manager (OMPM) Reports in Microsoft Office 2010. OMPM Reports is a tool that you can use to review and report on OMPM file scan results.

In this article:


Configure OMPM Reports

Review Scan Coverage and Errors

Review Office 2010 Compatibility

Review Access Compatibility

Filter for Excel, Word, or PowerPoint files that use macros
You can use OMPM Reports to perform the following actions:


Review OMPM File Scanner results to identify errors or to view coverage by computer.


Review data compatibility issues between Microsoft Access 97 or earlier versions and Access 2000 or later versions.


Create a list of files to convert and export the list to a file for use by the Office File Converter (OFC) or the Version Extraction Tool (VET).

Configure OMPM Reports

OMPM Reports (OMPM.accdr) is in the Report folder in the OMPM download package.
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To use OMPM Reports

	1.
In the Reports folder where you installed OMPM, double-click OMPM.accdr. Click Yes at the security prompt.

2.
On the OMPM Welcome page, in the Server drop-down box, select the computer running Microsoft SQL Server or Microsoft SQL Server 2005 Express Edition that you created earlier. If the server is not the default for a computer, it must be specified as the named instance in the form <ComputerName>\<ServerName>. By default, SQL Server installs itself as the default instance on a server, but SQL Server 2005 Express Edition installs itself by using SQLEXPRESS as the named instance.

3.
In the Database drop-down box, select the name of the database. Click Connect. If you have already connected to a database, OMPM Reports automatically open the database. If you want to connect to a different database, click Connect.
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Note: 

The SQL Server database can support millions of results. However, we recommend that you keep databases smaller than 1 million records if you intend to use the Access reporting tool or you might experience unintended behavior.


Review Scan Coverage and Errors

Use the following procedure to review the scan results for a specific scan that was performed. Only scanner coverage and errors are reported. Use the Office 2010 Compatibility report for upgrade issues that are identified by the scanner.
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To review scan coverage and errors

	1.
On the OMPM Welcome page, select Scan Coverage and Errors. This brings up the Scan Results page.

2.
Select a Run ID at the top of the Scan Results page to view the results for that run of the OMPM File Scanner.

3.
To view the scan results for a specific computer, select the computer in Scan results for each computer in the run selected above. The scan results appear in Scan errors for the run and computer selected above.


Severity levels

The severity levels that help map to the kinds of errors, which might occur in bulk converting the file to the Office 2010 format, from the table in the OMPM database are shown in the following table.

	Color
	Issue Level ID
	Description

	Red
	1
	Known issues that could cause significant data loss (for example, Microsoft Word 2010 edit version loss) or could cause a conversion to fail.

	Yellow
	2
	Will convert into the Office 2010 format, but there might be some format or minor data loss issues.

	Green
	3
	Light cosmetic issues, no data loss.

	No Issue
	4
	No issues.


Errors for Word, Excel, and PowerPoint

The following table provides a complete list of the errors the scanner can generate for Microsoft Word, Microsoft Excel, and Microsoft PowerPoint, taken from the OMPM database.

	Issue ID
	Title
	Description
	Issue level ID

	1000
	File Deleted
	The file no longer exists at the requested location.
	Red

	1001
	File Access Error
	The file location could not be accessed, probably because a computer was inaccessible.
	Yellow

	1002
	File Modified
	The file modified date did not match the modified date in the file list.
	Red

	1003
	No Write Permissions
	The user account does not have permissions to write to the file.
	Yellow

	1010
	Not Deep Scanned
	The file has not been deep scanned yet.
	Yellow

	1050
	File Scan Error
	An error occurred while scanning this file. Review the Scan Coverage and Errors report for more information.
	Yellow

	1100
	Document contains versions
	Edited versions of the document will be removed on opening the file in Word 2010, even in compatibility mode.
	Red

	1200
	Send for review data
	This file has review comments and contains a hidden baseline copy of the original. Microsoft PowerPoint 2010 discards the hidden copy and saving removes it permanently. Users cannot tell which edits reviewers made if reopened in previous versions.
	Red

	1201
	Embedded documents
	There are potential performance, security, and fidelity issues with embedded documents.
	Yellow

	1202
	VBA code
	This file contains embedded VBA code. This can create security, fidelity, performance, and solution compatibility issues. Check this file for compatibility with PowerPoint 2010.
	Yellow

	1203
	Microsoft Script Editor data
	When opening this file, PowerPoint 2010 discards MSE data that was stored on shapes, and saving removes it permanently. Solutions that depend on this data might break.
	Red

	1204
	Presentation broadcast data
	When opening this file, PowerPoint 2010 discards configuration settings for HTML broadcast presentations, and saving removes it permanently. To broadcast in an earlier version, the user must manually reenter the settings.
	Red

	1205
	Document routing
	When opening this file, PowerPoint 2010 discards routing information, and saving removes it permanently. To route the presentation in an earlier version, the user must manually reenter the routing information.
	Red

	1206
	Publish and subscribe data
	When opening this file, PowerPoint 2010 discards Macintosh Publish and Subscribe information, and saving removes it permanently. If reopened in an earlier version, the Publish and Subscribe feature will no longer function.
	Yellow

	1207
	Large number of OLE objects
	This file contains a large number of embedded objects. This can create security, fidelity, performance, and solution compatibility issues. Check this file for compatibility with PowerPoint 2010.
	Yellow

	1300
	Open format not supported
	This file format will not open in Microsoft Excel 2010.
	Red

	1301
	Save format not supported
	Excel 2010 does not support saving to this file format.
	Yellow

	1302
	HTML will be a publish-only file format
	The HTML file format will be a publish-only file format in Excel 2010. The file will open in Excel 2010, but on save to an Excel 2010 format, the file will be static.
	Red

	1303
	Links in workspace files might be broken
	A workspace file (.xlw) might contain links to other workbooks. The .xlw file might be broken if the links are changed during an upgrade.
	Green

	1304
	File format is earlier than Excel 97
	File format is before Excel 97. Such files are not scanned for migration.
	Yellow

	1305
	SharePoint linked lists in the file
	Linked lists are read-only in Excel 2010.
	Yellow

	1306
	Microsoft Script Editor present in the file
	Microsoft Script Editor (MSE) was removed in Excel 2010. There will be no UI access to MSE, and object model calls will return an error.
	Red

	1307
	Linked workbooks in the file
	Linked workbooks are identified to help identify upgrade issues. The path of the linked workbook and the number of occurrences are identified. Linked workbooks will have different extensions when they are converted to the Excel 2010 file format.
	Yellow

	1308
	Charts in the workbook
	Charts might not display the same as Excel 2003 in Excel 2010.
	Green

	1309
	English Language Formulas in the workbook
	English Language Formulas (ELFs) are turned on. ELFs have been removed in Excel 2010, but all ELFs will be changed to cell references so they can continue to work in Excel 2010.
	Green

	1310
	Embedded documents in the file
	Embedded documents are not scanned for compatibility issues.
	Yellow

	1311
	MSOWC.dll is referenced
	This file uses features of the Office 2000 Web Components (MSOWC.dll). The Office 2000 Web Components will not be installed as part of the Office 2010 and might need to be installed separately.
	Green

	1312
	OWC10.dll is referenced
	This file uses features of the Office XP Web Components (MSOWC.dll). The Office XP Web Components will not be installed as part of the Office 2010 and might need to be installed separately.
	Green

	1313
	OWC11.dll is referenced
	This file uses features of the Office 2003 Web Components (MSOWC.dll). The Office 2003 Web Components will not be installed as part of the Office 2010 and might need to be installed separately.
	Green


Review Office 2010 Compatibility

Use the following procedure to review Office 97-2003 files for compatibility issues with Office 2010. For a list of filtering criteria that you can select on the Office 2010 Release Compatibility page in OMPM reports, see OMPM Reports filtering reference. For more information about the filter criteria that you can select, see Office Migration Planning Manager (OMPM) 2010 reports filtering reference for Office 2010 (http://technet.microsoft.com/library/f37e7196-d970-4327-8dec-aa684835c4a5(Office.14).aspx).
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To review Office 2010 compatibility

	1.
On the OMPM Welcome page, select Office 2007 Compatibility. This brings up the Office 2010 Compatibility page.

2.
You can load a filter that you previously saved by clicking the Load Filter button at the bottom of the page. Otherwise, specify your file filter settings in Select a File Filter, along the left side of the page.
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Note: 

Filters apply to which files are shown, not which issues or created files are shown. For example, if you set Select Issues of Specified Type to select all issues of level Red, all files with red issues appear. However, if those files also have yellow and green issues, reports of those issues also appear.

3.
To invert the filter for a specific setting, select the check box to the right side of the setting. For example, if you select a scanner run, you see all files discovered during that scanner run. If you invert the filter for that setting, you see all files discovered during other runs, but not during the selected run.

4.
To apply the filter, click the Apply Filter button at the top of the 2010 Office release Compatibility page. Use the tabs on the right side of the page to perform the following steps.

5.
Select the Issue Summary tab to view a summary of the issues that were identified by the OMPM File Scanner by severity, type, and frequency. You can open the summary in a new window by clicking New Window at the bottom of the page.

6.
To view issues and edit their severity level, click Manage Issues at the bottom of the Issue Summary page, and review or edit issues on the resulting Manage Issues dialog box. If you review the impact of an issue and the issue is not important for your document set, you can also change the issue level in this dialog. You can use this to organize your files into processing groups of red, yellow, and green status.

7.
Select the Computer Summary tab to view a summary of the issues for each computer that was scanned. You can bring up the summary in a new window by clicking New Window at the bottom of the page. To obtain a printable report, click Report View at the bottom of the page.

8.
Select the Scanned Files tab to view files that match the criteria set by the filter that you applied. You can bring up the summary for all files in a new window by clicking New Window at the bottom of the page. To obtain a printable report, click Report View at the bottom of the page.

9.
Select the Created Files tab to view files that were created by using the Office File Converter or Version Extraction Tool. You can open the summary for all files in a new window by clicking New Window at the bottom of the page. To obtain a printable report, click Report View at the bottom of the page.

10.
To save the filter, click the Save Filter button at the bottom of the page.

11.
Export the files to an XML file for use by the Office File Converter or Version Extraction Tool by clicking the Export button at the bottom of the page.


Review Access Compatibility

Use the following procedure to discover issues that pertain to migrating Access 2003 to Access 2010.
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To review Access compatibility

	1.
On the OMPM Welcome page, select Access Compatibility. This opens the Access Reporting page.

2.
On the Access Reporting page, look at the date of the last analysis (next to Analyze). If you have run a scan since that date, or if you have never run Analyze, click Analyzer Settings on the Access Reporting page, specify the settings that you want, and then click Analyze. If you do not need to configure the settings and want to start an analysis of the scan data, click Analyze on the Access Reporting page.
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Note: 

Clicking Analyze prompts you with the message: "Analysis can take quite a long time and should not be canceled mid-run. Are you sure you want to continue?" If your scan data covers fewer than 100,000 Access databases, the analysis usually takes only a few minutes. If there are more than 100,000 databases, the analysis can take a long time, and you might prefer to run the analysis overnight.

3.
To search the Access scan data by field, select QuickSearch on the Access Reporting page. This lists files that OMPM has analyzed. Use QuickSearch to find a specific database file by name, or a list of databases in a specific path or on a specific computer.

4.
To view or print interactive reports for Access data, select Reports on the Access Reporting page. This brings up the View Reports tab. On the left navigation pane, you can choose from the following reports:


Database and Issue Details   Use this report to get the list of issues for each database file.


Database Issues Grouped by Issue   Use this report to find all the databases that are identified as having a specific issue.


Executive Summary   This report provides an overview of issues for all analyzed databases, without the file-level details.


Active versus Old Databases   This report lists analyzed databases and shows whether they are active or inactive, based on their LastModified property.


Conversion Issue–Database is an MDE file   This report lists .mde files and .mdb files that have identical names.


Conversion issue–Replicated database   This report lists databases that use replication.


Conversion issue–Reserved name in Form/Report/Macro   This report lists databases that contain a reserved name in a form, report, or macro.

5.
To view interactive charts that facilitate finding databases with certain attributes, select Charts on the Access Reporting page. This brings up the Database Charts screen, where you can choose from the following charts:


Date Last Opened   Database count per year opened.


Database Rating   Database count by level of user intervention required.


Access Version   Database count by version of Access.


File Size   Database count by file size.


Conversion Issues   Database count by conversion issue.


Warning Level   Database count by warning level.

6.
To view databases and database objects on a per-file basis, data, select File Details on the Access Reporting page.

7.
To view database issues on a per-file basis, select Conversion Issues on the Access Reporting page. For a list of Access errors, see “Access errors” in this section.


Filter for Excel, Word, or PowerPoint files that use macros

OMPM does not report on any macro conversion issues, but will find all documents with VBA projects. Even if the VBA project is empty, it will still be reported as having a project. All this can then be imported into your scan results, in a new database, to filter specifically on macros.
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To filter for Excel, Word, or PowerPoint files that user macros

	1.
Open OMPM\Database\Include\ProvisionDB.SQL (make a backup).

2.
Insert the following line into the section that creates the osVBAProperty table (line 718). This adds a new column named NoVBAProject to osVBAProperty table.

[NoVBAProject] [bit] NULL,
3.
Open OMPM\Database\Schemas\LogFileMapping.xml (make a backup). 

4.
Insert the following line at the end of the section that describes the other VBA project properties (line 95): 

<ElementType name="NoVBAProject" dt:type="boolean" sql:datatype="bit"/>
5.
Insert the following line into the element type description of the relation between VBA Properties and the osVBAProperty table (line 287):

<element type="NoVBAProject" sql:field="NoVBAProject" />
6.
Create a new OMPM database.

7.
Import Scan results. (You can re-import older scan results by moving them one level out of the \OMPM Imported folder.)

8.
This new NoVBAProjects column is not exposed in OMPM Reports. Therefore, you will need to run an SQL query directly against the OMPM database:

SELECT * FROM osScanFile WHERE scanfileID IN (SELECT scanfileID FROM osVBAProperty WHERE NoVBAProject = 0)
(You can customize this query and join it with other tables for more information if you want.)


[image: image76.png]


Note


If you have scanned the same files multiple times, you might consider taking advantage that the CSIDL will not change for a single file over multiple scans. 


For example, the following query will not duplicate reporting if you have scanned files one or more times: 


SELECT distinct filename,filepath,modifieddate,csidl FROM osScanFile WHERE scanfileID IN (SELECT scanfileID FROM osVBAProperty WHERE NoVBAProject = 0)
See Also
Office Migration Planning Manager (OMPM) 2010 reports filtering reference for Office 2010 (http://technet.microsoft.com/library/f37e7196-d970-4327-8dec-aa684835c4a5(Office.14).aspx)
Office Migration Planning Manager (OMPM) overview for Office 2010
Set up the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Run the Office Migration Planning Manager (OMPM) File Scanner for Office 2010
Import Office Migration Planning Manager (OMPM) log files into a database
64-bit editions of Office 2010

Processors that are 64-bit are becoming the standard for systems that range from servers to desktop computers. The 64-bit systems can use more virtual and physical memory than 32-bit systems. This lets users work with much larger data sets than they could previously, and to analyze and solve large computational problems. Microsoft Office 2010 introduces native 64-bit versions of Microsoft Office products to take advantage of this larger capacity. For example, this additional capacity is needed only by those Microsoft Excel users who require Excel spreadsheets that are larger than 2 gigabytes (GB). The 32-bit version of Office 2010 provides the same functionality and is also compatible with 32-bit add-ins. Therefore, the 32-bit version of Office 2010 is installed by default. 

Office 2010 also provides support for 32-bit Office 2010 applications that run on 64-bit Windows operating systems by using Windows-32-on-Windows-64 (WOW64). WOW64 is the x86 emulator that enables 32-bit Windows-based applications to run seamlessly on 64-bit Windows systems. Office 2010 lets users continue to use existing Microsoft ActiveX Controls, Component Object Model (COM) add-ins, and Visual Basic for Applications (VBA), which are primarily 32-bit because no 64-bit versions are available yet for many add-ins. Supporting 32-bit Office 2010 applications that run on 64-bit operating systems allows for better compatibility with controls, add-ins, and VBA. 

The recommendations for which edition of Office 2010 to install are as follows:


If users in your organization depend on existing extensions to Office, such as ActiveX controls, third-party add-ins, in-house solutions built on previous versions of Office, or 32-bit versions of programs that interface directly with Office, we recommend that you install 32-bit Office 2010 (the default installation) on computers that are running both 32-bit and 64-bit supported Windows operating systems. 


If some users in your organization are Excel expert users who work with Excel spreadsheets that are larger than 2 gigabytes (GB), they can install the 64-bit edition of Office 2010. In addition, if you have in-house solution developers, we recommend that those developers have access to the 64-bit edition of Office 2010 so that they can test and update your in-house solutions on the 64-bit edition of Office 2010.

This article applies to the current release of Office 2010. For a visual representation of this information, see 64-bit Client Installation of Microsoft Office 2010 (http://go.microsoft.com/fwlink/?LinkId=168620), which includes supported scenarios, deployment considerations, and an overview of the Setup process.
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In this article:


Supported Windows operating systems

Architecture-specific folders and customization tools

Supported scenarios

Deployment considerations

Setup process

Assessing your current environment for application compatibility
Supported Windows operating systems

The supported Windows operating system editions for 64-bit Office 2010 client include the following:


64-bit editions of Windows Vista with SP1


64-bit editions of Windows Server 2008 with Service Pack 1


Windows 7


Windows Server 2008 R2

The following statements apply:


The 64-bit Office client can be installed only on 64-bit editions of Windows Vista with SP1, 64-bit editions of Windows Server 2008 with Service Pack 1, Windows 7, and Windows Server 2008 R2.


The 32-bit Office client is supported as a WOW64 installation. This is the default installation on 64-bit Windows operating systems. The 32-bit Windows-based applications run on 64-bit Windows, which allows for compatibility with 32-bit Office applications and add-ins.


Office 2010 server products (Microsoft SharePoint Server 2010, Microsoft SharePoint Foundation 2010, and Microsoft Project Server 2010) support the 64-bit edition of Windows Server 2008 with Service Pack 2, and Windows Server 2008 R2. For more information, see the following resources:


Hardware and software requirements (SharePoint Server 2010) (http://technet.microsoft.com/library/4d88c402-24f2-449b-86a6-6e7afcfec0cd(Office.14).aspx)

Hardware and software requirements (SharePoint Foundation 2010) (http://technet.microsoft.com/library/dcdb7f80-5d48-4b7c-9cb5-affa5f293653(Office.14).aspx)

Determine hardware and software requirements (Project Server 2010) (http://technet.microsoft.com/library/32d82f51-546a-42a3-ade5-54cc4dfdcb87(Office.14).aspx)

For click-to-run scenarios, the supported version is Office 2010 32-bit (WOW64) on computers that run the supported 64-bit editions of Windows operating systems.

Architecture-specific folders and customization tools

Office 2010 includes two architecture-specific folders: one for 32-bit and one for 64-bit. 

Each of these folders contains the following:


A separate Config.xml file and Updates folder.


An architecture-specific Office Customization Tool (OCT). The OCT files are located in the Admin folder for the x86 (32-bit) and x64 (64-bit) folders, respectively.

The 64-bit version of the OCT provides the same user interface, capabilities, and configurable settings as the 32-bit version. Office 2010 introduces XML versions of OPA files: OPAX files (.opax) for non-language specific resources and OPAL files (.opal) for language-specific resources.

The OCT provides support for importing Setup customization files (.msp files) as follows: 


64-bit Setup customization files can be imported into 32-bit OCT and can then be used to customize 32-bit Office products.


32-bit Setup customization files can be imported into 64-bit OCT and can then be used to customize 64-bit Office products.

A 32-bit Setup customization file that is imported to 64-bit OCT is converted to 64-bit, and a 64-bit customization file that is imported to 32-bit OCT is converted to 32-bit. For more information about how to use the Import feature, see Import an Office 2010 Setup customization file (http://technet.microsoft.com/library/6bd88342-4f3a-4535-a570-475d251ef9da(Office.14).aspx).

If you have installed Office 2010 including Microsoft Outlook 2010, Outlook sets a registry key named Bitness of type REG_SZ on the computer on which it is installed. The Bitness registry key indicates whether the Outlook 2010 installation is 32-bit or 64-bit. This might be useful to administrators who are interested in auditing computers to determine the installed versions of Office 2010 in their organization.


Registry path:  HKEY_LOCAL_MACHINE\Software\Microsoft\Office\14.0\Outlook

Registry key: Bitness

Value: either x86 or x64

Supported scenarios

The scenarios that are supported in the Office 2010 64-bit client are as follows. 


Enterprise   In enterprise environments, the default is to install Office 2010 32-bit on computers that run either 32-bit or 64-bit editions of Windows operating systems.  We recommend this option.

An alternate approach in enterprise environments is for administrators to do the following:


Install Office 2010 32-bit on computers that run 32-bit editions of Windows.


Install Office 2010 64-bit on computers that run 64-bit editions of Windows to take advantage of additional memory on the 64-bit computers.


Retail   For users who install Office 2010 from DVDs onto computers that run a supported 64-bit Windows operating system, the installation is by default the 32-bit version of Office 2010 (WOW64).

Retail users who run 64-bit Windows operating systems and do not have 32-bit Office products installed can install the native 64-bit version of Office 2010 from the x64 folder on the DVD.


Side-by-side installations   No support is provided for side-by-side installations of 64-bit and 32-bit editions of Office, including across applications. For example, there is no support for side-by-side installations of the 2007 Microsoft Office system 32-bit with Office 2010 64-bit, or for Microsoft SharePoint Workspace 2010 64-bit and Microsoft Excel 2010 32-bit.


Upgrades   The Office client upgrade scenarios are as follows: 


A 2007 Office system 32-bit installation on a computer that runs a 32-bit Windows operating system can be upgraded to an Office 2010 32-bit version. 


A 2007 Office system installation on a computer that runs a 64-bit Windows operating system can be upgraded to an Office 2010 32-bit (WOW64).


A 2007 Office system installation cannot be upgraded to a native Office 2010 64-bit version.

Deployment considerations

Before you deploy 64-bit editions of Office 2010, you must evaluate the advantages and disadvantages and determine whether it is an appropriate deployment option for your specific environment. The following sections highlight benefits and issues that might affect compatibility, describe Outlook considerations, and list the applications that block and those that do not block a 64-bit Office 2010 installation. 

A key consideration is that you cannot install native 64-bit Office 2010 on computers that have 32-bit Office applications and third-party add-ins installed. You must uninstall the 32-bit Office applications and add-ins before you can install 64-bit Office 2010. If you have 32-bit third-party Office applications and add-ins that are required for users, you can install the default option, which is 32-bit Office 2010 (WOW64 installation) on computers that run supported 64-bit editions of Windows. A list of applications that block and those that do not block a 64-bit Office 2010 is included. See Blocking and nonblocking Office applications in 64-bit installations.

In this section:


Advantages

Disadvantages

General feature deprecations

Considerations for MAPI applications for Outlook

Blocking and nonblocking Office applications in 64-bit installations
Advantages

Running Office 2010 64-bit provides the following advantages:


Ability to use additional memory. 


Excel 2010 can load much larger workbooks. Excel 2010 made updates to use 64-bit memory addressing to move beyond the 2-GB addressable memory boundary that limits 32-bit applications. 


Microsoft Project 2010 provides improved capacity, especially when you are dealing with many subprojects to a large project.


Enhanced default security protections through Hardware Data Execution Prevention (DEP).

Disadvantages

The following issues might affect compatibility:


Microsoft Access MDE/ADE/ACCDE files   Databases that have had their source code removed (such as .mde, .ade, and .accde files) cannot be moved between 32-bit and 64-bit editions of Office 2010. Such databases that are created by using 32-bit Office (any version) can be used only with 32-bit Office, and a database that is created on 64-bit Office can be used only on 64-bit Office.


ActiveX controls and COM add-ins   ActiveX controls and add-in (COM) DLLs (dynamic link libraries) that were written for 32-bit Office will not work in a 64-bit process. As a result, Office 2010 64-bit solutions that try to load 32-bit ActiveX controls or DLLs will not work. Installations of 64-bit Office 2010 will run only 64-bit controls. Computers can have 64-bit and 32-bit controls installed, and Office 2010 64-bit can only run the 64-bit versions of the controls. The workaround for resolving these issues is to obtain 64-bit compatible controls and add-ins or to install Office 2010 32-bit (WOW).

In addition to controls that load into Office applications, there are also Web-based solutions that use ActiveX controls in Microsoft Internet Explorer. Office 2010 64-bit editions install some Office 32-bit client-side controls for supporting solutions in a 32-bit browser (the default browser on current 64-bit Windows systems). The Edit in Datasheet view functionality is not supported if you install 64-bit Office 2010. However, the functionality is available if you install 32-bit Office 2010. 


In-place activation   The following issues might occur if there is not a match between the bitness of Office 2010 and registered applications:


An OLE server might not instantiate in place and might fail to open if the application registered is not the same bitness as the version of Office installed. (For example, if the OLE Server application is 32-bit and the version of Office installed is 64-bit.)


Inserting an object into an Office 2010 application document might fail in cross-bitness scenarios. (For example if you insert a 32-bit object in a 64-bit Office 2010 application document.)


Graphics rendering   There are differences between the 32-bit and 64-bit Graphics Device Interface (GDI) that might have performance implications because of the lack of MMX support on 64-bit. Intel's MMX technology is an extension of the Intel architecture (IA) instruction set. The technology uses a single-instruction, multiple-data (SIMD) technique to speed up multimedia and communications software by processing data elements in parallel.


Visual Basic for Applications (VBA)   VBA code that uses the Declare statement to access the Windows application programming interface (API) or other DLL entry points will see differences between 32-bit and 64-bit versions. The Declare statement must be updated with the PtrSafe attribute after inputs and outputs to the API have been reviewed and updated. Declare statements will not work in 64-bit VBA without the PtrSafe attribute. New data types are added to 64-bit Office 2010 VBA: LongLong and LongPtr. For more information about VBA, see the “64-bit VBA Overview” and “Declare Statement” articles in the Microsoft Visual Basic for Applications online Help in Office applications.


Windows Mobile Device Center (WMDC) synchronization   WMDC does not synchronize with Microsoft Outlook 2010 if you use the 64-bit version of Outlook 2010. In such cases, an error message displays that states that there is no default mail client or the current mail client cannot fulfill the messaging. WMDC synchronizes correctly with the 32-bit version of Outlook 2010. To synchronize a Windows Phone with Outlook 2010 by using Windows Mobile Device Center, uninstall Outlook 2010 64-bit. Then use the original installer that you used to obtain Outlook 2010 64-bit to install Outlook 2010 32-bit. Outlook 2010 32-bit is the default option.

General feature deprecations

The following feature deprecations might affect compatibility:


Microsoft Access   The Replication Conflict Viewer is removed from both the 32-bit and 64-bit installations of Office 2010. This functionality can still be implemented by using the ReplicationConflictFunction Property. ReplicationConflictFunction is a Microsoft Visual Basic for Applications (VBA) routine in the running database that can be used to resolve synchronization conflicts. For more information, see “How to: Set Properties of Data Access Objects in Visual Basic” in Access 2007 Developer Reference (http://go.microsoft.com/fwlink/?LinkId=150854).


Publisher   The Microsoft Works database converter (wdbimp.dll) is removed from both 32-bit and 64-bit installations of Office 2010. This converter was previously used in the Mail Merge functionality to connect to a data source created in Microsoft Works.


Word   Microsoft Office Document Imaging (MODI) and all its components are deprecated for both 32-bit and 64-bit Office 2010.The legacy Equation Editor is not supported on 64-bit Office 2010, but is supported for 32-bit Office 2010 installations (WOW64).

WLL (Word Add-in libraries)   WLL files are deprecated for both 32-bit and 64-bit Office 2010. A WLL is an add-in for Microsoft Word that you can build with any compiler that supports building DLLs.

Considerations for MAPI applications for Outlook

If you developed and installed 32-bit Messaging Application Programming Interface (MAPI) applications, there are actions that you should take to change and rebuild 32-bit MAPI applications to run on a 64-bit platform. This also applies for 64-bit applications to run on a 32-bit platform.

Starting with Office 2010, Outlook is available as a 32-bit application and a 64-bit application. The version (bitness) of Outlook that you choose depends on the edition of the Windows operating system (32-bit or 64-bit) and the edition of Office 2010 (32- or 64-bit) that is installed on the computer, if Office is already installed on that computer.

Factors that determine the feasibility of installing a 32-bit or a 64-bit version of Outlook include the following:


You can install 32-bit Office 2010 and 32-bit Microsoft Outlook 2010 on a supported 32-bit or 64-bit edition of the Windows operating system. You can install the 64-bit version of Office 2010 and 64-bit Outlook 2010 only on a supported 64-bit operating system.


The default installation of Office 2010 on a 64-bit edition of the Windows operating system is 32-bit Office 2010.


The bitness of an installed version of Outlook is always the same as the bitness of Office 2010, if Office is installed on the same computer. That is, a 32-bit version of Outlook 2010 cannot be installed on the same computer on which 64-bit versions of other Office 2010 applications are already installed, such as 64-bit Microsoft Word 2010 or 64-bit Microsoft Excel 2010. Similarly, a 64-bit version of Outlook 2010 cannot be installed on the same computer on which 32-bit versions of other Office applications are already installed.

MAPI applications include stand-alone applications such as Microsoft Communicator and MFCMAPI, and service providers such as address book, store, and transport providers. For MAPI method and function calls to work in a MAPI application (except for one Simple MAPI function, MAPISendMail), the bitness of the MAPI application must be the same as the bitness of the MAPI subsystem on the computer on which the application is targeted to run. The bitness of the MAPI subsystem, in turn, is determined by and is always the same as the bitness of the installed version of Outlook. For information about how to prepare MAPI applications for 32-bit and 64-bit platforms, see Building MAPI Applications on 32-bit and 64-bit Platforms (http://go.microsoft.com/fwlink/?LinkId=165489).

Blocking and nonblocking Office applications in 64-bit installations

If 32-bit Office applications are installed on a computer, a 64-bit Office 2010 installation is blocked by default. The following section (Applications that block a 64-bit Office 2010 installation) lists the applications that block a 64-bit Office 2010 installation. The next section (Applications that do not block a 64-bit Office 2010 installation) lists exceptions; that is, applications that do not block the installation. In such cases, installation of 64-bit Office proceeds even if the listed 32-bit applications are installed on the computer.

Applications that block a 64-bit Office 2010 installation

The following applications block a 64-bit Office 2010 installation:


Microsoft Office Excel Viewer


Access database engine of Microsoft Access 2010


Microsoft Office 2010 (Click-to-run)


Compatibility Pack for the 2007 Office system

Applications that do not block a 64-bit Office 2010 installation

The following applications do not block a 64-bit Office 2010 installation:


Microsoft Visual Studio Web Authoring Component 2007


2007 Microsoft Office system 64-bit components


Microsoft Office 2010 (OEM pre-installation)


Microsoft Office 2003 Web Components


Expressions Web Designer


Microsoft Office XP Web Components


Microsoft Expression Web 1


Microsoft Expression Web 1 Language Packs


Microsoft Expression Web 2


Microsoft Expression Web 2 Language Packs


Visual Basic for Applications 6.4 SDK


Visual Basic for Applications 6.4 SDK International Components

Setup process

This section describes the Setup sequence for a 64-bit Office client installation. 

The Office 2010 installation DVD contains both the 32-bit and 64-bit versions of Office 2010 with two architecture-specific folders: one for 32-bit and one for 64-bit, as noted previously. Each of the architecture folders contains a Setup.exe file for the specific platform. There is also a Setup.exe file at the root folder. This is referred to as the platform chooser. The following figure shows the folder structure.
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The Setup sequence is the same as for a standard 32-bit Office client installation with the addition of specific checks that are performed for 64-bit Office 2010.

The following figure shows the checks that Setup performs for 64-bit installations.
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The following figure shows how Setup determines whether to install the 32-bit or 64-bit version of Office 2010 when Setup is run from the root of the media source (DVD) that contains both the 32-bit and 64-bit versions of Office 2010. 
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The following section summarizes the Setup sequence of events.

1.
Setup checks for 64-bit Office 2010 prerequisites.

When you run Setup.exe from the x64 folder, Setup determines whether 32-bit Office applications are installed. If Setup detects 32-bit Office applications, it displays an error message that informs users that they must first uninstall all 32-bit Office applications if they want to continue with the installation of Office 2010 64-bit. The error message lists the installed 32-bit Office applications. If Setup does not detect 32-bit Office applications, it installs the 64-bit edition of Office 2010.
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Note


When you run Setup.exe from the x86 folder, Setup determines whether there are 64-bit Office 2010 applications installed. If Setup detects 64-bit Office 2010, an error message is displayed and Setup is blocked. If Setup does not detect 64-bit Office 2010, it installs the 32-bit edition of Office 2010. 


Office Professional Plus 2010 and Microsoft Office Professional 2010 will also be available as a combination release (DVD media) that includes both the 32-bit and 64-bit editions of Office 2010. If Setup is run from the root folder of the Office 2010 DVD that contains both 32-bit and 64-bit Office 2010, Setup performs the installation as follows:

2.
Setup reads XML data.

3.
Setup builds the feature tree. 

4.
Setup creates the local installation source.

5.
Setup installs Office 2010.

6.
Setup applies the 64-bit OCT customization .msp file.

7.
Setup applies software updates.

For more information about the Setup sequence, see Setup process (http://technet.microsoft.com/library/f022a92a-2c32-44b7-996d-09e671a41e9c.aspx#BKMK_SetupProcess) in Setup architecture overview for Office 2010 (http://technet.microsoft.com/library/f022a92a-2c32-44b7-996d-09e671a41e9c(Office.14).aspx).

Assessing your current environment for application compatibility

Office 2010 provides the following new application compatibility tools to help IT professionals evaluate application compatibility issues:


Office Environment Assessment Tool (OEAT)   A tool that you can use to assess your existing environment before you deploy Office 2010. OEAT is designed to help you determine the kinds of add-ins and the extent to which add-ins for Microsoft Office applications are used in your environment. OEAT collects and reports add-in information about Microsoft Office 2000, Microsoft Office XP, Microsoft Office 2003, and the 2007 Microsoft Office system. It also determines the applications that interact with Office 2010 (by using COM) and provides a summary of the general state of the systems that are scanned. For more information, see Office Environment Assessment Tool (OEAT) user's guide for Office 2010.


Microsoft Office Code Compatibility Inspector   A tool that you can use in Excel 2010, PowerPoint 2010, Word 2010, and Microsoft Visual Studio 2008 to troubleshoot issues with Microsoft Visual Basic for Application (VBA) macros and add-ins. The tool scans your code for known compatibility issues, and then notifies you if it finds items in the code from the object model that have changed in some way or have been removed. The code inspector tools find code that is incompatible because of changes and deprecations in the Office 2010 object model. The inspector tools can be used to scan code for Declare statements and can update the statements so that they are compatible with the 64-bit version of Office 2010. For more information, see Microsoft Office Code Compatibility Inspector user's guide.


Office Migration Planning Manager (OMPM)   A tool for the 2007 Office system that can also be used to scan for conversion issues that are common to both the 2007 Office system and Office 2010. For more information, see Office Migration Planning Manager (OMPM) overview for Office 2010. A new version of OMPM for Office 2010 will be available shortly after the product releases.

For more information, see Application compatibility assessment and remediation guide for Office 2010.

Along with the introduction of 64-bit editions of Office 2010, Microsoft is releasing Microsoft Visual Basic for Applications 7.0 (VBA 7) to work with both 32-bit and 64-bit applications. For more information, see Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=179546). The article discusses the changes that apply to the 64-bit version of Office 2010, introduces the new VBA 7 code base, and discusses compatibility issues between the 32-bit and 64-bit versions of Office 2010 and suggested solutions.

See Also
Compatibility Between the 32-bit and 64-bit Versions of Office 2010 (http://go.microsoft.com/fwlink/?LinkId=179546)
Office Customization Tool in Office 2010 (http://technet.microsoft.com/library/8faae8a0-a12c-4f7b-839c-24a66a531bb5(Office.14).aspx)
Config.xml file in Office 2010 (http://technet.microsoft.com/library/e16af71c-fed4-40da-a886-95e596c3999e(Office.14).aspx)
Setup architecture overview for Office 2010 (http://technet.microsoft.com/library/f022a92a-2c32-44b7-996d-09e671a41e9c(Office.14).aspx)
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